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1.

Introduction / Basics

This chapter provides basic information on operating an instrument via remote control.

1.1 Remote Control Interfaces
For remote control, RS-232/USB (standard interface HO720) or LAN/USB (optional interface HO730) or GPIB (optional
interface HO740) can be used. The optional interfaces replaces the RS-232/USB HO720 interface module on the rear
panel.
=" Within this interface description, the term GPIB is used as a synonym for the IEC/IEEEbus interface.
SCPI (Standard Commands for Programmable Instruments) SCPI commands - messages - are used for remote control.
Commands that are not taken from the SCPI standard follow the SCPI syntax rules.
1.1.1 RS-232
The oscilloscope is equipped with a RS-232/USB interface and can be connected to an computer using either classic
RS-232 or USB.
=" [f the computer does not have a RS-232 (COM) Port, please use USB or virtual COM Port via USB. Use of USB -
RS-232 (serial) Converter may not work.
If you use classic RS-232 you do not need any driver. In order to set these parameter at the HMO, please press the but-
ton SETUP at the front panel in the area GENERAL and hit the soft key INTERFACE at the opened soft menu. Make sure
the RS-232 interface is chosen (blue backlighted) and then hit the button PARAMETER. This opens a menu where you
can set and save all parameter for the RS-232 communication. Setting of the RS-232 must fit the setting of the corre-
sponding COM Port at the Computer.
The VISA resource string has the form: ASRL<n>:INSTR
<n> COM-Port number
Example: ASRLT:INSTR
1.1.2 USB Interface
If you are using USB you need to install a USB driver, which is available for download free of charge from the HAMEG
Website.
All descriptions regarding the USB interface are true for the HO720 interface card as well as for the optional
HO730 USB part. All currently available USB driver are fully tested, functional and released for Windows XP™
32 Bit, Windows Vista™ or Windows 7™ both as 32Bit or 64Bit versions.
The USB interface must be chosen in the oscilloscope and does not need any setting. The connection can be done via
the normal USB or via the virtual COM port.
= |f the virtual COM port will be used, you must set USB as interface at the oscilloscope, install the VCOM part of
USB driver at the Computer.
The VISA resource string has the form:
USB::<manufacturer-ID>::<model code>::<IF-serial number>::RAW
1.1.3 LAN Interface
The HMO series can be equipped with a network interface and can be connected to an Ethernet LAN (local area net-
work] for remote control of the instrument. The instrument accepts remote commands via the LAN interface using the
VISA library. VISA must be installed on the control computer.
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The HMO series supports two ways of LAN communication:

- VXI-11 protocol: a protocol that has been specifically developed for test and measurement instruments. It is the recom-
mended protocol for remote control via LAN.

- Raw socket mode: a synchronous, streaming oriented protocol. Consequently, raw socket communication does not
support asynchronous events like Service Request (SRQ) or Device Clear (DCL)J.

The settings of the parameter at the oscilloscope are done after selecting ETHERNET as the interface and the soft key
PARAMETER is chosen. You can set anything including a fix IP adress. Alternative you can chose a dynamic IP setting via
the DHCP function. Please ask your IT department for the correct setting at your network.

IP address
Only the IP address of the instrument is required to set up the connection. It is part of the resource string used by the
programs to identify and control the instrument. The VISA resource string has the form:

TCPIP::<IP_address>::<IP_port>::SOCKET

The default port number for SCPI socket communication is 5025. IP address and port number are listed In the .. Ethernet
Settings” of the oscilloscope, see also: chapter 1.2.2,"Configuring LAN Parameters”, on page 4.

Example: If the instrument has the IP address 192.1.2.3; the valid VISA resource string is:
TCPIP::192.1.2.3::5025::SOCKET

=" The end character must be set to linefeed.

VXi11-Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote Procedure Call] protocol which in turn
relies on TCP/IP as the network/transport layer. The TCP/IP network protocol and the associated network services are
preconfigured.

The valid VISA resource string is:  TCPIP::<IP>::INSTR
<IP> IP-Address
Example: TCPIP::192.168.155.1::INSTR

1.1.4 GPIB Interface (IEC/IEEE Bus Interface)

To be able to control the instrument via the GPIB bus, the instrument and the controller must be linked by a GPIB bus
cable. A GPIB bus card, the card drivers and the program libraries for the programming language must be provided in
the controller. The controller must address the instrument with the GPIB instrument address.

Characteristics

The GPIB interface is described by the following characteristics:

- Upto 15 instruments can be connected

- The total cable length is restricted to a maximum of 15 m; the cable lenth between two instruments should not exceed
2 meters.

- Awired ..OR"-connection is used if several instruments are connected in parallel.

GPIB Instrument Address

In order to operate the instrument via remote control, it must be addressed using the GPIB address. The remote control
address is factory-set to 20, but it can be changed in the network environment settings or in the .Setup” menu under
.Interface > Parameter”. For remote control, addresses 0 through 30 are allowed. The GPIB address is maintained after
a reset of the instrument settings.

The valid VISA resource string is:  GPIB::<n>::INSTR
<n> GPIB address
Example: GPIB::1::INSTR
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1.2 Setting Up a Network (LAN) Connection
1.2.1 Connecting the Instrument to the Network
The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps Ethernet IEEE 802.3u interface.
I—=" Risk of network failure
Before connecting the instrument to the network or configuring the network, consult your network admini-
strator. Errors may affect the entire network.
= To establish a network connection, connect a commercial RJ-45 cable to one of the LAN ports of the instru-
ment and to a PC.
1.2.2 Configuring LAN Parameters
Depending on the network capacities, the TCP/IP address information for the instrument can be obtained in different
ways.
- If the network supports dynamic TCP/IP configuration, using the Dynamic Host Configuration Protocol (DHCP), and a
DHCP server is available, all address information can be assigned automatically.
- Otherwise, the address must be set manually. Automatic Private IP Addressing (APIPA] is not supported.
By default, the instrument is configured to use dynamic TCP/IP configuration and obtain all address information au-
tomatically. This means that it is safe to establish a physical connection to the LAN without any previous instrument
configuration.
=== Connection errors can affect the entire network. If your network does not support DHCP, or if you choose
to disable dynamic TCP/IP configuration, you must assign valid address information before connecting the
instrument to the LAN. Contact your network administrator to obtain a valid IP address.
Configuring LAN parameters
1. Press the SETUP key and then the .INTERFACE" softkey.
2. Pressthe .ETHERNET" softkey and then the .PARAMETER" softkey.
Note: By default, the instrument is set to DHCP. If the instrument is set to use DHCP and cannot find a DHCP server, it
takes about two minutes until the ETHERNET menu is available.
[nlmby ]
Fig. 1.1: Ethernet Settings dialog box
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Some data is displayed for information only and cannot be edited. This includes the .MAC" (physical] address of the
connector and the ,.Link" status information.

3. If the LAN does not support DHCP, or the instrument is directly connected with a computer, disable DHCP: Press the
.DHCP" softkey so that .,OFF" is highlighted.

4. Define the IP address of the instrument by entering each of the four blocks individually.
a) Define the first block number using the Universal knob.
b) Press .Next” to move to the next block and define the number.
c) When the IP address is complete, press .Down” to continue with the next setting.

5. Define the ,Subnetmask” and .Gateway” in the same way as the IP address.

6. Select the ..IP Port” - the port number for SCPI socket communication.

7. Select the .HTTP Port” used by the instrument.

8. Select the . Transfer” mode. This mode can either be determined automatically (.Auto” setting), or you can select a
combination of a transfer rate and half or full duplex manually.

9. Press .Save” to save the LAN parameters on the instrument.
= The, Link" status information at the bottom of the dialog box indicates whether a LAN connection was esta-
blished successfully.
Checking LAN and SCPI connection
1. Check the LAN connection using ping: ping XXx.yyy.zZzz.XXX.

2. If the computer can access the instrument, enter the IP address of the instrument in the address line of the internet
browser on your computer: http//:xxx.yyy.zzz.xxx

The .Instrument Home" page appears. It provides information on the instrument and the LAN connection.

HRAMEL=
Instruments
S =
Device Information DEVICE INFORMATION prine %
Screen Data .
Device Class: Unknown Interface Type: HO730
SCPI Device Control Device Type: HMO1024 Serial Number: 0se100322
Device Mumber: 012661039 HW \ersion: 1.001
Firmw are Version: Sy Wersion: 3.000
Ethernet Port
MaC Address: 00-30-C2-45-12-C1
DHCP: On
IP Address: 192.1658.155.150
Subnet Mask: 255.255.255.0
Default Gateway: 192.168,155.1
IP Port: 50000
HTTP Port: 80
LUSB Port
Wendor 1D 04032 (hex)
Product ID: ED73 (hex)
A Rohde & Schwarz Company @ HAMES Instruments GmbH

Fig. 1.2: The , Instrument Home" page provides information on the instrument and the LAN connection.
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3. On the .Screen Data” page, a copy of the instrument screen is shown. To get the current screen content from the in-
strument, click ,.Update”.
To save the screen copy, right-click the picture and select .Save picture as”.

4. Onthe ,SCPI Device Control” page, you can check if the transfer of remote commands is working. You can enter a single
command, for example; *IDN?, and transmit it with ,Send”.

AN
S -
Device Information SCPI DEVICE CONTROL
Screen Data

The device may be contralled with special commands (SCPI - Standard Commands for Programmable
. Instruments), The respectively valid instruction set you can take from the documentation delivered
SCPI Device Control with the device. If you type a wrong command or if you use a wrong syntax the device creates an
error message which is not send immediately but according to the standard it can be requested
separately, In this case you will not get a response. &n easy way to request the error messages is to
use the two buttons.

Command:  |*idn? | Send I
Last Error Message All Error Messages

HAHEG, HMO1024,012661039, Beta 03.602

Response:

Fig. 1.3: The SCPI Device Control

1.3 Switching to Remote Control

When you switch on the instrument, it is always in manual operation state (.local” state) and can be operated via the
front panel.

When you send a command from the control computer, it is received and executed by the instrument. The display
remains on, manual operation via the front panel is always possible.

The instrument front panel control will be activated once again by pushing a menu button or by sending a SCPI remote
command. Otherwise, the front panel is locked.

The remote mode will be activated with:
REN =with GPIB

and with the SCPI command
&GTR. = Go To Remote

Return to the local mode:
&GTL. =Go To Local
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1.4 Messages and Command Structure

1.4.1 Messages

Instrument messages are employed in the same way for all interfaces, if not indicated otherwise in the description.

See also:
- Structure and syntax of the instrument messages: chapter 1.4.2, .SCPI Command Structure”, on page 9
- Detailed description of all messages: chapter 2, .Command Reference”, on page 28

There are different types of instrument messages, depending on the direction they are sent:
- Commands
- Instrument responses

Commands

Commands [program messages) are messages the controller sends to the instrument. They operate the instrument
functions and request information. The commands are subdivided according to two criteria:

1. According to the effect they have on the instrument:
- Setting commands cause instrument settings such as a reset of the instrument or setting the frequency.

- Queries cause data to be provided for remote control, e.qg. for identification of the instrument or polling a
parameter value. Queries are formed by directly appending a question mark to the command header.

2. According to their definition in standards:

- Common commands: their function and syntax are precisely defined in standard IEEE 488.2. They are
employed identically on all instruments (if implemented). They refer to functions such as management
of the standardized status registers, reset and self test.

- Instrument control commands refer to functions depending on the features of the instrument such as
frequency settings. Many of these commands have also been standardized by the SCPI committee. These
commands are marked as .SCPI compliant™ in the command reference chapters. Commands without this
SCPI label are device-specific, however, their syntax follows SCPI rules as permitted by the standard.

Instrument responses

Instrument responses (response messages and service requests) are messages the instrument sends to the controller
after a query. They can contain measurement results, instrument settings and information on the instrument status.
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Interface Messages

The interface messages are called low-level control messages. These messages can be used to emulate interface mes-
sages of the GPIB bus.

Table 1.1: Interface Messages

Command Long term Effect on the instrument

&DCL Device Clear Aborts processing of the commands just received and sets the com-
mand processing software to a defined initial state. Does not change
the instrument setting.

&GTL Go to Local Transition to the ,local” state (manual control).
&GTR Go to Remote Transition to the ,remote” state (remote control).
&LLO Local Lockout Disables switchover from remote control to manual control by means of

the front panel keys.

&NREN Not Remote Enable Enables switchover from remote control to manual operation by means
of the front panel keys

GPIB Interface Messages

Interface messages are transmitted to the instrument on the data lines, with the attention line ([ATN] being active (LOW).
They are used for communication between the controller and the instrument and can only be sent by a computer which
has the function of a GPIB bus controller. GPIB interface messages can be further subdivided into:

- Universal commands: act on all instruments connected to the GPIB bus without previous addressing

- Addressed commands: only act on instruments previously addressed as listeners

Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all instruments connected to the bus and
do not require addressing.

Table 1.2: Universal Commands

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and sets the command pro-
cessing software to a defined initial state. Does not change the instrument settings.

IFC (Interface Clear) *) Resets the interfaces to the default setting.
LLO (Local Lockout) The LOC/IEC ADDR key is disabled.

SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfigure) | End of the parallel-poll state.

*) IFC is not a real universal command, it is sent via a separate line; however, it also affects all instruments connected
to the bus and does not require addressing
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Addressed Commands
Addressed commands are encoded in the range 00 through OF hex. They only affect instruments addressed as listeners.

Table 1.3: Addressed Commands

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a sweep). The effect of
the command is the same as with that of a pulse at the external trigger signal
input.

GTL (Go to Local) Transition to the ,local“ state (manual control).

GTR (Go to Remote) Transition to the ,remote” state (remote control).

PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received and sets the command
processing software to a defined initial state. Does not change the instrument
setting.

1.4.2 SCPI Command Structure
SCPI commands consist of a so-called header and, in most cases, one or more param-eters. The header and the pa-
rameters are separated by a .white space” (ASClI code 0 to 9, 11 to 32 decimal, e.g. blank). The headers may consist of

several mnemonics (keywords). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common commands). Common and device-specific
commands differ in their syntax.

Syntax for Common Commands

Common (=device-independent] commands consist of a header preceded by an asterisk (*) and possibly one or more
parameters.

Examples:

Table 1.4: Examples of Common Commands

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable registers.
*ESR? EVENT STATUS QUERY Queries the contents of the event status register.
*IDN? IDENTIFICATION QUERY Queries the instrument identification string.

Syntax for Device-Specific Commands
=" Not all commands used in the following examples are necessarily implemented in the instrument.
For demonstration purposes only, assume the existence of the following commands for this section:

— DISPlay[:WINDow<l...4>]:MAXimize <Boolean>
— HardCOPy:DEVice:COLor <Boolean>
— HardCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>

— HardCOPy[:IMMediate]
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- HardCOPy:ITEM:ALL

— HardCOPy:ITEM:LABel <string>

- HardCOPy:PAGE:DIMensions:QUADrant [<N>]

- HardCOPy:PAGE:ORIentation LANDscape | PORTrait
— HardCOPy:PAGE:SCALe <numeric value>

- MMEMory:COPY <file source>,<file destination>

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper case letters, the long form
corresponds to the complete word. Either the short form or the long form can be entered; other abbreviations are not
permitted.

Example:
HardCOPy:DEVice:COLor ONis equivalent to HCOP:DEV:COL ON.

=" Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the manual, the instrument
itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels or sources, the required instances
can be specified by a suffix added to the command.

Numeric suffixes are indicated by angular brackets [<1...4>, <n>, <i>] and are replaced by a single value in the com-
mand. Entries without a suffix are interpreted as having the suffix 1.

Example:

Definition: HardCOPy:PAGE:DIMensions:QUADrant [<N>]
Command: HCOP:PAGE:DIM:QUAD2
This command refers to the quadrant 2.

I—= Different numbering in remote control
For remote control, the suffix may differ from the number of the corresponding selection used in manual
operation. SCPI prescribes that suffix counting starts with 1. Suffix 1 is the default state and used when no
specific suffix is specified.
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Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or omitted. These mnemonics are
marked by square brackets in the description. The instrument must recognize the long command to comply with the
SCPI standard. Some commands are considerably shortened by these optional mnemonics.

Example:

Definition: HardCOPy[:IMMediate]
Command: HCOP:IMMis equivalent to HCOP

I—=" Optional mnemonics with numeric suffixes
Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the effect of the com-
mand.

Example:

Definition: DISPlay[:WINDow<l...4>]:MAXimize <Boolean>
Command: DISP:MAX ON refersto window 1.

In order to refer to a window other than 1, you must include the optional WINDow param-eter with the suffix for the
required window.

DISP:WIND2:MAX ON refers to window 2.

Parameters

Parameters must be separated from the header by a .white space”. If several parameters are specified in a command,
they are separated by a comma (,). For a description of the parameter types, refer to .SCPI Parameters”, on page 12.

Example:

Definition: HardCOPy:DEVice:CMAP:COLor:RGB <red>, <green>,<blue>
Command: HCOP:DEV:CMAP:COL:RGB 3,32,44

Special characters

Table 1.5: Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of ,or". The effectof
the command differs, depending on which parameter is used.

Example:

Definition: HardCOPy: PAGE:ORIentation LANDscape | PORTrait
Command: HCOP: PAGE : ORI LAND specifies landscape orientation
Command: HCOP: PAGE : ORI PORT specifies portrait orientation
Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are indi-
cated in the same line; they are separated by a vertical stroke. Only one of these mnemonics needs to be
included in the header of the command. The effect of the command is independent of which of the mnemo-
nics is used.

Example:

Definition SENSE : BANDwidth |BWIDth[:RESolution] <numeric value>
The two following commands with identical meaning can be created:
SENS:BAND:RES 1

SENS:BWID:RES 1
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[1 mnemonics in square brackets are optional and may be inserted into the header or omitted.
Example: HardCOPy [ : IMMediate]
HCOP:IMM is equivalent to HCOP

{} Parameters in curly brackets are optional and can be inserted once or several times, or omitted.
Example: SENSe:LIST:FREQuency <numeric value>{,<numeric value>}

The following are valid commands:

SENS:LIST:FREQ 10

SENS:LIST:FREQ 10,20

SENS:LIST:FREQ 10,20,30,40

SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The parameters must be separated from the
header by a .white space” [ASCII code 0 to 9, 11 to 32 decimal, e.g. blank). Allowed parameters are:

- Numeric values

- Special numeric values
- Boolean parameters
- Text

- Character strings

- Block data

The parameters required for each command and the allowed range of values are specified in the command description.

Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent. Values exceeding the resolution
of the instrument are rounded up or down. The mantissa may comprise up to 255 characters, the exponent must lie
inside the value range -32000 to 32000. The exponent is introduced by an ,.E" or .e". Entry of the exponent alone is not
allowed. In the case of physical quantities, the unit can be entered. Allowed unit prefixes are G (gigal), MA [mega), MOHM
and MHZ are also allowed), K (kilo), M (milli}, U (micro) and N (nano). If the unit is missing, the basic unit is used.

Example: SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9
Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:
- G lgigal

- MA [mega), MOHM, MHZ

- Klkilo]

- M (milli)

- U (micro)

- N (nano)

If the unit is missing, the basic unit is used.

Example: SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9
Some settings allow relative values to be stated in percent. According to SCPI, this unit is represented by the PCT string.

Example: HCOP:PAGE:SCAL 90PCT

Special numeric values
The texts listed below are interpreted as special numeric values. In the case of a query, the numeric value is provided.

- MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.

HAMEG Instruments GmbH e Industriestr. 6 ¢ D-63533 Mainhausen e Deutschland Subject to change without notice
Tel.: +49 (0) 6182 800 0 » Fax: +49 (0) 6182 800 100 * E-Mail: info@hameg.com
Geschaftsfuhrer: Dipl.-Ing. Holger Asmussen, Dipl.-Ing. Andre Vander Stichelen ¢ AG Offenbach am Main HRB 41200



HAMEL=

Instruments
A Rohde & Schwarz Company

Example:
Setting command: SENSe:LIST:FREQ MAXimum

Query: SENS:LIST:FREQ?, Response: 3.5E9

Queries for special numeric values
The numeric values associated to MAXimum/MINimum can be queried by adding the corresponding mnemo-
nics to the command. They must be entered following the quotation mark.

Example: SENSe:LIST:FREQ? MAXimum

Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The ,ON" state (logically true) is represented by ,ON" or a numeric value 1.
The .OFF" state (logically untrue) is represented by .,OFF" or the numeric value 0. The numeric values are provided as
the response for a query.

Example:

Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered using a short or long form. Like any
parameter, they have to be separated from the header by a white space. In the case of a query, the short form of the text

is provided.

Example:

Setting command: HardCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?

Response: LAND

Character strings
Strings must always be entered in quotation marks (. or ..

Example: HCOP:ITEM:LABel ,Testl™or HCOP:ITEM:LABel ,Testl}

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A command using a block data
parameter has the following structure:

Example: FORMat :READings:DATA #45168XXXXXXKX

The ASCII character # introduces the data block. The next number indicates how many of the following digits describe
the length of the data block. In the example the 4 following digits indicate the length to be 5168 bytes. The data bytes
follow. During the transmission of these data bytes all end or other control signs are ignored until all bytes are trans-
mitted. #0 specifies a data block of indefinite length. The use of the indefinite format requires a NL"END message to
terminate the data block. This format is useful when the length of the transmission is not known or if speed or other
considerations prevent segmentation of the data into blocks of definite length.
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Overview of Syntax Elements
The following table provides an overview of the syntax elements:

Table 1.6: Syntax Elements

The colon separates the mnemonics of a command. In a command line the separating semicolonmarks
the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

, The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

Quotation marks introduce a string and terminate it.

# The hash symbol introduces binary, octal, hexadecimal and block data.
Binary: #810110

— Octal: #07612

Hexa: #HF3A7

Block: #21312

A ,white space” (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the parame-
ters.

Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the following:
- a<New Line>

- a <New Line> with EOQI

- an EOl together with the last data byte

Several commands in a command line must be separated by a semicolon ,;". If the next command belongs to a different
command system, the semicolon is followed by a colon.

Example: MMEM:COPY ,Testl™, “MeasurementXY"“; :HCOP:ITEM ALL
This command line contains two commands. The first command belongs to the MMEM system, the second command
belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels in common, the command line can
be abbreviated. To this end, the second command after the semicolon starts with the level that lies below the common
levels. The colon following the semicolon must be omitted in this case.
Example: HCOP:ITEM ALL; HCOP:IMM
This command line is represented in its full length and contains two commands separated from each other by the semi-
colon. Both commands are part of the HCOP command system, i.e. they have one level in common.When abbreviating
the command line, the second command begins with the level below HCOP. The colon after the semicolon is omitted.
The abbreviated form of the command line reads as follows:

HCOP:ITEM ALL; IMM

However, a new command line always begins with the complete path.

Example: HCOP:ITEM ALL
HCOP:IMM
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Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is formed by adding a question mark
to the associated setting command. According to SCPI, the responses to queries are partly subject to stricter rules than
in standard |IEEE 488.2.

- The requested parameter is transmitted without a header.
Example: HCOP:PAGE:ORI?,
Response: LAND

- Maximum values, minimum values and all other quantities that are requested via a special text parameter are returned
as numeric values.
Example: SENSe:FREQuency:STOP? MAX,
Response: 3.5E9

- Numeric values are output without a unit. Physical quantities are referred to the basic units or to the units set using the
Unit command. The response 3.5E9 in the previous example stands for 3.5 GHz.

- Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ONJ.

Example:

Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

- Text [character data) is returned in a short form.

Example:

Setting command: HardCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:0ORI?

Response: LAND

1.5 Command Sequence and Synchronization
IEEE 488.2 defines a distinction between overlapped and sequential commands:
- Asequential command is one which finishes executing before the next command starts executing. Commands that are
processed quickly are usually implemented as sequential commands.
- Anoverlapping command is one which does not automatically finish executing before the next command starts executing.
Usually, overlapping commands take longer to process and allow the program to do other tasks while being executed.
If overlapping commands do have to be executed in a defined order, e.g. in order to avoid wrong measurement results,
they must be serviced sequentially. This is called synchronization between the controller and the instrument.
Setting commands within one command line, even though they may be implemented as sequential commands, are not
necessarily serviced in the order in which they have been received. In order to make sure that commands are actually
carried out in a certain order, each command must be sent in a separate command line.
Example: Commands and queries in one message
The response to a query combined in a program message with commands that affect the queried value is not predictable.
The following commands always return the specified result:
:FREQ:STAR 1GHZ; SPAN 100 :FREQ:STAR?
Result: 1000000000 (1 GHz)
Whereas the result for the following commands is not specified by SCPI:
:FREQ:STAR 1GHz;STAR?;SPAN 1000000
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The result could be the value of STARt before the command was sent since the instrument might defer executing the
individual commands until a program message terminator is received. The result could also be 1 GHz if the instrument
executes commands as they are received.

E—=" Asageneralrule, send commands and queries in different program messages.

Example: Overlapping command with *OPC

The instrument implements SINGle as an overlapped (asynchronous) command. Assuming that SING1e takes longer to
execute than *OPC, sending the following command sequence results in initiating a sweep and, after some time, setting

the OPC bit in the ESR:

SINGle; *OPC.

Sending the following commands still initiates a sweep:

SINGle; *OPC; *CLS

However, since the operation is still pending when the instrument executes *CLS, forcing it into the ,Operation Comple-

te Command Idle” State (OCIS), *OPC is effectively skipped. The OPC bit is not set until the instrument executes another
*OPC command.

1.5.1 Preventing Overlapping Execution
To prevent an overlapping execution of commands, one of the commands *OPC, *OPC? or *WAI can be used. All three
commands cause a certain action only to be carried out after the hardware has been set. By suitable programming, the
controller can be forced to wait for the corresponding action to occur.
Table 1.7: Synchronization using *OPC, *OPC? and *WAI

Command Action Programming the controller

*OPC Sets the Operation Complete bit in the — Setting bit 0 in the ESE
ESRafter all previous commands have — Setting bit 5 in the SRE
been executed. — Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is retur- | Sending *OPC? directly after the commandwhose pro-
ned.This is only the case after the Opera- | cessing should be terminated beforeother commands
tion Complete bit has been set in the ESR. | can be executed.

This bit indicates that the previous setting
has been completed.

*WAI Stops further command processing until Sending *WAI directly after the commandwhose pro-
allcommands sent before *WAI have been | cessing should be terminated beforeother commands
executed. are executed

Command synchronization using *WATI or *OPC? appended to an overlapped command is a good choice if the overlapped
command takes only little time to process. The two synchronization techniques simply block overlapped execution of the
command.
For time consuming overlapped commands it is usually desirable to allow the controller or the instrument to do other
useful work while waiting for command execution. Use one of the following methods:
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*OPC with a service request

1. Set the OPC mask bit (bit no. 0 in the ESE: *ESE 1

2. Set bitno. 5in the SRE: *SRE 32 to enable ESB service request.
3. Send the overlapped command with *OPC

4. Wait for a service request
The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.
2. Send the overlapped command with *OPC?
3. Wait for a service request
The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the sequence: *OPC; *ESR?
A return value (LSB) of 1 indicates that the overlapped command has finished.

*OPC? with short timeout

1. Send the overlapped command without *OPC, *OPC? or *WAI

2. Poll the operation complete state periodically (by means of a timer] using the sequence: <short timeout>; *OPC?

3. A return value (LSB) of 1 indicates that the overlapped command has finished. In case of a timeout, the operation is
ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem:ERRor? to remove the .-410, Query interrupted” entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application supports threads, separate
threads can be used for the application GUI and for controlling the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with other instruments.

1.6 Status Reporting System
The status reporting system stores all information on the current operating state of the instrument, and on errors which
have occurred. This information is stored in the status registers and in the error queue. Both can be queried via GPIB
bus or LAN interface (STATus... commands].

1.6.1 Structure of a SCPI Status Register
Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and has different functions. The indi-
vidual bits are independent of each other, i.e. each hardware status is assigned a bit number which is valid for all five
parts. Bit 15 (the most significant bit) is set to zero for all parts. Thus the contents of the register parts can be processed
by the controller as positive integers.
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Fig. 1.4: The status-register model

Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

- CONDition
The CONDition partiswritten into directly by the hardware or the sum bit of the next lower register. Its contents reflect
the current instrument status. This register part can only be read, but not written into or cleared. Its contents are not
affected by reading.

- PTRansition
The two transition register parts define which state transition of the CONDition part [none, 0 to 1, 1 to 0 or both) is
stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the CONDition partis changed from O to 1,
the associated PTR bit decides whether the EVENt bit is set to 1.
- PTR bit =1: the EVENt bit is set.
- PTR bit =0: the EVENt bit is not set.
This part can be written into and read as required. Its contents are not affected by reading.

- NTRansition
The Negative-TRansition part also acts as a transition filter. When a bit of the CONDition partis changed from 1
to 0, the associated NTR bit decides whether the EVENt bit is set to 1.
- NTR bit =1: the EVENt bit is set.
- NTR bit =0: the EVENt bit is not set.
This part can be written into and read as required. Its contents are not affected by reading.

- EVENt
The EVENt part indicates whether an event has occurred since the last reading, it is the .memory” of the condition part.
It only indicates events passed on by the transition filters. It is permanently updated by the instrument. This part can
only be read by the user. Reading the register clears it. This part is often equated with the entire register.

- ENABLle
The ENABle part determines whether the associated EVENt bit contributes to the sum bit (see below]. Each bit of the
EVENt part is ,ANDed" with the associated ENABLe bit (symbol .&). The results of all logical operations of this part are
passed on to the sum bit via an ,OR" function (symbol ,+].
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit ENABle bit = 1: if the associated EVENt bit
is .17, the sum bit is set to .1" as well. This part can be written into and read by the user as required. Its contents are
not affected by reading.
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Sum bit

The sum bit is obtained from the EVENt and ENABLle part for each register. The result is then entered into a bit of the
CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event can lead to a service request
throughout all levels of the hierarchy.

1.6.2 Hierarchy of status registers

As shown in the following figure, the status information is of hierarchical structure.
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Fig. 1.5: Overview of the status registers hierarchy

- STB, SRE
The STatus Byte (STB) register and its associated mask register Service Request Enable (SRE] form the highest level of

the status reporting system. The STB provides a rough overview of the instrument status, collecting the information of
the lower-level registers.

- ESR, SCPI registers
The STB receives its information from the following registers:
- The Event Status Register (ESR] with the associated mask register standard Event Status Enable (ESE).

- The STATus:0PERation and STATus:QUEStionable registers which are defined by SCPI and contain detailed
information on the instrument.

- Output buffer
The output buffer contains the messages the instrument returns to the controller. It is not part of the status reporting
system but determines the value of the MAV bit in the STB and thus is represented in the overview.
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All status registers have the same internal structure.

=" SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the STB is structured
according to SCPI. By analogy, the ESE can be used as the ENABle part of the ESR.

1.6.3 Contents of the Status Registers
In the following sections, the contents of the status registers are described in more detail.
Status Byte (STB) and Service Request Enable Register (SRE)
The sTatus Byte (STB]is already defined in IEEE 488.2. It provides a rough overview of the instrument status by colle-
cting the pieces of information of the lower registers. A special feature is that bit 6 acts as the sum bit of the remaining
bits of the status byte.
The STB can thus be compared with the CONDition part of an SCPI register and assumes the highest level within the
SCPI hierarchy.
The STB is read using the command *STB or a serial poll.
The sTatus Byte (STBJis linked to the Service Request Enable (SRE] register. Each bit of the STB is assigned
a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set in the SRE and the associated bit in the STB changes from 0
to 1, a service request (SRQ) is generated. The SRE can be set using the command *SRE and read using the command
*SRE?.
Table 1.8: Meaning of the bits used in the status byte
Bit No. | Meaning
0...1 Not used
2 Error Queue not empty
The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each entry of the
error queue generates a service request. Thus an error can be recognized and specified in greater detail
by polling the error queue. The poll provides an informative error message. This procedure is to be recom-
mended since it considerably reduces the problems involved with remote control.
3 QUEStionable status sum bit
The bit is set if an EVENt bit is set in the QUEStionable status register and the associated ENAB1e bit
is set to 1. A set bit indicates a questionable instrument status, which can be specified in greater detail by
polling the QUEStionable status register.
4 MAV bit (message available)
The bit is set if a message is available in the output buffer which can be read. This bit can be used to ena-
ble data to be automatically read from the instrument to the controller.
5 ESB bit
Sum bit of the event status register. It is set if one of the bits in the event status register is set and enabled
in the event status enable register. Setting of this bit indicates a serious error which can be specified in
greater detail by polling the event status register.
6 MSS bit (master status summary bit)
The bit is set if the instrument triggers a service request. This is the case if one of the other bits of this
registers is set together with its mask bit in the service request enable register SRE.
7 OPERation status register sum bit
The bit is set if an EVENt bit is set in the OPERation status register and the associated ENAB1e bit is set
to 1. A set bit indicates that the instrument is just performing an action. The type of action can be deter-
mined by polling the OPERation status register.
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Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI register. The event status register
can be read out using command *ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE and the associated bit in the ESR
changes from 0 to 1, the ESB bit in the STB is set. The ESE register can be set using the command *ESE and read using
the command *ESE?.

Table 1.9: Meaning of the bits used in the event status register

Bit No. | Meaning

0 Operation Complete
This bit is set on receipt of the command *OPC exactly when all previous commands have been executed.
Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a query, or
if it does not fetch requested data and sends new instructions to the instrument instead. The cause is often
a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between -300 and -399
or a positive error number, which denotes the error in greater detail, is entered into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other reasons. An
error message with a number between -200 and -300, which denotes the error in greater detail, is entered
into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error message
with a number between -100 and -200, which denotes the error in greater detail, is entered into the error
queue.

6 User Request
This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)
This bit is set on switching on the instrument.

STATus:0PERation Register

In the CONDition part, this register contains information on which actions the instrument is being executing. In the
EVENTt part, it contains information on which actions the instrument has executed since the last reading. It can be read
using the commands STATus :OPERation:CONDition? or STATus:OPERation[:EVENt]?.

See also figure 1.5: ,Overview of the status registers hierarchy”

The remote commands for the STATus:0OPERation register are described in chapter 2.14.1: ,.STATus:0PERation Regi-
ster” on pageSeite 168.
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Table 1.10: Bits in the STATus:OPERation register

Bit No. Meaning
0 ALIGnment

This bit is set as long as the instrument is performing a self alignment.
1 SELFtest

This bit is set while the selftest is running.
2 AUToset

This bit is set while the instrument is performing an auto setup.
3 WTRIgger

This bit is set while the instrument is waiting for the trigger.
4t0 14 Not used
15 This bit is always 0.

STATus:QUEStionable Register

This register contains information about indefinite states which may occur if the unit is operated without meeting the
specifications. It can be read using the commands ,STATus: QUEStionable:CONDition?" on pageSeite 170 and
,STATus:QUEStionable[:EVENt]?" on pageSeite 171.
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Fig. 1.6: Overview of the STATus:QUEStionable register
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Table 1.11: Bits in the STATus:QUEStionable register

Bit No. Meaning
Oto2 not used
3 COVerload
This bit is set if a questionable channel overload occurs (see: STATus:QUEStionable:COVerload regis-
ter, on the page below).
4 TEMPerature
This bit is set if a questionable temperature occurs (see ,STATus:QUEStionable:TEMPerature register”,
on the page below).
5to7 Not used
8 NOALigndata
This bit is set if no alignment data is available - the instrument is uncalibrated.
9 LIMit
This bit is set if a limit value is violated (see: STATus:QUEStionable:LIMit register, next page).
10to 1M Not used
12 MASK
This bit is set if a mask value is violated (see: STATus:QUEStionable:MASK register, next page).
13 to 14 Not used
15 This bit is always O.

STATus:QUEStionable:COVerload register

This register contains all information about overload of the channels. The bit is set if the assigned channel is overloaded.

Table 1.12: Bits in the STATus:QUEStionable:COVerload register

Bit No. Meaning

0 CHANnell
1 CHANnel?2
2 CHANnel3
3 CHANnel4

STATus:QUEStionable:TEMPerature register

This register contains information about the instrument’s temperature.

Table 1.13: Bits in the STATus:QUEStionable:TEMPerature register

Bit No. Meaning
0 TEMP WARN
This bit is set if a temperature warning on channel 1, 2, 3 or 4 occured.
1 TEMP ERROr
This bit is set if a temperature error on channel 1, 2, 3 or 4 occured.
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STATus:QUEStionable:LIMit register

This register contains information about the observance of the limits of measurements.This bit is set if the limits of the
main or additional measurement of the assigned measurement are violated.

Table 1.14: Bits in the STATus:QUEStionable:LIMit register

Bit No. Meaning
0 MEAS1
1 MEAS?2
2 MEAS3
3 MEAS4

STATus:QUEStionable:MASK register
This register contains information about the violation of masks. This bit is set if the assigned mask is violated.

Table 1.15: Bits in the STATus:QUEStionable:MASK register
Bit No. Meaning
0 MASK1

1.6.4 Application of the Status Reporting System
The purpose of the status reporting system is to monitor the status of one or several devices in @ measuring system. To
do this and react appropriately, the controller must receive and evaluate the information of all devices. The following
standard methods are used:
- Service request (SRQJ initiated by the instrument
- Serial poll of all devices in the bus system, initiated by the controller in order to find out who sent a SRQ and why
- Parallel poll of all devices

- Query of a specific instrument status by means of commands

- Query of the error queue

Service Request

Under certain circumstances, the instrument can send a service request (SRQJ to the controller. Usually this service
request initiates an interrupt at the controller, to which the control program can react appropriately. As evident from
figure 1.5, an SRQ is always initiated if one or several of bits 2, 3, 4, 5 or 7 of the status byte are set and enabled in the
SRE. Each of these bits combines the information of a further register, the error queue or the output buffer. The ENABle
parts of the status registers can be set such that arbitrary bits in an arbitrary status register initiate an SRQ. In order to
make use of the possibilities of the service request effectively, all bits should be set to 1" in enable registers SRE and
ESE.

The SRQ is the only possibility for the instrument to become active on its own. Each controller program should cause the
instrument to initiate a service request if errors occur. The program should react appropriately to the service request.

Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried. However, the query is realized
via interface messages and is thus clearly faster. The serial poll method is defined in IEEE 488.1 and used to be the only
standard possibility for different instruments to poll the status byte. The method also works for instruments which do
not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instruments connected to the controller.
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Query of an instrument status

Each part of any status register can be read using queries. There are two types of commands:

- The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level registers.
- The commands of the STATus system query the SCPI registers (STATus: QUEStionable. . .]

The returned value is always a decimal number that represents the bit pattern of thequeried register. This number is
evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on the cause of the SRQ.
Decimal representation of a bit pattern
The STB and ESR registers contain 8 bits, the SCPI registers 16 bits. The contents of a status register are specified

and transferred as a single decimal number. To make this possible, each bit is assigned a weighted value. The decimal
number is calculated as the sum of the weighted values of all bits in the register that are set to 1.

Bits

Weight

1 2 4 8 16 32 64 128

Fig. 1.7: Decimal representation of a bit pattern

Example:
The decimal value 40 = 32 + 8 indicates that bits no. 3 and 5 in the status register (e.g. the QUEStionable status sum-
mary bit and the ESB bit in the STatus Byte ] are set.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the error queue are de-

tailed plain text error messages that can be looked up in the Error Log or queried via remote control using
SYSTem:ERRor [ :NEXT] ? or SYSTem:ERRor: ALL?. Each call of SYSTem:ERRor [ : NEXT] ? provides one entry from
the error queue. If no error messages are stored there any more, the instrument responds with 0, ..No error”.

The error queue should be queried after every SRQ in the controller program as the entries describe the cause of an er-
ror more precisely than the status registers. Especially in the test phase of a controller program the error queue should
be queried regularly since faulty commands from the controller to the instrument are recorded there as well.
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1.6.5 Reset Values of the Status Reporting System

1.7

The following table contains the different commands and events causing the status reporting system to be reset. None
of the commands, except *RST and SYSTem: PRESet, influence the functional instrument settings. In particular, DCL
does not change the instrument settings.

Table 1.16: Resest of the status reporting system

Event Switching on sup- | DCL, SDC | *RST STATus: *CLS

ply-voltage Power- | (DeviceCl | orSYS- PRE-Set

On-Status-Clear ear,Select | Tem:PRE-

edDevice- | Set
Clear)

Effect 0 1
Clear STB, ESR - yes - - - yes
Clear SRE, ESE - yes - - - -
Clear EVEN parts of the registers - yes - - - yes
Clear ENABIe parts of all OPERation - yes - - yes -
and QUEStionable registers; Fill ENA-
Ble parts of all other registers with ,1%.
Fill PTRansition parts with ,1%; Clear - yes - - yes -
NTRansition parts
Clear error queue yes yes - - - yes
Clear output buffer yes yes yes 1) 1) 1)
Clear command processing and input | yes yes yes - - -
buffer
1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINATOR> clears
the output buffer.

General Programming Recommendations
Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In contrast, the priority of remote control
is the .predictability” of the instrument status. Thus, when a command attempts to define incompatible settings, the
command is ignored and the instrument status remains unchanged, i.e. other settings are not automatically adapted.
Therefore, control programs should always define an initial instrument status (e.g. using the *RST command) and then
implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Otherwise, the result of the query may
vary depending on which operation is performed first (see also Preventing Overlapping Execution on page 17).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its own. Each controller program
should instruct the instrument to initiate a service request in case of malfunction. The program should react appropria-
tely to the service request.

Error queues

The error queue should be queried after every service request in the controller program as the entries describe the
cause of an error more precisely than the status registers. Especially in the test phase of a controller program the error
queue should be queried regularly since faulty commands from the controller to the instrument are recorded there as
well.
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2 Command Reference

This chapter provides the description of all remote commands available for oscilloscopes HMO series. The commands
are sorted according to the menu structure of the instrument. A list of commands in alphabetical order ist given in the
.List of Commands” at the end of this documentation.

2.1 Common Commands
Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These commands have the same effect and
are employed in the same way on different devices.The headers of these commands consist of ,*" followed by three

letters. Many common commands are related to the Status Reporting System.

Available common commands:.

O A L 28
DS e 28
HESE VAlUBS oo 28
B S R 7 28
DN 29
P 29
P T e 29
P S A 0N e 29
R G T 29
O RE < CON Nt S > L 30
T B e 30
TR G e 30
T ST 30
N Al 30
*CAL?

Calibration Query

Initiates a calibration of the instrument and subsequently queries the calibration status. Responses > 0 indicate errors.
*CLS

Clear Status

Sets the status byte (STBJ, the standard event register (ESR) and the EVENt part of the QUEStionable and the OPERation
registers to zero. The command does not alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only
*ESE <Value>
Event Status Enable

Sets the event status enable register to the specified value. The query returns the contents of the event status enable
register in decimal form.

Parameters:

<Value> Range: 0to 255

*ESR?
Event Status Read
Returns the contents of the event status register in decimal form and subsequently sets the register to zero.

Return values:

<Contents> Range: 0 to 255
Usage: Query only
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*IDN?
|DeNtification:returns the instrument identification.

Return values:

<ID> HAMEG,<device type>,<serial number>,<firmwareversion>
Example: HAMEG,HM02024,12345,0.10.1.23

Usage: Query only

*OPC

OPeration Complete
Sets bit 0 in the event status register when all preceding commands have been executed. This bit can be used to initia-

te a service request. The query form writes a .. 1" into the output buffer as soon as all preceding commands have been
executed. This is used for command synchronization.

*OPT?
OPTion identification query

Queries the options included in the instrument. For a list of all available options and their description refer to the CD-

ROM.

Return values:

<Options> The query returns a list of options. A zero is returned for options that are not installed.
Usage: Query only

*PSC <Action>
Power on Status Clear
Determines whether the contents of the ENABLe registers are preserved or reset when the instrument is switched on.

Thus a service request can be triggered when the instrument is switched on, if the status registers ESE and SRE are
suitably configured. The query reads out the contents of the .power-on-status-clear” flag.

Parameters:
<Action> 011
0
The contents of the status registers are preserved.
1
Resets the status registers.
*RST
ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the description of commands.

Usage: Setting only
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*SRE <Contents>
Service Request Enable

Sets the service request enable register to the indicated value. This command determines under which conditions a
service request is triggered.

Parameters:

<Contents> Contents of the service request enable register in decimal form.
Bit 6 (MSS mask bit] is always 0.
Range: 0to 255

*STB?

STatus Byte query

Reads the contents of the status byte in decimal form.
Usage: Query only

*TRG

TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual trigger signal (Manual Trigger).
This common command complements the commands of the TRIGger subsystem.

Usage: Event
*TST?
self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service Manual supplied with the
instrument). .0" indicates no errors occured.

Usage: Query only
*WAI
WAt to continue

Prevents servicing of the subsequent commands until all preceding commands have been executed and all signals have
settled (see also command synchronization and *OPC].

Usage: Event
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2.2 Acquisition and Setup
Starting and Stopping Acquisition
Time Base ..o
ACGUISTEION e
VEIHICAL 1.
L0gIC Channel .o
WaVETOM DAL it
PO S
2.2.1 Starting and Stopping Acquisition
RUN
RUNContinous
SINGle
RUNSing
STOP
RUN
Starts the continuous acquisition.
Usage: Event
Asynchronous command
RUNContinous
Same as RUN.
Usage: Event
Asynchronous command
SINGle
Starts a defined number of acquisition cycles.
Usage: Event
Asynchronous command
RUNSingle
Same as SINGle.
Usage: Event
Asynchronous command
STOP
Stops the running acquistion.
Usage: Event
Asynchronous command
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2.2.2 Time Base

TIMebase:SCALe <TimeScale> ... 32
TIMEDASE: R AT M e 32
TIMebase:ACQTime <ACqUISItIONTIMES ..o 32
TIMebase:RANGe <ACqUISTHIONTIMES ..o 32
TIMebase:DIVISIONS? ... e 32
TIMebase:POSition <Offset> ... 33
TIMebase:REFerence <ReferencePoint> ... 33

TIMebase:SCALe <TimeScale>
Sets the horizontal scale for all channel and math waveforms.

Parameters:

<TimeScale> Range: Te-9 to 50
Increment: 1e-9
*RST: 100e-6
Default unit: s/div

TIMebase:RATime?

Queries the real acquisition time used in the hardware. If FFT analysis is performed, the
value can differ from the adjusted acquisition time (TIMebase : ACQTime).

Return values:
<HWAcqTime> Increment: le-12
Default unit: s

Usage: Query only

TIMebase:ACQTime <AcquisitionTime>
Defines the time of one acquisition, that is the time across the 12 divisions of the diagram:Timebase Scale*12.

Parameters:

<AcquisitionTime> Range: 12ns to 600s
Increment:  1e-12
Default unit: s

TIMebase:RANGe <AcquisitionTime>
Defines the time of one acquisition, that is the time across the 12 divisions of the diagram: Timebase Scale*12.
Parameters:

<AcquisitionTime> Range: 12ns to 600s
Default unit: s

TIMebase:DIVisions?
Queries the number of horizontal divisions on the screen.

Return values:

<HorizDivCount> Range: 12
*RST: 12
Usage: Query only
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2.2.3

TIMebase:POSition <Offset>

Defines the trigger position (trigger offset] - the time interval between trigger point and reference point to analize the

signal some time before or after the trigger event.

See also: TIMebase:REFerence

Parameters:

<Offset> Range: -500 to 500
Increment:  0.01 ([depending on timebase)
*RST: 0

Default unit: s

TIMebase:REFerence <ReferencePoint>

Sets the reference point of the time scale (Time Reference) in % of the display. The reference point defines which part of
the waveform is shown. If the trigger position is zero, the trigger point matches the reference point.

See also: TIMebase:POSition

Parameters:
<ReferencePoint> Range: 10 to 90

Increment: 10

*RST: 50

Default unit: %
Acquisition
AUTOSCALE .ot 33
ACQuire:MODE <AcquisitionMode> ..o 34
ACQuire:INTerpolate <Interpolation> ... 34
ACQuire:AVERage:COUNt <AverageCount> ..o 34
ACQuire:WRATe <WaveformRate> ...t 34
CHANnel<m>:TYPE <DecimationMode> . ..o 35
CHANnel<m>:ARIThmetics <TrArithmetic> ... 35
TIMebase:ROLL:ENABLe <ROW> ..o 35
ACQuire:FILTer:FREQency <FilterFrequency> ...t 36
ACQUIre:POINIS:ARATE? .o 36
ACQUITE:SRATE? oo 36

ACQuire:STATe <Aquisition State>
ACQuUIre:TYPE <AQUISITION TYPES ittt
ACQuire:REALtime <Random Sampling>
ACQuire:PEAKdetect <PeakDetect> ...
ACQuire:HRESolution <HIGhRES> ...

AUToscale

Performs an autoset process, analyzes the enabled channel signals, and obtains appropriate

horizontal, vertical, and trigger settings to display stable waveforms.

Usage: Event
Asynchronous command
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ACQuire:MODE <AcquisitionMode>
Selects the method of adding waveform points to the samples of the ADC in order to fill the record length.

Parameters:
<AcquisitionMode> RTIMe | ETIMe

RTIMe

Real Time Mode:At slow time base settings the sampled points of the input signal are used
to build the waveform, no waveform points are added. With fast time base settings, the
sample rate is higher than the ADC sample rate. Waveform samples are added to the ADC
samples with sin(x)/x interpolation.

ETIMe
Equivalent time:The waveform points are taken from several acquisitions of a repetive

signal at a different time in relation to the trigger point.
*RST: RTIME

ACQuire:INTerpolate <Interpolation>
Defines the interpolation mode.

Parameters:

<Interpolation> LINear [ SINX | SMHD
LINear: Linear interpolation between two adjacent sample points.
SINX: Interpolation by means of a sin(x}/x curve.
SMHD: Sample & Hold causes a histogram-Llike interpolation.
*RST: SINX

ACQuire:AVERage:COUNt <AverageCount>
Defines the number of waveforms used to calculate the average waveform. The higher the number, the better the noise
is reduced.

Parameters:
<AverageCount> Only numbers from the 2" progression are permitted.

ACQuire:WRATe <WaveformRate>
Defines the mode to set the sample rate [samples per second saved in the memory) and the waveform acquisition rate
(waveforms per second).

Parameters:

<WaveformRate> AUTO | MWAVeform | MSAMples
AUTO
To display the best waveform, the instrument selects the optimum combination of
waveform acquisition rate and sample rate using the full memory depth.
MWAVeform
Maximum waveform rate:The instrument combines sample rate and memory
depth to acquire at maximum waveform acquisition rate. In connection with
persistence, the mode can display rare signal anomalies.
MSAMples
Maximum sample rate:The instrument acquires the signal at maximum sample
rate and uses the full memory depth. The result is a waveform with maximum
number of waveform samples, high degree of accuracy, and low risk of aliasing.
*RST: AUTO
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CHANnel<m>:TYPE <DecimationMode>
Selects the method to reduce the data stream of the ADC to a stream of waveform points with lower sample rate.

Suffix:

<m> The command affects all channels regardless of the indicated channel number.
The suffix can be omitted.

Parameters:

<DecimationMode> SAMPle | PDETect | HRESolution

SAMPle
Input data is acquired with a sample rate which is aligned to the time base
(horizontal scale) and the record length.

PDETect
Peak Detect:the minimum and the maximum of n samples in a sample interval
are recorded as waveform points.

HRESolution
High resolution:The average of n sample points is recorded as waveform point.

*RST: SAMPle

CHANnel<m>:ARIThmetics <TrArithmetic>
Selects the method to build the resulting waveform from several consecutive acquisitions of the signal.

Suffix:

<m> The command affects all channels regardless of the indicated channel number.
The suffix can be omitted.

Parameters:

<TrArithmetic> OFF | ENVelope | AVERage | FILTer
OFF
The data of the current acquisition is recorded according to the decimation settings.
ENVelope
Detects the minimum and maximum values in an sample interval over a number of
acquisitions.
AVERage

Calculates the average from the data of the current acquisition and a number of
acquisitions before. The number of used acquisitions is set with
ACQuire:AVERage:COUNt.

FILTer

Sets a low-pass filter with 3 db attenuation at a configurable limit frequency
set with ACQuire:FILTer:FREQency.

The filter removes higher frequencies from the channel signals.

*RST: OFF

TIMebase:ROLL:ENABle <Roll>
Enables the roll mode.

Parameters:
<Roll> ON | OFF
*RST: OFF
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ACQuire:FILTer:FREQency <FilterFrequency>
Sets the limit frequency if CHANnel<m>:ARIThmetics is set to .FILTer".

Parameters:
<FilterFrequency> Limit frequency with 3 dB attenuation
Default unit: Hz

ACQuire:POINts:ARATe?

Retrieves the sample rate of the ADC, that is the number of points that are sampled by the ADC in one second.

Return values:

<AcquisitionRate> ADC sample rate
Range: 2.5E3 to 4E9 (depending on HMO model)
Increment: 1E3
*RST: 4E9 (depending on HMO model)
Default unit: Hz
Usage: Query only
ACQuire:SRATe?

Returns the sample rate, that is the number of recorded waveform samples per second.

Return values:

<SampleRate> Range: 2to 1EM
Increment:  depends on time base, waveform rate, number of active channels
*RST: 1E7

Default unit: Sa/s

Usage: Query only

ACQuire:STATe <Aquisition State>
Sets the aquisition state of the instrument.

Parameters:

<Agquisition State> RUN | STOP | COMPlete | BREak
RUN
The aquisition is running.
STOP
The acquisition will stop if finished.
COMPlete
The current aquisition is finished and completed.
BREak
Set:  will break/interrupt current acquisition
Read: acquisition is finished but interrupted
*RST: RUN
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ACQuire:TYPE <Aquisition Type>
Sets the type of the aquisition mode.

Parameters:
<Aquisition Type> REFresh | ROLL | AVERage | ENVelope | FILTer

REFresh
The aquisitions are displayed as they are done.

ROLL
The aquisitions are done in roll mode.

AVERage
The aquisitions are averaged.

FILTer
Sets a low-pass filter with 3 db attenuation at a configurable limit frequency

*RST: OFF
ACQuire:REALtime <Random Sampling>
Enables the random sampling.

Parameters:
<Random Sampling> AUTO | OFF

*RST: OFF
ACQuire:PEAKdetect <PeakDetect>
Enables the peak detection.

Parameters:
<PeakDetect> AUTO | OFF

*RST: OFF

ACQuire:HRESolution <HighRes>
Enables the high resolution mode.

Parameters:
<HighRes> AUTO | OFF
*RST: OFF
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2.2.4 Vertical

CHANRel<m>:STATe <State> e
CHANRel<m>:COUPLING <COUPLING™ .oiiiiiiiiiiii e
CHANRel<m>:SCALE <5Cale> ..
CHANRel<m>:RANGE <RANGE> ..ot
CHANRel<m>:POSItion <POSItION> ...
CHANRelsm>:0FFSet <Offset> ..
CHANnel<m>:BANDwidth <BandwidthLimit> ...
CHANnel<m>:POLarity <Polarity> ...
CHANnRel<m>:0VERload <Overload> .. ...
CHANREl<mM>:SKEW <SKEWS .o
CHANnel<m>:THReshold <Threshold> ...
CHANnelsm>:LABel <label> ..
CHANnel<m>:LABel:STATe <State> ...

CHANnel<m>:STATe <State>
Switches the channel signal on or off.

Suffix:

<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<State> ON | OFF

CHANnel<m>:COUPling <Coupling>
Selects the connection of the indicated channel signal.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<Coupling> DC | DCLimit | AC | ACLimit
DC: Direct connection with 50 Q termination.
DCLimit: Direct connection with 1 MQ termination.
AC: Connection through DC capacitor that removes the DC offset voltage from

the input signal.

ACLimit: Connection through DC capacitor with 1 M(Q) termination. The capacitor

removes the DC offset voltage from the input signal.

*RST: DCLimit

CHANnel<m>:SCALe <Scale>
Sets the vertical scale for the indicated channel.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<Scale> Scale value, given in Volts per division.
Range: 1e-3to 10
Increment:  0.01
*RST: 5e-3

Default unit: V/div
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CHANnel<m>:RANGe <Range>
Sets the voltage range across the 8 vertical divisions of the diagram. Use the command alternativly instead of
CHANnel<m>:SCALe [see command above).

Suffix:
<m> Selects the input channel. The maximum channel number is instrument-dependent.
Parameters:
<Range> Voltage range value
Range: 8e-3to 80
*RST: 40e-3

Default unit: V

CHANnel<m>:POSition <Position>
Sets the vertical position of the indicated channel and its horizontal axis in the window.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<Position> Position value, given in divisions.
Range: -5to5
*RST: 0

Default unit: div

CHANnel<m>:0FFSet <Offset>
The offset voltage is subtracted to correct an offset-affected signal.

Suffix:

<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<Offset> Offset value

*RST: 0

Default unit: V

CHANnel<m>:BANDwidth <BandwidthLimit>
Selects the bandwidth limit for the indicated channel.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<BandwidthLimit> FULL | B20
FULL
Use full bandwidth.
B20
Bandwidthlimit 20 MHz.
*RST: FULL
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CHANnel<m>:POLarity <Polarity>
Turns the inversion of the signal amplitude on or off. To invert means to reflect the voltage values of all signal
components against the ground level. Inversion affects only the display of the signal but not the trigger.

Suffix:

<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<Polarity> NORMal | INVerted

CHANnel<m>:0VERload <Overload>
Retrieves the overload status of the specified channel from the status bit. When the overload problem is solved, the
command resets the status bit.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<Overload> ON | OFF
Use OFF to reset the overload status bit.
*RST: OFF
Example: CHANnel2:0VERload?

Queries the overload status of channel 2.
CHANnel2:0VERload OFF
Resets the overload status bit.

CHANnel<m>:SKEW <Skew>
Skew or deskew compensates delay differences between channels caused by the different length of cables, probes, and
other sources. Correct deskew values are important for accurate triggering.

Suffix:

<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<Skew> Deskew value

Default unit: s

CHANnel<m>:THReshold <Threshold>
Threshold value for digitization of analog signals. If the signal value is higher than the threshold, the signal state is high (1 or
true for the boolean logic). Otherwise, the signal state is considered low (0 or false] if the signal value is below the threshold.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<Threshold> Default values are:
TTL: 1.4V
ECL: -1.3V
CMOS: 2,9V
Default unit: V
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CHANnel<m>:LABel <l abel>
Set the label for the input channel.

Suffix:
<m> 1.4
Selects the input channel. The number of channels depends on the instrument.
Parameters:
<lLabel> String value
String with max. 8 characters, only ASCIl characters can be used.
Example: “V-Input”

“VoltagA”

CHANnel<m>:LABel:STATe <State>
Switches the label of the channel on or off

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<State> ON | OFF
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2.2.5 Logic Channel

LOGic<I>:POSItIon <POSIION™ ..o 42
LOGICKI>SIZE <SIZE> oot 42
LOGic<I>:STATE <State> oo 42
LOGic<I>:LABEl <Label> ..o 42
LOGic<I>:LABel:State <label> ..o 43
POD<p>:THReshold <Threshold Mode> ... 43
POD<p>:THReshold:UDLevel<u> <Threshold Level> ... 43
POD<P>:STATE <STAE> oot 43
POD<P>:DATA? <At .. it 4
POD<p>:DATAHEADET? oo L
POD<p>:DATA:POINTS <POINTS>...oiiiiiiiiiiiiii e A
POD<p>:DATAXINCTEMENT? .o 45
POD<P>:DATAXORIGIN . .ot 45
POD<p>:DATA:YINCIemMENT? .o o 45
POD <P :DATAYORIGIN ..ttt 46
POD<p>:DATAYRESOIULION? 1.oiiiiiiiii i 46

LOGic<I>:POSition <Position>
Set the position of a logic channel.

Suffix:

<I> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<Position> Position value, given in divisions.

Default unit: div

LOGic<I>:SIZE <Size>
Set the size of the display of teh logic channel.

Suffix:

<I> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<Size> SMALL | MEDium | LARGe

LOGic<I>:STATe <state>
Switches the channel signal on or off.

Suffix:

<I> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<State> ON | OFF

LOGic<I>:LABel <Label>
Set the label for the logic channel.

Suffix:
<I> Selects the input channel. The number of channels depends on the instrument.
Parameters:
<Label> string value
“xxxxxxxx” [maximum 8 characters)
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LOGic<I>:LABel:State <L abel>
Switches the label of the lagic channel on or off.

Suffix:

<I> Selects the input channel. The number of channels depends on the instrument.
Parameters:

<lLabel> ON | OFF

POD<p>:THReshold <Threshold Mode>
Threshold Mode for Logic Pod. If the signal value is higher than the threshold, the signal state is high (1 or true for the
boolean logic). Otherwise, the signal state is considered low (0 or false] if the signal value is below the threshold.

Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HMO352x/HM02524..
Parameters:
<Threshols Mode> TTLIECLICMOS | USERT | USER2

TTL
TTL level, set to 1.4V

ECL
ECL level, set to -1.3V

CMOS
CMOS level, set to 2.5V

USER1
USERT level, can be set with the POD<p>:THReshold:UDLevel<u> command.

USER2
USER? level, can be set with the POD<p>:THReshold:UDLevel<u> command.

POD<p>:THReshold:UDLevel<u> <Threshold Level>
Set the User high level threshold for the pod.

Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.
<u> Select the User setting. (USERT, USER?2)
Parameters:
<Threshols Level> Range: -2t08
Increment:  le-2
Default unit: V
POD<p>:STATe <State>
Switches the Pod on or off.
Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.
Parameters:
<State> ON | OFF
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POD<p>:DATA? <Data>
Returns the data of the POD. The data can be used in MATLAB, for example.

To set the export format, use ,FORMat [ : DATA] ™ on page 50.
Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.

Return values:
<Data> List of values according to the format settings.

Usage: Query only

POD<p>:DATA:HEADer?
Returns the header of data of the POD.

Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.

Table 2.1: Header data

Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Number of Samples 1200
4 Number of values per sample interval. 2
For PeakDetect waveforms the value is 2.

Usage: Query only

POD<p>:DATA:POINts <Points>
Returns the number of available data.

As a setting, the command selects a range of samples. As a query, it returns the number of samples for the selected
range.

To get correct results with settings MAX and DMAX, the acquisition must not run when the command is used. To acquire
consistent and valid data, use the SINGle command before. Do not cancel a running acquisition with STOP because the
waveform data might be incomplete or incorrect. Please use the command ACQuire:STATe STOP to stop the acquisi-
tion.

Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.

Return values:
<Points> Number of data points in the selected range.

Default unit: Samples
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Setting Parameters:
<Points> DEFault | MAXimum | DMAXimum

Sets the range for the query.

DEFault
Waveform samples displayed on the screen.

MAXimum
Range is the complete memory (only available in STOP mode).

DMAXimum
Display maximum:number of samples in the current waveform record (only available in
STOP mode).

POD<p>:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.

Return values:
<Xincrement> Timeins

Usage: Query only

POD<p>:DATA:XORigin?
Return the time of the first sample of the indicated waveform (depending on the trigger event t=0J.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8[16).

Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.

Return values:
<Xorigin> Timeins

Usage: Query only
POD<p>:DATA:YINCrement?

Returns the value per bit of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<p> Select the Pod.
The possible number of Pods are 1 for HMQ72x...202x and 2 for HM0352x/HM02524.
Usage: Query only
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2.2.6

POD<p>:DATA:YORigin
Return the value for binary value 0 of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<p> Select the Pod.

The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.

POD<p>:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<p> Select the Pod.

The possible number of Pods are 1 for HM072x...202x and 2 for HM0352x/HM02524.

Return values:
<Yresolution> For default waveforms, the resolution is 8 hit.

Usage: Query only

Waveform Data

CHANRELSM > i DATATY e 46
CHANRel<m>:DATAHEADET? oo 47
CHANRNel<m>:DATAENVEIOPET? oo 47
CHANRel<m>:DATA:ENVelope:HEADEr? ..o 48
CHANRNel<m>:DATAXINCIrEmMENt? .o 48
CHANnel<m>:ENVelope:DATAXINCrement?. ..o 48
CHANNel<m>:DATAXORIGINT oo 48
CHANRel<m>:DATA:ENVelope:XORIGINT .ot 48
CHANRel<m>:DATAYINCremMENt? .o 49
CHANRel<m>:DATA:ENVelope:YINCrement?. ... 49
CHANRNel<m>:DATAYORIGINT oot 49
CHANnel<m>:DATA:ENVelope:YORIGINT ..ottt 49
CHANRel<m>:DATA:YRESOIULION? .oiiiiiceeeeeeee 49
CHANnel<m>:DATA:ENVelope:YRESOIUtION? ..o 49
CHANRel<m>:DATA:POINtS <POINtS> ..o 49
FORMat[:DATA] <DataFormat>,<ACCUIaCY> .......c..ooiiiii i 50
FORMat:BORDer <ByteOrder>........cociiiiiiiiii i 51
CHANnel<m>:DATA?

Returns the data of the channel waveform points. The waveforms data can be used in MATLAB, for example.

For envelope waveforms, use the CHANnel<m>:DATA:ENVelope command.
To set the export format, use ,FORMat [ : DATA] ™ on page 50.

Suffix:

<m> Selects the input channel. The number of channels depends on the instrument.

Return values:
<Data> List of values according to the format settings.

Example: CHANT:DATA?

-0.125000,-0.123016,-0.123016,-0.123016, -0.123016,-0.123016,...

Usage: Query only
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CHANnel<m>:DATA:HEADer?
Returns information on the channel waveform.
For envelope waveforms, use the CHANnel<m>:DATA: ENVelope : HEADer command.

Table 2.2: Header data

Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval. 2
For PeakDetect waveforms the value is 2.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:
<DataHeader> Comma-separated value list

Example: CHAN:DATA:HEAD?
-9.477E-008,9.477E-008,200000,1

Usage: Query only

CHANnel<m>:DATA:ENVelope?

Returns the data of the envelope waveform.

Use this command only for envelope waveforms. for all other channel waveforms use CHANnel<m>:DATA.
To set the export format, use ,FORMat [ : DATA] ™ on page 50.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:

<Data> List of values according to the format settings.
Usage: Query only
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CHANnel<m>:DATA:ENVelope:HEADer?
Returns information on the envelope waveform.

Use this command only for envelope waveforms. for all other channel waveforms use CHANnel<m>:DATA : HEADer .

Table 2.3: Header data

Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Number of Samples 1200
4 Number of values per sample interval. 2
For envelope waveforms the value is 2.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:

<DataHeader> Comma-separated value list
Example: -9.477E-008,9.477E-008,1200,2
Usage: Query only

CHANnel<m>:DATA:XINCrement?

CHANnel<m>:ENVelope:DATA:XINCrement?

Return the time difference between two adjacent samples of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:
<Xincrement> Timeins

Usage: Query only

CHANnel<m>:DATA:XORigin?

CHANnel<m>:DATA:ENVelope:XORigin?

Return the time of the first sample of the indicated waveform (depending on the trigger event t=0J.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8[16).

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:

<Xorigin> Timeins
Usage: Query only
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CHANnel<m>:DATA:YINCrement?

CHANnel<m>:DATA:ENVelope:YINCrement?

Return the value per bit of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:
<Yincrement> VIA

Usage: Query only

CHANnel<m>:DATA:YORigin?

CHANnel<m>:DATA:ENVelope:YORigin?

Return the value for binary value 0 of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 816).

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:
<Yorigin> VIA

Usage: Query only

CHANnel<m>:DATA:YRESolution?

CHANnel<m>:DATA:ENVelope:YRESolution?

Return the vertical bit resolution of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8[16).

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

Usage: Query only

CHANnel<m>:DATA:POINts <Points>
As a setting, the command selects a range of samples. As a query, it returns the number of samples for the selected
range.

To get correct results with settings MAX and DMAX, the acquisition must not run when the command is used. To acquire
consistent and valid data, use the SINGle command before. Do not cancel a running acquisition with STOP because the
waveform data might be incomplete or incorrect.

Suffix:
<m> Selects the input channel. The number of channels depends on the instrument.

Return values:
<Points> Number of data points in the selected range.
Default unit:Samples
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Setting Parameters:
<Points> DEFault | MAXimum | DMAXimum

Sets the range for the query.

DEFault
Waveform samples displayed on the screen.

MAXimum
Range is the complete memory (only available in STOP mode).

DMAXimum

Display maximum:number of samples in the current waveform record (only available in
STOP mode).

Example: The instrument is set up with an automatic waveform rate. The acquisition will record
TMByte. 800.000 points of TMByte can be shown within the display. To increase the
performance of the device the record is decimated to 6000 points within the displayed area.
Those 6000 points are the displayed waveform.

Reading default data will return the decimated waveform of the display.
Use this by setting CHAN : DATA: POIN DEF.
A query will return 6000 points.

To read all recorded points within the display area use CHAN: DATA : POIN DMAX.
In this case you will get 800.000 points.

Use CHAN:DATA: POIN MAX to get the full record including the data points that can
not be shown on the display.

FORMat[:DATA] <DataFormat>,<Accuracy>

Defines the format for data export with:
CHANnel<m>:DATA? on page 46
CHANnel<m>:DATA:ENVelope? on page 47
CALCulate:MATH<m>:DATA? on page 96
REFCurve<m>:DATA? on page 102
CALCulate:QMATH:DATA? on page xxx

Parameters:

<DataFormat> ASCii | REAL | UINTeger
ASCii
List of values, for example, 1.23,1.22,1.24,..
<Accuracy> is 0, which means that the instrument selects the number of digits to be returned.
The query returns Asc, 0.
REAL
Block data, 32 bit float values in 4 byte blocks.
<Accuracy> is always 32. The query returns REAL, 32.
UINTeger
Unsigned integer format, binary values with length 8 or 16 bit (UINT,8 or UINT,16).
The data range for UINT, 8 is 0 to 255, the data range for UINT, 16 is 0 to 65.535.
For data conversion, you need the results of . . . : DATA:XORigin?,
...:DATA:XINCrement?, ...:DATA:Yorigin?,...:DATA:YINCrement?
and ...:DATA:YRESolution? commands.
*RST:  ASC

<Accuracy> 018116132
Length of a data value in bit
*RST: 0
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Example: Set the ASCII data format:
FORM ASC

Example: Query for data format:
FORM?
-> ASC,0

FORMat:BORDer <ByteOrder>
Defines the byte order for binary data export if FORMat[:DATA] is set to REAL or UINT.

Parameters:
<ByteOrder> MSBFirst | LSBFirst
MSBFirst
Big endian, most significant byte first, for example:
abcd,acbe,abcf, ...
LSBFirst
Little endian, least significant byte first, for example:
dcba,ebca,fchba, ...
*RST:  MSBF
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2.2.7 Probes

PROBe<m>:SETuUp:TYPE?. ...
PROBe<m>:SETup:ATTenuation:UNIT <UNit> ..o,

PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation> .........cccoooiiiiinennn, 52
PROBe<m>:SETup:ATTenuation[:AUTO]?. ..o 52

PROBe<m>:SETup:TYPE?
Queries the type of the probe.

Suffix:
<m> Selects the input channel. The number of channels depends
on the instrument.

Return values:
<Type> NONE | ACTive | PASSive

NONE not detected

ACTive  active probe

PASSive passive probe
Usage: Query only

PROBe<m>:SETup:ATTenuation:UNIT <Unit>
Selects the unit that the probe can measure.

Suffix:

<m> Selects the input channel. The number of channels depends on
the instrument.

Parameters:

<Unit> VIA

PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation>
Sets the attenuation of the probe if the probe was not detected by the instrument.

Suffix:

<m> Selects the input channel. The number of channels depends on
the instrument.

Parameters:

<ManualAttenuation> Range: 0.001 to 1000

*RST:1
PROBe<m>:SETup:ATTenuation[:AUTO0]?
Returns the attenuation of an automatically detected probe.
Suffix:
<m> Selects the input channel. The number of channels depends on

the instrument.

Return values:

<ProbeAttenuation> Range: 0.001 to 1000
Usage: Query only
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2.3

2.3.1

Trigger

General A Trigger SETHINGS oot 53
B G TG i 55
WAL TIIGG T i 57
VIdEO/TV TIIGUET oo 58
Pattern TrIGGET oo 59
BT I gT eeeeeeee 61

General A Trigger Settings

TRIGger:A:MODE <TriggerModes . ... 53
TRIGger:A:LEVel<n>[:VALUe] <Level> ..., 53
TRIGGer:A:SOURCE <SOUMCE™ .ot o4
TRIGger:EXTern:COUPLling <ExternCoupling> .....ccooiiiiiiiiiii e o4
TRIGGEr:A:TYPE <TYPE> i 54

TRIGger:A:MODE <TriggerMode>

Sets the trigger mode. The trigger mode determines the behaviour of the instrument if no trigger occurs.

Parameters:
<TriggerMode> AUTO | NORMal

AUTO

The instrument triggers repeatedly after a time interval if the trigger conditions

are not fulfilled. If a real trigger occurs, it takes precedence.

NORMal

The instrument acquires a waveform only if a trigger occurs.

*RST: AUTO

TRIGger:A:LEVel<n>[:VALue] <Level>
Sets the trigger treshold voltage for all A trigger types that require a trigger level.

Suffix:

<n> Selects the trigger input. 1...4 select the corresponding channel, 5 is the external
trigger input. The number of channels depends on the instrument.

Parameters:

<lLevel> Default unit: V
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TRIGger:A:SOURce <Source>
Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1|CH2 | CH3 | CH4 | DO0..D15 | BUST | BUS2 | EXTernanalog | LINE | NONe | PATTern

CH1|CH2|CH3|CH4
One of the input channels is the trigger source. Available channels depend on the
instrument type.

DO...D15
Slope trigger on the POD bit. Available digital channels depend on the
instrument type.

BUS1 | BUS2
Trigger on serial BUS [depend on the instrument type).

EXTernanalog
External Trigger Input on the rear / front panel.

LINE
AC line for the edge trigger.

NONE
No trigger (e.g. in roll mode).

PATTern
Pattern, if logic trigger is active.

TRIGger:EXTern:COUPLling <ExternCoupling>
Sets the coupling for the external trigger input. The command is relevant if TRIGger:B: SOURce is set to
EXTernanalog.

Parameters:
<ExternCoupling> AC | DC

*RST: AC

TRIGger:A:TYPE <Type>
Sets the trigger type for the A trigger.

Parameters:

<Type> EDGE | WIDTh | TV | LOGic | BUS
EDGE: edge trigger
WIDTh: width trigger
TV: video trigger
LOGic: logic trigger
BUS: bus trigger, requires options for serial trigger and decode
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2.3.2 Edge Trigger

TRIGger:A:EDGE:SLOPe <SLOPE> oot 55
TRIGger:A:EDGE:COUPUNG <CoUPLING> .oiiiiiiiiiiiiic e 55
TRIGger:A:EDGE:FILTer:LPASS <State> ..o 56
TRIGger:A:EDGE:FILTer:NREJect <State> ..., 56

TRIGger:A:EDGE:SLOPe <Slope>
Sets the slope for the edge trigger (A trigger).

Parameters:
<Slope>

POSitive | NEGative | EITHer

POSitive
Rising edge, a positive voltage change

NEGative
Falling edge, a negative voltage change

EITHer
Rising as well as the falling edge (alternating)

*RST: PQOSitive

TRIGger:A:EDGE:COUPLling <Coupling>
Sets the coupling for the trigger source.

Parameters:
<Coupling>

DC | AC | HF | ALEVel

DC
Direct Current coupling. The trigger signal remains unchanged.

AC
Alternating Current coupling. A 5 Hz high pass filter removes the DC offset voltage
from the trigger signal.

HF
High frequency coupling. A 15 kHz high-pass filter removes lower frequencies from
the trigger signal. Use this mode only with very high frequency signals.

ALEVel
Auto Level in HMO series 722 to 2024.

*RST: DC
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TRIGger:A:EDGE:FILTer:LPASs <State>

Turns an additional 5 kHz low-pass filter in the trigger path on or off. This filter removes higher frequencies and is
available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:A:EDGE:FILTer:NREJect <State>
Turns an additional 100 MHz low-pass filter in the trigger path on or off. This filter removes higher frequencies and is
available with AC and DC coupling.

Parameters:
<State> ON | OFF
*RST: OFF
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2.3.3 Width Trigger

TRIGger:A:WIDTh:POLarity <Polarity> ... 57
TRIGger:A:WIDTh:RANGe <RangeMode> ... 57
TRIGger:-A:WIDTh:DELTa <Deltas> ..o 57
TRIGger:A:WIDTh:WIDTh <TIMET> .ot 57

TRIGger:A:WIDTh:POLarity <Polarity>
Sets the polarity of the pulse.

Parameters:
<Polarity> POSitive | NEGative

POSitive
Positive going pulse, the width is defined from the rising to the falling slopes.

NEGative
Negative going pulse, the width is defined from the falling to the rising slopes.

*RST: POSitive

TRIGger:A:WIDTh:RANGe <RangeMode>
Defines how the measured pulse width is compared with the given limit(s).

Parameters:
<RangeMode> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide
Triggers on pulses inside or outside a range defined by time + delta. The time is specified
with TRIGger :A:WIDTh:WIDTh, the range around is defined with TRIGger: A:WIDTh:DELTa.

SHORter | LONGer
Triggers on pulses shorter or longer than a time set with TRIGger :A:WIDTh:WIDTh.

*RST: LONGer

TRIGger:A:WIDTh:DELTa <Delta>
Defines a range around the width value specified using TRIGger:A:WIDTh:WIDTh.

Parameters:

<Delta> Range +At (Variation”)
Range: 3.2E-9 to maximum value depends on the defined pulse width
Increment:  3.2E-9

*RST: 3.2E-9
TRIGger:A:WIDTh:WIDTh <Time1>
For the ranges WITHin and OUTSide (defined using TRIGger: A:WIDTh:RANGe), the <Time1> defines the center of a

range which is defined by the limits +<Delta> [set with TRIGger:A:WIDTh:DELTa).

For the ranges SHORter and LONGer, the width defines the maximum and minimum pulse width, respectively.

Parameters:
<Timel> Center value, maximum value or minimum value depending on the defined range type.
Range: 19.2E-9 to 107.374E-3 [depending on model]
Increment:  6.4E-9, fort > 1 ms:1 ps [depending on model]
*RST: 19.2E-9
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2.3.4 Video/TV Trigger

TRIGger:A:TV:STANdard <Standard> ..o 58
TRIGger:A:TV:POLarity <Polarity> ..o 58
TRIGger:A:TV:FIELd <Field> e 58
TRIGGer:A:TV:LINE <LiNe> .o 58

TRIGger:A:TV:STANdard <Standard>
Selects the color television standard.

Parameters:
<Standard> PAL | NTSC | SECam | PALM | 1576 | P720 | P1080 | 11080

*RST: PAL
TRIGger:A:TV:POLarity <Polarity>
Sets the polarity of the sync pulses. The edges of the sync pulses are used for triggering.

Parameters:
<Polarity> POSitive | NEGative

POSitive If the video modulation is positve, the sync pulses are negative.
NEGative If the modulation is negative, sync pulses are positive.

*RST: NEGative

TRIGger:A:TV:FIELd <Field>
Sets the trigger on the beginning of the video signal fields, or on the beginning of video signal lines.

Parameters:

<Field> EVEN | ODD | ALL | LINE | ALINe
EVEN Triggers only on even half frames.
0DD Triggers only on odd half frames.
ALL Triggers on all frames.
LINE Triggers on the beginning of a specified line in any field.

The line number is set with TRIGger:A: TV:LINE.

ALINe Triggers on the beginning of all video signal lines.
*RST: ALL

TRIGger:A:TV:LINE <Line>
Sets an exact line number if TRIGger:A:TV:FIELd is set to LINE.

Parameters:
<Line> Range: 1to 525, 625, ..., 1080 depending on the TV standard
Increment: 1
*RST: 1
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2.3.5 Pattern Trigger

TRIGger:A:PATTern:SOURce <SoUrceString> ..o 59

TRIGger:A:PATTern:FUNCtion <FUNCLION> ..o
TRIGger:A:PATTern:CONDition <Condition>
TRIGger:A:PATTern:MODE <PatternMode>

TRIGger:A:PATTern:WIDTh[:WIDTh] <numeric_value> ..........c.cccoovoiiiiiiiiiiieee, 60
TRIGger:A:PATTern:WIDTh:DELTa <PatternDelta> ... 60
TRIGger:A:PATTern:WIDTh:RANGe <PatternRange> ... 60

TRIGger:A:PATTern:SOURce <SourceString>
Select the state for each digital channel.

Parameters:

<SourceString> string containing 0, 1, or X for each channel
1: high, the signal voltage is higher than the trigger level.
0: low, the signal voltage is lower than the trigger level.
X: Don't care. the channel does not affect the trigger.

Example: TRIG:A:PATT:SOUR ., 1X10"

CH1, CH3, and NOT CH4 are logically combined with

TRIGger:A:PATTern:FUNCtion, CH2 does not matter (don't care).

TRIGger:A:PATTern:FUNCtion <Function>
Sets the logical combination of the trigger states of the channels.

Parameters:
<Function> AND | OR

AND

The required states of all channels must appear in the input signal at the same time.

OR
At least one of the channels must have the required state.

*RST: AND

TRIGger:A:PATTern:CONDition <Condition>

Sets the trigger point depending on the result of the logical combination of the channel

states.

Parameters:
<Condition> "“TRUE" | "FALSE"

*RST: "TRUE"
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TRIGger:A:PATTern:MODE <PatternMode>
Sets the duration function of the pattern trigger.

Parameters:
<PatternMode> OFF | TIMeout | WIDTh

OFF
only pattern trigger without duration

TIMeout
pattern trigger with duration and timeout

WIDTh
using duration and comparision of the width of the logical combined channel

*RST: OFF

TRIGger:A:PATTern:WIDTh[:WIDTh] <numeric_value>

For the ranges WITHin and OUTSide (defined using TRIGger :A: PATTern:WIDTh:RANGe), the <numeric_value> de-
fines the center of a range which is defined by the limits +<Delta> (set with TRIGger:A: PATTern:WIDTh:DELTa).

For the ranges SHORter and LONGer, the width defines the maximum and minimum pulse width, respectively.

Parameters:
<numeric_value> Center value, maximum value or minimum value depending on the defined range type.

Range: 19.2E-9 to 107.374E-3 [depending on model]
Increment:  6.4E-9, fort>1ms:1 ps

*RST: 19.2E-9

TRIGger:A:PATTern:WIDTh:DELTa <PatternDelta>
Defines a range around the width value specified using TRIGger:A: PATTern:WIDTh[:WIDTh]

Parameters:
<Delta> Range +At (. Variation”)

Range: 3.2E-9 to maximum value depends on the defined pulse width
Increment:  3.2E-9

*RST: 3.2E-9

TRIGger:A:PATTern:WIDTh:RANGe <PatternRange>
Defines a range around the width value specified using TRIGger:A:PATTern:WIDTh:WIDTh.

Parameters:
<PatternRange> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide

Triggers on pulses inside or outside a range defined by time + delta. The time is specified
with TRIGger:A: PATTern:WIDTh[:WIDTh], the range around is defined with
TRIGger:A:PATTern:WIDTh:DELTa.

SHORter | LONGer
Triggers on pulses shorter or longer than a time set with
TRIGger:A:PATTern:WIDTh[:WIDTh]

*RST: LONGer
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2.3.6 B-Trigger

TRIGger:B:ENABle <State>
TRIGger:B:SOURce <Source>
TRIGger:B:EDGE:SLOPe <Slope>
TRIGger:B:LEVel <Level>
TRIGger:B:MODE <Mode>
TRIGger:B:DELay <DelayTime>
TRIGger:B:EVENt:COUNt <EventCnt>

TRIGger:B:ENABle <State>
Activates or deactivates the second trigger.

The instrument triggers if both trigger event conditions (A and BJ are fulfilled.

Parameters:
<State> ON | OFF

*RST: OFF

TRIGger:B:SOURce <Source>

Selects one of the input channels as B-trigger source. Available channels depend on the

instrument type.

Parameters:
<Source> CH1|CH2 | CH3 | CH4

*RST: CH1
TRIGger:B:EDGE:SLOPe <Slope>
Sets the edge for the B-trigger.

Parameters:
<Slope> POSitive | NEGative | EITHer (alternating)

*RST: POSitive
TRIGger:B:LEVel <Level>
Sets the trigger level for the B-trigger event.

Parameters:
<Level> Default unit: V

*RST: 0
TRIGger:B:MODE <Mode>
Defines the delay type of the B-trigger.

Parameters:
<Mode> DELay | EVENts

DELay
Time delay, set with TRIGger:B:DELay

EVENts

Event count delay, set with TRIGger:B:EVENt : COUNt

*RST: DELay
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TRIGger:B:DELay <DelayTime>
Sets the time the instrument waits after an A-event until it recognizes B-events.
Before setting the delay time, TRIGger : B:MODE must be set to DELay.

Parameters:

<DelayTime> Range: 8E-9 min., depending on model
Increment: depending on model
Default unit: s

*RST: 8E-9 min., depending on model

TRIGger:B:EVENt:COUNt <EventCnt>

Sets a number of B-trigger events that fulfill all B-trigger conditions but do not cause the trigger. The oscilloscope trig-
gers on the n-th event (the last of the specified number of events).

Before setting the event number, TRIGger:B:MODE must be set to EVENts.

Parameters:
<EventCnt> Number of B-events
Range: 1 to 65535
Increment: 1
*RST: 1
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2.4

2.4.1

Display

Basic Display SETLINGS oo 63
ZOOMN .o 68
Markers (TImestamps) ..o 69
Basic Display Settings

This chapter describes commands that configure the screen display.

General Display Settings:

DISPLay:MODE <MOGE> ..ot 63
DISPlay:PALette <Palette> ..o 63
DISPlay:VSCREEN:ENABLle <Enable> ..o A
DISPlay:VSCREEN:POSItion <PoSItion> ... A
XYZ-Setup:

DISPLay:XY:XSOUICE <SOUMCEDS ..ottt b4
DISPLlay:XY:YTSOUrCe <SOUMCES .ot b4
DISPLlay:XY:Y2S0UrCe <SOUMCES .ottt A
DISPLay:XY:ZMODE <MOTE> ..ot 65
DISPlay:XY:ZTHReshold <Zthreshold> ..o 65
DISPLay:XY:ZSOUICe <SOUMCE> ..ottt 65
Intensities

DISPlay:INTensity:WAVeform <Intensity> ... 65
DISPlay:INTensity:BACKLight <INtensity> ..o 66
DISPlay:INTensity:GRID <INtensity> ... 66
DISPlay:PERSistence:STATe <State> ..o 66
DISPlay:PERSistence:TIME <TImMe> ... 66
DISPlay:PERSistence:INFinite <InfPersistence> ... 66
DISPlay:PERSistence:TIME:AUTO <AULO> ..o 67
DISPlay:PERSIStence:CLEAN oo 67
Waveform, Auxilary Cursors and Grid Settings

DISPLay:STYLE <SEYLES Lot 67
DISPLay:GRID:STYLE <SYLE> ittt 67

DISPlay:MODE <Mode>
Sets the diagram mode.

Parameters:
<Mode>

YT I XY

YT
Default time diagram with a time axis in x-direction and the signal amplitudes displayed
in y-direction.

XY
XY-diagram, combines the voltage levels of two waveforms in one diagram.

*RST: YT

DISPlay:PALette <Palette>
Sets the color and brightness of the displayed waveform samples depending on their cumulative occurance.

Parameters:
<Palette>

NORMal | INVerse | FCOLor | IFColor

NORMal
Values that occur frequently are brighter than rare values.

INVerse
Rare values are brighter than frequent values, inverse to the NORMal brightness.
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FColor
Rare values are displayed in blue, while more frequent values are red and very frequent
values are displayed in yellow or white, with various colors inbetween.

IFColor
Inverses the FColor setting:rare values are yellow or white while frequent values are blue.

*RST: NORMal
DISPlay:VSCREEN:ENABle <Enable>
Switches the virtual screen on or off.

Parameters:
<Enable> ON | OFF

*RST: OFF
DISPlay:VSCREEN:POSition <Position>
Set the position of the virtual screen window.
Parameters:
<Position> Range: 2to -8
Increment: 0.02
Default unit: div
*RST: 0
DISPlay:XY:XSOurce <Source>

Defines the source to be displayed in x direction in an XY-diagram, replacing the usual time base.

Parameters:
<Source> CH1 |1 CH2|CH3 | CH4

*RST: CH1
DISPlay:XY:Y1Source <Source>
Defines the y source of the first xy waveform in the diagram.

Parameters:
<Source> CH1|CH2 | CH3 | CH4

*RST: CH2

DISPlay:XY:Y2Source <Source>
Defines the y source of the second xy waveform in the diagram.

Parameters:
<Source> NONE | CH1 | CH2 | CH3 | CH4
*RST: NONE
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DISPlay:XY:ZMODe <Mode>
Activates or deactivates the intensity control of the waveform via an additional signal
source and sets the intensity mode.

Parameters:
<Mode> ANALog | DIGital | OFF

ANALog
Modulated intensity; Intensity is modulated continuously according to the selected source Z.

DiGital

Intensity is determined by a threshold value defined with DISPlay:XY:ZTHReshold.
If the Z signal value is below the selected threshold, the corresponding x/y point is
displayed with lowest intensity. If the Z signal value is above the threshold, the

x/y point is displayed with the defined intensity level.

OFF
Intensity control is deactivated.

*RST: OFF

DISPlay:XY:ZTHReshold <Zthreshold>
Defines the threshold for intensity with a two-state modulation, if DISPlay:XY: ZMODe is set to DIGital.

Parameters:
<Zthreshold> Threshold for visibility on the screen
Range: -10to 10
Increment: depends on the scaling of the channel that is assigned to Z

Default unit: 'V
*RST: 0
DISPlay:XY:ZSOurce <Source>

Defines the source to be used to determine the intensity of the xy-waveform.

Parameters:
<Source> CH1 |1 CH2|CH3 | CH4

*RST: CH1

DISPlay:INTensity:WAVeform <Intensity>
Defines the strength of the waveform line in the diagram.

Parameters:
<Intensity> Value in percent
Range: 0to 100
Increment: 1
Default unit: %
*RST: not available, (*RST does not change the intensity)
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DISPlay:INTensity:BACKlight <Intensity>
Defines the intensity of the background lighting of the display.

Parameters:

<Intensity> Value in percent
Range: 10 to 100
Increment: 1
Default unit: %

*RST: not available, (*RST does not change the intensity)

DISPlay:INTensity:GRID <Intensity>
Defines the intensity of the grid on the screen.

Parameters:

<Intensity> Value in percent
Range: 0to 100
Default unit: %

*RST: not available, (*RST does not change the intensity)

DISPlay:PERSistence:STATe <State>
Defines whether the waveform persists on the screen or whether the screen is refreshed continuously.

Parameters:
<State> ON | OFF

ON
The waveform persists for the time defined using DISPlay:PERSistence:TIME.

OFF

The waveform does not persist on the screen. Only the currently measured values are
displayed at any time.

*RST: OFF

DISPlay:PERSistence:TIME <Time>
Persistence time if persistence is active (see DISPlay:PERSistence:STATe).

Each new data point in the diagram area remains on the screen for the duration defined here. To set infinite persistence,
use DISPlay:PERSistence:INFinite.

Parameters:

<Time> Range: 50E-3 to infinite
Increment:  min. 50E-3, increasing increment with increasing persistence time
Default unit: s

*RST: 50E-3
DISPlay:PERSistence:INFinite <InfPersistence>

Sets the persistence time to infinite if DISPlay:PERSistence:STATe is ON. each new data point remains on the
screen infinitely until this setting is changed or the persistence is cleared.

Parameters:
<InfPersistence> ON | OFF
*RST: OFF
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DISPlay:PERSistence:TIME:AUTO <Auto>
The optimal persistence time is determined automatically by the instrument.

Parameters:
<Auto> ON | OFF

DISPlay:PERSistence:CLEar
Removes the displayed persistent waveform from the screen.

Usage: Event

DISPlay:STYLe <Style>

Defines how the waveform data is displayed

Parameters:

<Style> VECTors | DOTS
VECTors: Individual data points are connected by a line.
DOTS: Only the data points are displayed.
*RST: VECT

DISPlay:GRID:STYLe <Style>
Defines how the grid is displayed.

Parameters:
<Style> LINes | RETicle | NONE
LINes: Displays the grid as horizontal and vertical lines.
RETicle: Displays crosshairs instead of a grid.
NONE: No grid is displayed.
*RST: LIN
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2.4.2 Zoom
TIMebase:ZO0OM:STATe <ZoomState> ... 68
TIMebase:Z00M:SCALe <ZoomScale> ... 68
TIMebase:ZOOM:TIME <Times> e 68

TIMebase:Z00M:POSition <Position>

TIMebase:ZOOM:STATe <ZoomState>
Switches the zoom window on or off.

Parameters:
<ZoomState> ON | OFF

*RST: OFF
TIMebase:ZOOM:SCALe <ZoomScale>
Defines the time base in the zoom diagram in seconds per division.
Parameters:
<ZoomScale> Scaling of the zoom time base

Default unit: s/div

*RST: 50e-6
TIMebase:ZOOM:TIME <Time>

Defines the offset of the trigger point to the reference point of the zoom diagram.

Parameters:
<Time> Default unit: s

*RST: 0
TIMebase:Z0OOM:POSition <Position>

Defines the position of the zoom reference point [the reference point of the zoom window] in relation to the reference
point of original time base.

Parameters:
<Position> Range: 0 to 100, depending on the zoom time base
Default unit: %
*RST: 50
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2.4.3 Markers (Timestamps)

T AR S E T e

TSTamp:NEXT

TSTamMP:PREVIOUS oo
TSTaMP:CLEAN e
ST AP IACLEAT e

TSTamp:SET

Sets a new marker (timestamp) at the reference point of the display, unless an existing marker is already set there. The

reference point is set with ,TIMebase:REFerence“ on page 33.

Deletes the marker (timestamp) at the reference point. The reference point is set with ,, TIMebase:REFerence“ on

Usage: Event

TSTamp:NEXT

Moves the next marker (timestamp, to the right] to the reference point of the display or zoom area.
Usage: Event

TSTamp:PREVious

Moves the previous marker (timestamp, to the left) to the reference point of the display or zoom area.
Usage: Event

TSTamp:CLEar

page 33.

Usage: Event

TSTamp:ACLear

Deletes all markers (timestamps).

Usage: Event
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2.5

2.5.1

Measurements

This chapter describes functions that configure or perform cursor and automatic measurements.

U S0 e 70
Automatic MeasUremMENTS ..o i 76
Cursor

CURSOr<m > AOFF e 70
CURSor<m>:STATE <State> ..o 70
CURSOr<m>:FUNCHION <TYPE> ..iiiiiiiiiiiii et 71
CURSOr<m>:SOURCE SSOUMCES ..ottt 71
CURSor<m>:TRACKIng[:STATe] <State> ... 72
CURSor<m>:X1Position <XpoSitioNT> ... 72
CURSor<m>:X2Position <XpOSItIONZ> . .iiiiiiiiiiiiii e 72
CURSor<m>:X3Position <XpoSIioN3> ..ot 72
CURSor<m>:YTPosition <YPoSItIoNT> ..o 72
CURSor<m>:Y2Position <YPOSItION2> ..o 73
CURSor<m>:Y3Position <Yposition3> ... 73
CURSor<m>:TRACking:SCALe[:STATe] <State> ... 73
CURSor<m>:YCOUPLNG <CoUPLING™ ..ottt 73
CURSor<m>:XCOupling <Coupling> ..ot 73
CURSOr<m>:RESUI? .o 74
CURSor<m>:XDELta:INVErse? ..o A
CURSor<m>:XDELtal:VALUEI? ..o 74
CURSO0or<m>:YDELta:SLOPE? .ottt 74
CURSor<m>:YDELtal:VALUEI? ..o 75
CURsor<m>:XRATIo:UNIT <URNIt> ..o 75
CURSOor<m>:XRATIOLEVALUEI? Lo 75
CURSor<m>:YRATIO:UNIT <UNIt> oot 75
CURSor<m>:YRATIO[:VALUE]? oo 76
CURSor<m>:AOFF

Switches the cursor off.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Usage: Event

CURSor<m>:STATe <State>
Activates or deactivates the cursor measurement.

Suffix:

<m> 1 [the numeric suffix is irrelevant)
Parameters:

<State> ON | OFF

*RST: OFF
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CURSor<m>:FUNCtion <Type>
Defines the cursor measurement type.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Parameters:

<Type> HORizontal | VERTical | PAIRed | HRATio | VRATio | PPCount |

NPCount | RECount | FECount | MEAN | RMS | RTIMe | FTIMe |
PEAK | UPEakvalue | LPEakvalue | STDDEV | PDCYcle | NDCYcle

HORizontal: Sets two horizontal cursor lines and measures the voltages at the two cursor
positions and the delta of the two values.

VERTical: Sets two vertical cursor lines and measures the time from the trigger point to
each cursor, the time between the two cursors and the frequency calculated
from that time.

PAIRed: V-Marker

HRATio: Ratio of the x-values (e.g. a duty cycle) between the first and second cursors
and the first and third cursors

VRATio: Ratio of the y-values (e.g. overshooting) between the first and second cursors
and the first and third cursors

PPCount: Count positive pulses

NPCount:  Count negative pulses

RECount: Count rising edges
FECount: Count falling edges

MEAN: Mean value

RMS: Root mean square

RTIMe: Rise time, tr

FTIMe: Fall time, tf. The reference level for rise and fall time measurement is set with
,REFLevel<m>:RELative:MODE“ on page 78.

PEAK: Absolute difference between the two peak values, Vpp

UPEakvalue: Upper peak value, Vp+
LPEakvalue: Lower peak value, Vp
STDDEV standard deviation
PDCYcle positive duty cycle
NDCYcle negative duty cycle

*RST: PAIR

CURSor<m>:SOURce <Source>
Defines the source of the cursor measurement as one of the active signal, reference or math channels.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Parameters:

<Source> NONE | CH1 | CH2 | CH3 | CH4 | POD1 | POD2 | DO...D15 [QMA | MAT | MA2 | MA3 | MA4 |
MA5 | RET | RE2 | RE3 | RE4 | XY1 | XY2
CH1|CH2 | CH3 | CH4
Active signal channels 1to 4
POD1 | POD2
Active logic POD (depending on the instrument type)
DO...D15
Active digital channels from DO up to D15 [depending on the instrument type)
QMA
Active quick math channel
MA1 | MA2 | MA3 | MA4 | MAS
Active math channels 1t0 5
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RE1|RE2 | RE3 | RE4
Active reference channels 1to 4

XY1 | XY2
Active XY-waveform

*RST: CH1

CURSor<m>:TRACKing[:STATe] <State>
If set to ON, the V-Marker cursor measurement is enabled.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<State> ON | OFF

*RST: OFF

CURSor<m>:X1Position <Xposition1>
Specifies the position of the first cursor on the time axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition1> Default unit: s

CURSor<m>:X2Position <Xposition2>
Specifies the position of the second cursor on the time axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition2> Default unit: s

CURSor<m>:X3Position <Xposition3>
Specifies the position of the third cursor on the time axis for the Ratio X measurement.

Suffix:

<m> 1 [the numeric suffix is irrelevant)
Parameters:

<Xposition3> Default unit: s

CURSor<m>:Y1Position <Yposition1>
Specifies the position of the first horizontal cursor on the y-axis.

Suffix:
<m> 1 (the numeric suffix is irrelevant)
Parameters:
<YpositionT> Default unit: V
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CURSor<m>:Y2Position <Yposition2>
Specifies the position of the second horizontal cursor on the y-axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Yposition2> Default unit: V

CURSor<m>:Y3Position <Yposition3>
Specifies the position of the third horizontal cursor on the y-axis for Ratio Y measurements.

Suffix:

<m> 1 [the numeric suffix is irrelevant)
Parameters:

<Yposition3> Default unit: V

CURSor<m>:TRACKking:SCALe[:STATe] <State>
Enables the adjustment of cursor lines if the vertical or horizontal scales are changed.

Suffix:

<m> 1 [(the numeric suffix is irrelevant)
Parameters:

<State> ON | OFF

ON
Cursor lines keep their relative position to the waveform.

OFF
Cursor lines remain on their position on the display if the scaling is changed.

*RST: OFF

CURSor<m>:YCOupling <Coupling>
CURSor<m>:XCOupling <Coupling>
If enabled, the cursors of a set are coupled so that the distance between the two remains the same if one cursor is

moved.
Suffix:
<m> 1 (the numeric suffix is irrelevant)
Parameters:
<Coupling> ON | OFF
*RST: OFF
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CURSor<m>:RESult?

Returns a result depending on the selected cursor function.
Suffix:

<m> 1 (the numeric suffix is irrelevant)

Return values:
<Value> Measurement result

Example: If CURSor<m>:FUNCtion is set to RTIM, CURSor<m>:RESult? will return the risetime
of a slope between both cursors.
If the function is set to MEAN, CURSor<m>:RESult? will return the measured mean value.
If there is no specific value, CURSor<m>:RESult? will return the position of the first cursor.

Usage: Query only
CURSor<m>:XDELta:INVerse?
Returns the inverse time difference between the two cursors (1/At).

Suffix:
<m> 1 [the numeric suffix is irrelevant)

Return values:
<Deltalnverse> Default unit: 1/s

Usage: Query only
CURSor<m>:XDELta[:VALuel?
Returns the time difference between the two cursors (At).

Suffix:
<m> 1 [the numeric suffix is irrelevant)

Return values:
<Delta> Default unit: s

Usage: Query only
CURSor<m>:YDELta:SLOPe?
Returns the inverse value of the voltage difference - the reciprocal of the vertical distance of two horizontal cursor

lines:1/AV.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:

<DeltyYslope> Inverse value
Usage: Query only
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CURSor<m>:YDELta[:VALuel?
Queries the delta of the values in y-direction at the two cursors.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<DeltaY> Delta value in V

Usage: Query only

CURsor<m>:XRATio:UNIT <Unit>
Sets the unit for X Ratio measurements with CURSor<m>:XRATio[:VALue].

Suffix:
<m> 1 (the numeric suffix is irrelevant)
Parameters:
<Unit> RATio | PCT | GRD | PI
RATio: floating value
PCT: percent
GRD: degree
Pl: radian
*RST: RAT

CURSor<m>:XRATio[:VALue]?
Returns the ratio of the x-values (e.g. a duty cycle) between the first and second cursors and the first and third
cursors:(x2-x1)/(x3-x1).

Set the unit of the result with CURsor<m>:XRATio:UNIT.

Suffix:
<m> 1 [the numeric suffix is irrelevant)

Return values:
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

CURSor<m>:YRATio:UNIT <Unit>
Sets the unit for Y Ratio measurements with CURSor<m>: YRATio [ :VALue].

Suffix:
<m> 1 (the numeric suffix is irrelevant)
Parameters:
<Unit> RATio | PCT
RATio: floating value
PCT: percent
*RST: RAT
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2.5.2

CURSor<m>:YRATio[:VALue]?

Provides three cursors and measures the ratio of the y-values (e.g. overshooting) between the first and second cursors

and the first and third cursors:(y2-y1)/ly3-y1).
Set the unit of the result with CURSor<m>: YRATio:UNIT.

Suffix:
<m> 1 [(the numeric suffix is irrelevant)

Return values:
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

Automatic Measurements

MEASUrement<m>:AODFF ... 76
MEASUrement<m>:ADN ..o 76
MEASurement<m>:ARESULL? ... 77
MEASurement<m>[ENABLE] <States> ..o 77
MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>] ... 77
MEASUrement<m>:CATEGOMY7 ..ottt 78

REFLevel<m>:RELative:MODE <RelativeMode> ...
MEASurement<m>:MAIN <MeasTypes> ..o
MEASurement<m>:RESult? [<MeasType>] .........ccccoeeeeenn.
MEASurement<m>:RESult:AVG? [<AverageValue>]
MEASurement<m>:RESult:STDDev? [<StandardDeviation>] .............cccccoooiiiiinn, 81
L
l

MEASurement<m>:RESult:NPEak? [<NegativePeak>]...............ooooi 81
MEASurement<m>:RESult:PPEak? [<PositivePeak>] ... 81
MEASurement<m>:RESult: WFMCount? [<WaveformCount>].........cccccvvvvvevieiiiiii.l. 81
MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope>...................... 82
MEASurement<m>:STATistics[:ENABle] <StatisticEnable>..........c..ccoooviiiiieeiin. 82
MEASurement<m>:STATIstics:RESet ... 82
MEASurement<m>:STATistics:WEIGht <AverageCount> ............cc..oooeiiiiiieeeii, 82

MEASurement<m>:AOFF
Stops the quick measurement.

Suffix:
<m> 1.6
The numeric suffix is irrelevant.

Usage: Event
MEASurement<m>:AON

Starts the quick measurement.
Suffix:

<m> 1..6

The numeric suffix is irrelevant.

Usage: Event
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MEASurement<m>:ARESult?
Returns the results of the quick measurement.

Suffix:
<m> 1.6
Selects the measurement.

Return values:

<QuickMeasData> List of values
Quick measurement results are listed in the following order:
PEAK, UPE, LPE, CYCR, CYCM, PER, FREQ, RTIM, FTIM

Usage: Query only

MEASurement<m>[:ENABLle] <State>
Activates or deactivates the selected measurement (1-6). Only the results of active measurements are displayed on the

screen.
Suffix:
<m> 1.6

Selects the measurement.
Parameters:
<State> ON | OFF

*RST: OFF

MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>]
Selects one of the active signal, reference or math channels as the source of the selected measurement.

Suffix:
<m> 1.6
Parameters:
<SignalSource> NONE | CHT | CH2 | CH3 | CH4 | DO...D15 | QMA | MAT | MA2 | MA3 | MA4 | MAS |
RE1 | RE2 | RE3 | RE4
<ReferenceSource> NONE | CH1 | CH2 | CH3 | CH4 | MA1 | MA2 | MA3 | MA4 | MA5 | RE1 | RE2 | RE3 | RE4
CH1|CH2 | CH3| CH4
Active signal channels 1 to 4
D0...D15
Active digital channels from DO up to D15 [depending on the instrument type)
QMA
Active quick math channel
MA1 [ MA2 | MA3 | MA4 | MAS
Active math channels 1t0 5
RE1|RE2 | RE3 | RE4
Active reference channels 1 to 4
*RST: CH1
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MEASurement<m>:CATegory?
Returns the measurement category. Currently, the instrument supports only yt-measurements.

Suffix:
<m> 1.6

Selects the measurement.

Return values:

<Category> AMPTime
AMPtime:  yt-measurements
*RST: AMPT

Usage: Query only

REFLevel<m>:RELative:MODE <RelativeMode>
Sets the lower and upper reference levels for rise and fall time mesurements (cursor and automatic mesurements),
defined as percentages of the high signal level.

Suffix:
<m> 1.7
Measurement to which the reference level belongs.
Suffix 1...6 assign the measurement places 1 to 6 (auto measure).
Suffix 7 assigns the cursor mesurement.
Parameters:
<RelativeMode> TEN | TWENty
TEN: 10/90%
TWENTy: 20/80%
Example: REFL2:REL:MODE TWENty

MEAS2 :MAIN RTIM

Sets the reference level for measurement place 2 and measures the rise time between
these levels:

lower reference level = 20% of high signal level

upper reference level = 80% of high signal level

*RST: TEN
MEASurement<m>:MAIN <MeasType>

Defines the measurement type to be performed on the selected source. To query the results, use
,CALCulate:MATH<m>:DATA?"“ on page 96.

Suffix:

<m> 1..6
Selects the measurement type.

Parameters:

<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue | PPCount | NPCount | RECount |
FECount | HIGH | LOW | AMPLitude | MEAN | RMS | RTIMe | FTIMe | PDCYcle | NDCYcle |
PPWidth | NPWidth | CYCMean | CYCRms | STDDev | TFRequency | TPERiode | POVershoot |
NOVershoot | DELay | PHASe
FREQuency
Frequency of the signal. The result is based on the length of the left-most signal period
within the displayed section of the waveform of the selected channel.
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PERiod
Length of the left-most signal period within the displayed section of the waveform of the
selected channel.

PEAK
Peak-to-peak value within the displayed section of the waveform of the selected channel.

UPEakvalue
Maximum value within the displayed section of the waveform of the selected channel.

LPEakvalue
Minimum value within the displayed section of the waveform of the selected channel.

PPCount
Counts positive pulses.

NPCount
Counts negative pulses.

RECount
Counts the number of rising edges.

FECount
Counts the number of falling edges.

HIGH
Mean value of the high level of a square wave.

LOwW
Mean value of the low level of a square wave.

AMPLitude
Amplitude of a square wave.

MEAN
Mean value of the complete displayed waveform of the selected channel.

RMS
RMS [Root Mean Square) value of the voltage of the complete displayed waveform of the
selected channel.

RTIMe | FTIMe

Rise or falling time of the left-most rising edge within the displayed section of the waveform
of the selected channel. The reference level for this mesurement is set with
»REFLevel<m>:RELative:MODE"“ on page 78.

PDCycle | NDCycle
Measure the positive or negative duty cycle.

PPWidth | NPWidth
Measure the width of positive or negative pulses.

CYCMean
Mean value of the left-most signal period of the waveform of the selected channel.

CYCRms
RMS (Root Mean Square) value of the voltage of the left-most signal period of the waveform
of the selected channel.

STDDev
Measures the standard deviation of the waveform.

TFRequency
Measures the frequency of the trigger signal based on the length of its period.
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TPERiode
Measures the length of the trigger signal periods (hardware counter).

POVershoot
Measures the positive overshoot of the waveform.

NOVershoot
Measures the negative overshoot (undershoot] of the waveform.

Delay

Time difference between two edges of the same or different waveforms.

The waveforms are selected with MEASurement<m>:SOURce, and the edges with
MEASurement<m>:DELay:SLOPe.

Phase
Phase difference between two waveforms [(time difference/period] x 360].
The waveforms are selected with MEASurement<m>:SOURce.

*RST: NONE [measurement is off)

MEASurement<m>:RESult? [<MeasType>]
Returns the result of the specified measurement type.

Suffix:
<m> 1...6
Selects the measurement type.

Return values:
<Value> Measurement result

Query Parameters:

<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue | PPCount | NPCount | RECount |
FECount | HIGH | LOW | AMPLitude | MEAN | RMS | RTIMe | FTIMe PDCYcle | NDCYcle |
PPWidth | NPWidth | CYCMean | CYCRms | STDDev | TFRequency | TPERiode | POVershoot |
NOVershoot

Specifies the measurement type. See ,MEASurement<m>:MAINY on page 78.
Usage: Query only
MEASurement<m>:RESult:AVG? [<AverageValue>]
Returns the average value of the current mesurement series. The number of waveforms used for calculation is defined
with ,MEASurement<m>:STATistics:WEIGht™ on page 82.
Suffix:
<m> 1..6

Selects the measurement type.

Query parameters:

<AverageValue> Statistic value
Usage: Query only
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MEASurement<m>:RESult:STDDev? [<StandardDeviation>]
Returns the statistical standard deviation of the current mesurement series. The number of waveforms used for calcu-
lation is defined with ,MEASurement<m>:STATistics:WEIGht" on page 82.

Suffix:
<m> 1..6
Selects the measurement type.

Query parameters:
<StandardDeviation> Statistic value

Usage: Query only

MEASurement<m>:RESult:NPEak? [<NegativePeak>]

Returns the minimum measurement value of the current measurement series.
Suffix:

<m> 1.6

Selects the measurement type.

Query parameters:
<NegativePeak> Minimum measurement value

Usage: Query only

MEASurement<m>:RESult:PPEak? [<PositivePeak>]
Returns the maximum measurement value of the current measurement series.

Suffix:
<m> 1.6

Selects the measurement type.

Query parameters:
<PositivePeak> Maximum measurement value

Usage: Query only
MEASurement<m>:RESult:WFMCount? [<\WaveformCount>]
Returns the current number of measured waveforms.

Suffix:

<m> 1.6

Selects the measurement type.

Query parameters:

<WaveformCount> Number of measured waveforms
Usage: Query only
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MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope>
Sets the edges to be used for delay measurement. The associated waveforms are defined with
MEASurement<m>:SOURce

Parameters:
<SignalSlope> POSitive | NEGative

Slope of source 1 (first waveform)
<ReferenceSlope> POSitive | NEGative

Slope of source 2 [second waveform]

*RST: POS

MEASurement<m>:STATistics[:ENABle] <StatisticEnable>
Activates or deactivates the statistical evaluation for the selected measurement.

Suffix:
<m> 1.6
Selects the measurement type.
Parameters:
<StatisticEnable> ON | OFF

*RST: OFF

MEASurement<m>:STATistics:RESet
Deletes the statistical results for the selected measurement, and starts a new statistical evaluation, if the acquisition is
running. The waveform count is set to 0 and all measurement values are set to NAN.

Suffix:
<m> 1...6

Selects the measurement type.
Usage: Event

MEASurement<m>:STATistics:WEIGht <AverageCount>
Sets the number of measured waveforms used for calculation of average and standard deviation.

Suffix:
<m> 1...6
Selects the measurement type.
Parameters:
<AverageCount> Statistics average count
Range: 2 to 1000
Increment: 1
*RST: 1000
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2.6

2.6.1

Search functions

S BAT N 83
P A e 85
B0 85
VD e 86
RUNt 87
RISE / Fall L@ oo 89
Search

SEARCh:STATe <SearchState> ... .o 83
SEARCh:SOURCE <S€arChSOUICE> . ..ot 83
SEARch:CONDition <SearchCondition> ......oooiiiiiiiiiiiieeeeeeee e 83
SEARCH IR OUNT 84
SE AR CH: RE U N> e 84
SEARCH: RE UL AL L 7 e 84
SEARch:RESDiagram:SHOW <ResultShow> ... 85

SEARch:STATe <SearchState>
Enable or disable the search function

Parameters:
<SearchState>

ON | OFF

*RST: OFF

SEARch:SOURce <SearchSource>
Set the source for the search function.

Parameters:
<SearchSource>

CH1T 1 CH2 1 CH3 | CH4 | QMA | MAT | MA2 | MA3 | MA4 | MAS | RE1 | RE2 | RE3 | RE4

CH1|CH2|CH3|CH4
Signal channels 1to 4

QMA
Quick math channel

MA1 | MA2 | MA3 | MA4 | MAS
Math channels 1to 5

RE1 | RE2 | RE3 | RE4
Reference channels 1 to 4

*RST: CH1

SEARch:CONDition <SearchCondition>
Set the condition for the search function

Parameters:
<SearchCondition>

EDGE | WIDTh | PEAK | RUNT | RTIMe

*RST: EDGE
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SEARch:RCOunt
Returns the number of events which meet the search condition.

Return values:

<ResultCount> <numeric_value>

*RST: 0
SEARch:RESult<n>?
Returns the result values of the specified search result.
See also: ~SEARCh:RESult:ALL?" below
Suffix:
<n> *

Number of the search result

Return values:
<Result> Comma-separated value list
Optional value depending on search condition:

EDGE unused
WIDTh Puls width
PEAK peak value of the peak
RUNT width of the runt
RTIMe risetime

Example: SEARch:RESult3?

Returns the result values of the third search result.
3,-4.1660e-04,0, PEAK, NEGATIVE, -1.530e-02

Usage: Query only

SEARch:RESult:ALL?
Returns a list of the results separated by comma.

Return values:
<AllResult> List of results separeted by comma

For each result, six values are returned:

1. Result number as indicated in the search results table

2. X-position (time] of the search result

3. Y-position of the search result, currently not relevant

4. Type of the search result (Edge, Peak, ...]

5. Slope or polarity of the search result

6. For peak searches, the value contains the peak voltage. For width searches,
it contains the pulse width. For edge searches, the value is not relevant.

Example: SEARch:RESult:ALL?
Returns all four results of a peak search:
1,-4.7750e-04,0, PEAK, NEGATIVE, -1.530e-02,
2,-4.4630e-04,0, PEAK, NEGATIVE, -1.530e-02,
3,-4.1660e-04, 0, PEAK,NEGATIVE, -1.530e-02,
4,-3.8690e-04,0, PEAK, NEGATIVE, -1.530e-02

Usage: Query only
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2.6.2

2.6.3

SEARch:RESDiagram:SHOW <ResultShow>
Enable or disable list view of search results on the display.

Parameters:

<ResultShow> ON | OFF
*RST:0FF

Peak

SEARch:MEASure:PEAK:POLarity <Polarity> ........cccccoiiiiiiiiiiic,
SEARch:MEASure:LEVEL:PEAK:MAGNitude <Magnitude> ......................

SEARch:MEASure:PEAK:POLarity <Polarity>
Set the polarity of the peak

Parameters:
<Polarity> PQOSitive | NEGative | EITHer

*RST: POS
SEARch:MEASure:LEVEL:PEAK:MAGNitude <Magnitude>
Set the magnitude of the peak

Parameters:
<Magnitude> Default unit:V

Edge

SEARch:TRIGger:EDGE:SLOPe <SIope> .......ccoooiiiiiiiiiiiiiice,
SEARch:TRIGger:EDGE:LEVel <Level> ...
SEARch:TRIGger:EDGE:LEVel:DELTa <DeltalLevel>.........ccccocoiii

SEARch:TRIGger:EDGE:SLOPe <Slope>
Set the slope of the edge.

Parameters:
<Slope> POSitive | NEGative | EITHer

*RST: POS
SEARch:TRIGger:EDGE:LEVel <Level>
Sets the voltage level for the edge search.

Parameters:
<Level> <numeric_value>

*RST: 500E-3 = 500mV
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2.6.4

SEARch:TRIGger:EDGE:LEVel:DELTa <DeltalLevel>
Sets a hysteresis range above and below the search level to avoid unwanted search results caused by noise oscillation
around the level.

Parameters:
<DeltalLevel> Range: Lower limit depends on vertical scale and other settings, no upper limit

*RST: 200E-3 = 200mV

Width

SEARch:TRIGger:WIDTh:POLarity <POlarity> .......ccoooiiiiiiiiiiiccc
SEARch:TRIGger:WIDTh:LEVel <Level> ...
SEARch:TRIGger:WIDTh:LEVel:DELTa <DeltaLevel>
SEARch:TRIGger:WIDTh:WIDTh <Width> ...
SEARch:TRIGger:WIDTh:DELTa <DeltaWidth>...
SEARch:TRIGger:WIDTh:RANGe <Range>...........ccooiiiiiiiiiiiiicee

SEARch:TRIGger:WIDTh:POLarity <Polarity>
Set the polarity of the pulse.

Parameters:
<Polarity> POSitive | NEGative

*RST: POS
SEARch:TRIGger:WIDTh:LEVel <Level>
Set the level of the pulse

Parameters:
<Level> <numeric_value>

*RST: 500E-6
SEARch:TRIGger:WIDTh:LEVel:DELTa <DeltalLevel>
Set the hysteresis of the level of the pulse.

Parameters:
<Deltalevel> Range:Lower limit depends on vertical scale and other settings, no upper limit

*RST: 200E-6
SEARch:TRIGger:WIDTh:WIDTh <Width>
Set the width of the pulse.

Parameters:
<Width> Default unit:s
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SEARch:TRIGger:WIDTh:DELTa <Delta\Width>
Sets a range At to the reference pulse width set with ,,SEARch: TRIGger :WIDTh:WIDThY on page 86,
if SEARch: TRIGger :WIDTh:RANGe is set to WITHin or OUTSide

Parameters:

<DeltaWidth> Range:Lower limit depends on the resolution, practically no upper limit

SEARch:TRIGger:WIDTh:RANGe <Range>
Set the comparision of the width of the pulse

Parameters:
<Range> WITHin | OUTSide | SHORter | LONGer
WITHin
Finds pulses inside the range width + At.
OUTSide
Finds pulses outside the range width + At.
SHORter
Finds pulses shorter than the given width.
LONGer
Finds pulses longer than the given width.
*RST: WITH
2.6.5 Runt
SEARch:TRIGger:RUNT:POLarity <Polarity> ..o 87
SEARch:TRIGger:RUNT:WIDTh <Width> ... 87
SEARch:TRIGger:RUNT:DELTa <DeltaWidth>.......ccccooiiiiiiiiiice 88
SEARch:TRIGger:RUNT:RANGe <Range>.......ccccoviiiiiiiiiiiicicc e 88
SEARch:TRIGger:LEVel:RUNT:LOWer <LowerLevel>...........c.coooiiiiiiiiiiii 88
SEARch:TRIGger:LEVel:RUNT:UPPer <UpperLevel> .........cccccoiiiiiiiiiiii, 88
SEARch:TRIGger:RUNT:POLarity <Polarity>
Set the polarity of the Runt
Parameters:
<Polarity> PQOSitive | NEGative | EITHer
*RST: POS
SEARch:TRIGger:RUNT:WIDTh <Width>
Sets the reference runt pulse width, the nominal value for comparisons.
Parameters:
<Width> Range: Depends on various settings, mainly time base and sample rate
*RST: 200e-6
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SEARch:TRIGger:RUNT:DELTa <DeltaWidth>
Sets a range At to the reference pulse width set with ,,SEARch: TRIGger : RUNT:WIDTh™ on page 87,
if SEARch: TRIGger : RUNT : RANGe is set to WITHin or OUTSide.

Parameters:
<DeltaWidth> Range: Depends on various settings, mainly time base and sample rate

*RST: 50e-6

SEARch:TRIGger:RUNT:RANGe <Range>

Sets how the measured pulse width is compared with the given limit(s).
To set the width, use SEARch: TRIGger : RUNT :WIDTh .

To set the range + At, use SEARch: TRIGger :RUNT:DELTa .

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds pulses longer than the given width.

SHORter
Finds pulses shorter than the given width.

WITHin
Finds pulses inside the range width + At.

0UTSide
Finds pulses outside the range width + At.

*RST: LONG

SEARch:TRIGger:LEVel:RUNT:LOWer <LowerlLevel>
Sets the lower voltage threshold for runt detection. A positive runt crosses the lower level twice without crossing the
upper level.

Parameters:
<LowerlLevel> Default unit:V

*RST: 400E-3

SEARch:TRIGger:LEVel:RUNT:UPPer <UpperLevel>
Sets the upper voltage threshold for runt detection. A negative runt crosses the upper level twice without crossing the
lower level.

Parameters:
<UpperLevel> Default unit:V
*RST: 600E-3
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2.6.6 Rise/Falltime

SEARch:TRIGger:RISetime:TIME <TIME> ..o
SEARch:TRIGger:RISetime:DELTa <Deltalime> ..o
SEARch:TRIGger:RISetime:SLOPe <Polarity> ..o
SEARch:TRIGger:RISetime:RANGe <Range> ..o
SEARch:TRIGger:LEVel:RISetime:LOWer <LowerLevel> ...
SEARch:TRIGger:LEVel:RISetime:UPPer <UpperLevel> ...

SEARch:TRIGger:RISetime:TIME <Time>
Sets the reference rise or fall time, the nominal value for comparisons.

Parameters:

<Time> Range: Depends on various settings, mainly time base and sample rate

Default unit: s

*RST: 200E-6

SEARch:TRIGger:RISetime:DELTa <DeltaTime>

Sets a range At to the reference rise/fall time set with SEARch: TRIGger:RISetime: TIME ,
if SEARch: TRIGger:RISetime:RANGe is set to Within or Outside. The instrument finds rise/fall times inside or out-

side the range time = At.

Parameters:

<DeltaTime> Range: Depends on various settings, mainly time base and sample rate

Default unit: s

*RST: 50e-6

SEARch:TRIGger:RISetime:SLOPe <Polarity>
Set the polarity for the Rise/fall time.

Parameters:

<Polarity> PQOSitive | NEGative | EITHer
POSitive to search for rise time
NEGative to search for fall time
ElTHer to search for rise and fall time
*RST: POS
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SEARch:TRIGger:RISetime:RANGe <Range>

Sets how the measured rise or fall time is compared with the given limit(s).
To set the rise/fall time, use SEARch: TRIGger:RISetime: TIME .

To set the range + At, use SEARch: TRIGger:RISetime:DELTa .

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds rise/fall times longer than the given time.

SHORter
Finds rise/fall times shorter than the given time.

WITHin
Finds rise/fall times inside the range time + At.

0UTSide
Finds rise/fall times outside the range time + At.

*RST: LONG

SEARch:TRIGger:LEVel:RISetime:LOWer <L owerlLevel>
Sets the lower voltage threshold. When the signal crosses this level, the rise time measurement starts or stops depen-
ding on the selected slope.

Parameters:
<LowerLevel> Default unit: V

*RST: 400E-3
SEARch:TRIGger:LEVel:RISetime:UPPer <UpperlLevel>

Sets the upper voltage threshold. When the signal crosses this level, the rise/fall time measurement starts or stops
depending on the selected slope.

Parameters:
<UpperLevel> Default unit: V
*RST: 600E-3
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2.7 Quickmath, Mathematics and Reference Waveforms

QUICKIMI AT L 91
M At Mt CS o 94
Reference Waveforms e 99

2.7.1 Quickmath

This chapter describes commands that configure or perform basic math functions using Quickmath.

CALCulate:QMATR:STATE <STate> oo 91
CALCulate:QMATh:SOURCE <> <SOUICE> ..o 91
CALCulate:QMATh:0PERation <Operation> ...........cccoooiiiiiiiioceee e 91
CALCulate:QMATh:SCALE <SCale> .. i 92
CALCulate:QMATh:POSIition <PoSItioN> ... 92
CALCULate:AMAT N D AT A e 92
CALCulate:QMATH:DATAHEADEI? oo e 92
CALCulate:QMATh:DATAXINCrement?. . e 92
CALCulate:QMATH:DATAXORIGINT .ot 93
CALCulate:QMATh:DATA:YINCrement? . e 93
CALCulate:QMATH:DATA:YORIGINT 1ottt 93
CALCulate:QMATH:DATA:YRESOIUtION? ..o 93

CALCulate:QMATh:STATe <State>

Defines whether the Quickmath waveform is active or not. Only if the source channels of the quick math waveform is
available, it will be visible on the screen and can be selected as a source for analysis and display functions. Quickmath is
only available in YT and Zoom mode.

Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:QMATh:SOURce <m> <Source>
Defines the source of the Quickmath waveform.

Parameters:
<m> 1.2

Selects the source.
<Source> CH1|CH2 | CH3 | CH4
Example: CALC:QMAT:SOURL CH2

CALC:QMAT:SOUR2 CH3

*RST: 1

CALCulate:QMATh:0PERation <Operation>
Defines the operation of the Quickmath waveform.

Parameters:

<Operation> ADD | SUB | MUL | DIV

Example: CALC:QMAT:0OPER ADD in case of QMA=CH2 + CH3
CALC:QMAT:OPER SUB in case of QMA=CH2 - CH3
CALC:QMAT:0PER MUL in case of QMA=CH2 x CH3
CALC:QMAT:QOPER DIV in case of QMA=CH2 / CH3
*RST: ADD
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CALCulate:QMATh:SCALe <Scale>
Sets the vertical scale for the Quickmath waveform.

Parameters:
<Scale> Scale value, given in Volts per division.

Range: -1.0E-24 to 5.0E+25
Increment: 1,2, 5 progression, for example, TmV/div, 2mV/div, 5mV/div, 10, 20, 50...

*RST: 1
CALCulate:QMATh:POSition <Position>
Sets the vertical position of the Quickmath waveform in the window.
Parameters:
<Position> Position value, given in divisions

Increment: 0.01in reset state

*RST: 0

CALCulate:QMATh:DATA?
Returns the data of the Quickmath waveform. The waveforms data can be used in MATHLAB, for example.
To set the export format, use ,FORMat [ :DATA]™ on page 50.

Return values:
<Data> List of values according to the format settings

Usage: Query only
CALCulate:QMATh:DATA:HEADer?
Returns information on the Quickmath waveform.

Table 2.4: Header data

Position Meaning Example

1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in's 9.477E-008 = 94,77 ns

3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Return values:

<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only

CALCulate:QMATh:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform.
The commands are relevant for data conversion if binary data format is defined [FORM UINT, 8/16).

Return values:

<Xincrement> Timeins
Usage: Query only
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CALCulate:QMATh:DATA:XORigin?
Return time of the first sample depending to trigger event (time=0).
The commands are relevant for data conversion if binary data format is defined [FORM UINT, 8/16).

Return values:
<Xorigin> Timeins

Usage: Query only

CALCulate:QMATh:DATA:YINCrement?
Return the voltage value per bit of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8[16).

Return values:
<Yincrement> Voltage in V

Usage: Query only
CALCulate:QMATh:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8[16).

Return values:
<Yorigin> Voltage in V

Usage: Query only
CALCulate:QMATh:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform.

The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8/16).

Return values:

<Yresolution> For default waveforms, the resolution is 16 bit.
Usage: Query only
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2.7.2 Mathematics

This chapter describes commands that configure or perform mathematical functions.

CALCulate:MATH<m>:STATe <State> ... 94
CALCulate:MATH<mM>:SCALe <Scale> ... 94
CALCulate:MATH<mM>:POSition <PoSItION> ... oo 94
CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplEXpr> ..o 95
CALCuUlate:MATH<M> DA T A e 96
CALCulate:MATH<m>:DATAHEADEr? L e 96
CALCulate:MATH<m>:LABel <Label> ... 96
CALCulate:MATH<m>:LABel:STATe <State> ..o 97
CALCulate:MATH<m>:DATAXINCrement? ..o e 97
CALCulate:MATH<mM>:DATAXORIGIN? ..ot 97
CALCulate:MATH<m>:DATA:YINCrement? ... 97
CALCulate:MATH<M>:DATAYORIGINT c.oiiiiiit i 98
CALCulate:MATH<m>:DATA:YRESOLUtION? oo 98

CALCulate:MATH<m>:STATe <State>
Defines whether the selected mathematical channel is active or not. Only if a channel is active it is visible on the screen
and can be selected as a source for analysis and display functions.

Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:SCALe <Scale>
Sets the vertical scale for the specified math waveform.

Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<Scale> Scale value, given in Volts per division.

Range: -1.0E-24 to 5.0E+25
Increment: 1, 2, 5 progression, for example, 1mV/div, 2mV/div, 5mV/div, 10, 20, 50...

*RST: 1

CALCulate:MATH<m>:POSition <Position>
Sets the vertical position of the specified math waveform in the window.

Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<Position> Position value, given in divisions.
Increment: 0.01in reset state
*RST: 0
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CALCulate:MATH<m>[:EXPRession][:DEFine]l <RemComplExpr>
Defines the equation to be calculated for the selected math channel as a regular expression.

Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<RemComplExpr> String with regular expression
Example: Multiplication: CALC:MATH1:EXPR:DEF “MUL (CH1,CH2)™
Integral: CALC:MATH2 :EXPR:DEF “INT (MA1l)™“
IR low pass: CALC:MATH3:EXPR:DEF “IIRL (MA2,1E6)"
The mathematical expression is a string parameter, consisting of a keyword which
represents the math function, followed by the respective sources.
These may be separated by comma and written in brackets.
A query of the math function always returns the string, which is listed under string expression.
Function ExpressionString Comment
Addition “ADD (CH1,CH2)” Alternativ “CH1+CH2”
Subtraction “SUB (CH1,CH2)” Alternativ. “CH1-CH2”
Multiplication “MUL (CH1,CH2)"” Alternativ. “CH1*CH2"
Division “DIV(CHI1,CH2)"” Alternativ. “CH1/CH2”
Max. amplitude “MAX (CH1,CH2)”
Min. amplitude “MIN (CH1,CH2)"”
Square “SOR(CHI1)”
Square root “SQRT (CH1) ”
Absolute value “ABS (CH1)”
Positive wave “POS (CH1)”
Negative wave “NEG (CH1)”
Reciprocal 1/x “REC (CH1) "
Inverse “INV (CH1)”
Common logarithm “LOG (CH1)”
Natural logarithm “LN (CH1)”
Derivative “DERI (CH1)”
Integral “INT (CH1)”
IIR low pass “IIRL(CHL, 1E6)” CH1 - Source
Te6 - Constant, limit frequency of the low pass
IIR high pass “IIRH(CHL, 1E6)” CH1 - Source
Te6 - Constant, limit frequency of the high pass
FFT “FFTMAG (CH1)” FFT function of the source waveform
Table 2.5: Math expression
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CALCulate:MATH<m>:DATA?

Returns the data of the math waveform. The waveforms data can be used in MATHLAB, for example.

To set the export format, use ,FORMat [ :DATA]™ on page 50.
Suffix:
<m> 1.4

Selects the math waveform.

Return values:

<Data> List of values depending on defined data format.

Usage: Query only

CALCulate:MATH<m>:DATA:HEADer?
Returns information on the math waveform.

Table 2.6: Header data

Position Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1
Suffix:
<m> 1.4

Selects the math waveform.
Return values:

<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only

CALCulate:MATH<m>:LABel <Label>
Sets the label for the Math waveform.

Suffix:
<m> 1.4

Selects the math waveform.
Parameters:
<lLabel> String value

“xxxxxxxx” (maximum 8 characters)
Example: .Power”

CH1=Voltage
CH2=Current
CH1*CH2=POWER
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CALCulate:MATH<m>:LABel:STATe <State>
Switches the label of the math channel on or off.

Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform.
The commands are relevant for data conversion if binary data format is defined [FORM UINT, 8/16).

Suffix:
<m> 1.4
Selects the math waveform.

Return values:
<Xincrement> Timeins

Usage: Query only

CALCulate:MATH<m>:DATA:XORigin?
Return the time of the first sample of the indicated waveform.
The commands are relevant for data conversion if binary data format is defined (FORM UINT, 8/16).

Suffix:
<m> 1.4
Selects the math waveform.

Return values:
<Xorigin> Timeins

Usage: Query only

CALCulate:MATH<m>:DATA:YINCrement?
Return the voltage value per bit of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<m> 1.4

Selects the math waveform.

Return values:

<Yincrement> Voltage in V
Usage: Query only
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CALCulate:MATH<m>:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16].

Suffix:
<m> 1.4
Selects the math waveform.

Return values:
<Yorigin> Voltage in V

Usage: Query only

CALCulate:MATH<m>:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:

<m> A

1
Selects the math waveform.

Return values:

<Yresolution> For default waveforms, the resolution is 16 bit.
Usage: Query only
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2.7.3 Reference Waveforms

REFCUNE <M > ST AT € e 99
REFCurve<m>:SOURCE <SOUMCE> ..o 99
REFCurve<m>:SOURCE:CATELOG? ..iiiiiiiii e 100
REFCUrve<m>:UPDate ..o 100
REFCurve<m>:SAVE <FileName> ... 100
REFCurve<m>:LOAD <FileName> ... 101
REFCUrve<m>:LOAD ST AT e 101
REFCurve<m>:HORizontal:SCALe <Scale> ... 101
REFCurve<m>:HORizontal:POSition <Position> ..........cccoiiiiii 101
REFCurve<m>:VERTical:SCALe <Scale> ... 101
REFCurve<m>:VERTical:POSition <Position> ...........occcciiiie 102
REFCUrVe<m > DA T A 102
REFCurve<m>:DATAHEAD er? e 102
REFCurve<m>:DATAXINCrement?. .. 102
REFCurve<m>:DATAXORIGINT ..ot 103
REFCurve<m>:DATAYINCremMent? . o 103
REFCUrve<m>:DATAYORIGINT . oo 103
REFCurve<m>:DATA:YRESOIUtION? . .. 103
REFCurve<m>:STATe
Displays or hides the selected reference waveform.
Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.
Parameters:
<State> ON | OFF

*RST: OFF

REFCurve<m>:SOURce <Source>
Defines the source of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Source> CH1 [ CH2 | CH3 | CH4 | POD1 | POD2 | QMA | MAT | MA2 | MA3 | MA4 | MAS |
RET | RE2 | RE3 | RE4

CH11CH2 | CH3 | CH4
Signal channels 1to 4

POD1 | POD2
Logic POD

QMA
Quick math channel

MA1 | MA2 | MA3 | MA4 | MAS
Math channels 1to 5

RE1|RE2| RE3 | RE4
Reference channels 1 to 4

Any active channel, math, or reference waveform depend on the type of the instrument.

*RST: CH1
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REFCurve<m>:SOURce:CATalog?
Returns a list of waveforms that can be used as reference source. Only available waveforms can be used.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Catalog> CHT|CH2|CH3|CH4 | POD1 | POD2 | QMA | MAT | MA2 | MA3 | MA4 | RET | RE2 | RE3 | RE4

CH1|CH2|CH3|CH4
Signal channels 1to 4

POD1 | POD2
Logic POD
QMA

Quick math channel

MA1 | MA2 | MA3 | MA4 | MAS
Math channels 1to 5

RE1| RE2 | RE3 | RE4
Reference channels 1to 4

Any active channel, math, or reference waveform depend on the type of the instrument.

Usage: Query only
REFCurve<m>:UPDate
Updates the selected reference by the waveform defined with ,REFCurve<m>:SOURce™ on page 99.
Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Usage: Event

REFCurve<m>:SAVE <FileName>
Stores the reference waveform the specified file.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Setting Parameters:

<FileName> String with path and file name
Usage: Setting only
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REFCurve<m>:LOAD <FileName>
Loads the waveform data from the indicated reference file to the reference storage.
To load the instrument settings, use REFCurve<m>: LOAD: STATe (see command below):

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Setting Parameters:
<FileName> String with path and file name

Usage: Setting only

REFCurve<m>:LOAD:STATe

Loads the instrument settings in addition to the reference waveform data. The waveform

data must be loaded before the settings, see REFCurve<m>: LOAD [see command above):

The settings are only available if the file was stored to the internal storage /INT/REFERENCE and never written to an
external storage (USB stick].

Suffix:
<m> 1.4

Selects the reference waveform.
Usage: Event

REFCurve<m>:HORizontal:SCALe <Scale>
Changes the horizontal scale (timebase] of the reference waveform independent of the channel waveform settings.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Scale> Default unit: s/div

*RST: 100e-6

REFCurve<m>:HORizontal:POSition <Position>
Changes the horizontal position of the reference waveform independent of the channel waveform settings.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Position> Default unit: s

*RST: 0

REFCurve<m>:VERTical:SCALe <Scale>
Changes the vertical scale of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Scale> Default unit: V/div
*RST: 1
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REFCurve<m>:VERTical:POSition <Position>
Changes the vertical position of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Position> Default unit: div
*RST: 0
REFCurve<m>:DATA?

Returns the data of the reference waveform for transmission from the instrument to the controlling computer. The
waveforms data can be used in MATLAB, for example.

To set the export format, use ,FORMat [ : DATA]™ on page 50.
Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:
<Data> Comma-separated value list [depending on the defined data format]

Usage: Query only
REFCurve<m>:DATA:HEADer?
Returns information on the reference waveform.

Table 2.7: Header data

Position Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1
Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000,1
Usage: Query only

REFCurve<m>:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform.
The commands are relevant for data conversion if binary data format is defined [FORM UINT, 8/16).

Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:

<Xincrement> Timeins
Usage: Query only
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REFCurve<m>:DATA:XORigin?
Return the time of the first sample of the indicated waveform.
The commands are relevant for data conversion if binary data format is defined [FORM UINT, 8/16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Xorigin> Timeins

Usage: Query only

REFCurve<m>:DATA:YINCrement?
Return the voltage value per bit of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8]16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Yincrement> Voltage in V

Usage: Query only

REFCurve<m>:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8[16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Yorigin> Voltage in V

Usage: Query only

REFCurve<m>:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform.
The commands are relevant for data conversion, if binary data format is defined (FORM UINT, 8/16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

Its resolution is depending on the source waveform. The maximum is 16 bit.

Usage: Query only
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2.8 FFT
CALCulate:MATH<m>:ARIThmetics <Arithmetics> ..o 104
CALCulate:MATH<m>:FFT:AVERage:COUNT ... 104
CALCulate:MATH<m>:FFT:MAGNitude:SCALE .....oooiiiiiiiiiiie 105
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJusted? ...........ccocooviinnn. 105
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO <SpanRBWCoupling> 105
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBWRatio> ...... 105
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <ResolutionBW> ..... 106
CALCulate:MATH<m>:FFT:CFRequency <CenterFreq> ..o, 106
CALCulate:MATH<mM>:FFT:FULLSPAN ..o 106
CALCulate:MATH<m>:FFT:SPAN <FreqSpans> ... 106
CALCulate:MATH<m>:FFT:STARt <StartFreg> ..o 106
CALCulate:MATH<m>:FFT:STOP <StopFreg> ... 107
CALCulate:MATH<m>:FFT:WINDow:TYPE <WindowType> ......c.cccovviiiiiiiiiin 107
CALCulate:MATH<m>:FFT:TIME:RANGe <WindowWidth> ... 107
CALCulate:MATH<m>:FFT:TIME:POSition <WindowPosition>............ccccovvieiiinnnns 108
CALCulate:MATH<m>:FFT:SRATe? <SampleRate> .........cccccoeoeiiiiiiiiiiiiiccee 108

CALCulate:MATH<m>:ARIThmetics <Arithmetics>
Defines the mode for FFT calculation and display.

Suffix:
<m> 1.4
The numeric suffix is irrelevant.
Parameters:
<Arithmetics> OFF | ENVelope | AVERage

OFF

The FFT is performed without any additional weighting or postprocessing of the acquired
data. The new input data is acquired and displayed, and thus overwrites the previously saved
and displayed data.

ENVelope

In addition to the normal spectrum, the maximal oscillations are saved separately and
updated for each new spectrum. The maximum values are displayed together with the newly
acquired values and form an envelope. This envelope indicates the range of all FFT trace
values that occurred.

AVERage

The average of several spectrums is calculated. The number of spectrums used for the
averaging is defined using the command CALCulate:MATH<m>:ARIThmetics.

This mode is useful for noise rejection.

*RST: OFF

CALCulate:MATH<m>:FFT:AVERage:COUNt
Defines the number of spectrums used for averaging if CALCulate :MATH<m>:ARIThmetics (see command above) is

set to AVERage.
Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<AverageCount> Integer value
Range: 2t0512
Increment: 2"
*RST: 2
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CALCulate:MATH<m>:FFT:MAGNitude:SCALe
Defines the scaling of the y-axis.

Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<Magnitude Scale> LINear | DBM | DBV
LINear: linear scaling; displays the RMS value of the voltage.
DBM: logarithmic scaling; related to 1 mW
DBV: logarithmic scaling; related to 1 Ve
*RST: DBM

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]l:ADJusted?
Queries the effective resolution bandwidth.

Suffix:
<m> 1.4

The numeric suffix is irrelevant.

Return values:

<AdjResBW> Range: -100e24 to 100e24
Increment: 0.1
*RST: 1.221E3

Default unit: Hz

Usage: Query only

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO <SpanRBWCoupling>
Couples the frequency span to the RBW.

Suffix:
<m> 1.4

The numeric suffix is irrelevant.
Parameters:

<SpanRBWCoupling> ON | OFF

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBWRatio>
Defines the ratio resolution bandwidth (Hz) / span (Hz).

Suffix:
<m> 1.4
The numeric suffix is irrelevant.
Parameters:
<SpanRBWRatio> Range: 1024 to 32768
Increment: 2"
*RST: 4096
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CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <ResolutionBW>
Defines the resolution bandwidth.

Suffix:
<m> 1.4
The numeric suffix is irrelevant.
Parameters:
<ResolutionBW> Range:Depends on various other settings.

Default unit:Hz

CALCulate:MATH<m>:FFT:CFRequency <CenterFreg>
Defines the position of the displayed frequency domain, which is (Center - Span/2] to (Center + Span/2). The width of the
domain is defined using the CALCulate :MATH<m>: FFT : SPAN command.

Suffix:
<m> 1.4
Selects the math waveform.
Parameters:
<CenterFreg> Range: 0to 2el12

Increment: 1
Default unit: Hz

*RST: 500e6

CALCulate:MATH<m>:FFT:FULLspan
Performs FFT calculation for the full frequency span.

Suffix:
<m> 1.4

The numeric suffix is irrelevant.
Usage: Event

CALCulate:MATH<m>:FFT:SPAN <FreqSpan>
The span is specified in Hertz and defines the width of the displayed frequency range, which is (Center - Span/2] to (Cen-
ter + Span/2). The position of the span is defined using the CALCulate :MATH<m>:FFT:CFRequency command.

Suffix:
<m> 1.4
The numeric suffix is irrelevant.
Parameters:
<FreqSpan> Default unit: Hz

CALCulate:MATH<m>:FFT:STARt <StartFreq>
Defines the start frequency of the displayed frequency domain (instead of defining a center frequency and span).

Suffix:
<m> 1.4
The numeric suffix is irrelevant.
Parameters:
<StartFreg> Default unit: Hz
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CALCulate:MATH<m>:FFT:STOP <StopFreg>
Defines the stop frequency of the displayed frequency domain (instead of defining a center frequency and span).

Suffix:
<m> 1.4
The numeric suffix is irrelevant.
Parameters:
<StopFreg> Default unit: Hz

CALCulate:MATH<m>:FFT:WINDow:TYPE <WindowType>
Window functions are multiplied with the input values and thus can improve the FFT display.

Suffix:
<m> 1.4
The numeric suffix is irrelevant.
Parameters:
<WindowType> RECTangular | HAMMing | HANNing | BLACkmanharris

RECTangular

The rectangular window multiplies all points by one. The result is a high frequency accuracy
with thin spectral lines, but also with increased noise. Use this function preferably with pulse
response tests where start and end values are zero.

HAMMing

The Hamming window is bell shaped. Its value is not zero at the borders of the measuring
interval. Thus, the noise level inside the spectrum is higher than Hanning or Blackman, but
smaller than the rectangular window. The width of the spectral lines is thinner than the
other bell-shaped functions. Use this window to measure amplitudes of a periodical signal
precisely.

HANNing

The Hanning window is bell shaped. Unlike the Hamming window, its value is zero at the
borders of the measuring interval. Thus, the noise level within the spectrum is reduced and
the width of the spectral lines enlarges. Use this window to measure amplitudes of a
periodical signal precisely.

BLACkmanharris

The Blackman window is bell shaped and has the steepest fall in its wave shape of all other
available functions. Its value is zero at both borders of the measuring interval. In the Black-
man window the amplitudes can be measured very precisely. However, determining the
frequency is more difficult. Use this window to measure amplitudes of a periodical signal
precisely.

*RST: HANNing

CALCulate:MATH<m>:FFT:TIME:RANGe <\WindowWidth>
Defines the width of the time base extract from the Y(t)-window for which the FFT is calculated.

Parameters:
<WindowWidth> Range: depends on the time base
Default unit: s
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CALCulate:MATH<m>:FFT:TIME:POSition <\WindowPosition>
Defines the position of the time base extract in the Y(t)-window for which the FFT is calculated.

Parameters:

<WindowPosition> Range: depends on the time base and the width of the FFT time base extract
Default unit: s

CALCulate:MATH<m>:FFT:SRATe? <SampleRate>
Returns the sample rate of data used in an FFT analysis.

Return values:

<SampleRate> Default unit: Sa/s
Usage: Query only
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2.9

Masks
MASK:STATE KSEATES it 109
MASKETEST STESE> i 109
MASK:LOAD <FileNaME> oo 109
MASK:SAVE <FIleNamMIe> ..o 109
MASK:SOURCE SSOUMCE> Lottt 109
MASKECHC OPY e 110
MASK:YPOSIHION <YPOSITION oot 110
MASK:YSCALE <YSCALe> oo 110
MASK:YWIDth <Yaddition > ..o 110
MASKXWIDth <Xaddition ..o 110
MASKECOUNE? e T
MASKEVCOUNE? s 1
MASK:ACTion:YOUT:ENABLE <YOUT> ..oiiiiiiiiiiiiii e m
MASK:STATe <State>
Turns the mask test mode on or off. When turning off, any temporarily stored new masks are deleted.
Parameters:
<State> ON | OFF

*RST: OFF
MASK:TEST <Test>
Starts, finishes or interrupts a mask test.
Parameters:
<Test> RUN | STOP

*RST: STOP

MASK:LOAD <FileName>
Loads a stored mask from the specified file.

Setting Parameters:
<FileName> String parameter
Path and file name

Usage: Setting only
MASK:SAVE <FileName>

Saves the current mask in the specified file.
Setting Parameters:

<FileName> String parameter
Path and file name

Usage: Setting only
MASK:SOURce <Source>

Defines the channel to be compared with the mask.
Parameters:

<Source> CH1 | CH2 | CH3 | CH4

*RST: CH1
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MASK:CHCopy
Creates a mask from the envelope waveform of the test source set with MASK: SOURce.

Usage: Event

MASK:YPOSition <Yposition>
Moves the mask vertically within the display.

Parameters:

<Yposition> Mask offset from the vertical center
Range: -200 to 200
Increment: 0.02
Default unit: div

*RST: 0

MASK:YSCALe <Yscale>
Changes the vertical scaling to stretch or compress the mask in y-direction.

Parameters:

<Yscale> Avalue over 100% stretches the amplitudes; a value less than 100% compresses
the amplitudes.
Range: 10 to 1000

Increment: 1
Default unit: %

*RST: 100

MASK:YWIDth <Yaddition>
Changes the width of the mask in vertical direction.

Parameters:

<Yaddition> The value is added to the y-values of the upper mask limit and subtracted from the
y-values of the lower mask limit.
Range: 0tob.12

Increment: 0.04
Default unit: div

*RST: 0

MASK:XWIDth <Xaddition>
Changes the width of the mask in horizontal direction.

Parameters:
<Xaddition> The value is added to the positive x-values and subtracted from the negative x-values of the
mask limits in relation to the mask center.

Range: 0to 10
Increment:  0.01

Default unit: div

*RST: 0
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2.10

MASK:COUNt?
Returns the number of tested acquisitions.

Return values:

<TotalCount> Total number of tested acquisitions
Usage: Query only
MASK:VCOunt?

Returns the number of acquistions that hit the mask.

Return values:
<ViolationCount> Number of violated acquisitions

Usage: Query only

MASK:ACTion:YOUT:ENABLe <Yout>

Enable or disable of pulses at the Y-OUTput if mask is distorted.

Parameters:
<Yout> ON | OFF

*RST: OFF

Component Tester (HM072x....202x only)

COMPonenttest:STATE <State> oo
COMPaonenttest:FREQuency <Frequency> ...

COMPonenttest:STATe <State>
Switches the component tester mode on or off.

Parameters:
<State> ON | OFF

*RST: OFF

COMPonenttest:FREQuency <Frequency>
Sets the frequency of the component tester source.

Parameters:
<Frequency> F50 | F200

F50

Sets the frequency of the component tester source to 50Hz.

F200
The frequency is 200 Hz.
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2.1

2.111

Protocol Analysis
GBNETAL L 112
Parallel BUS ... 114
Sl 115
SO Pl 122
L2 e 124
A R T e 133
AN e 139
L N e 150
General
BUS<D>:STATE <State> oo 112
BUSKD> TYPE <TYPE> ittt 112
BUS<b>:FORMat <Format> ... 112
BUS<b>:DSIZe <DisplaySizes> .....cooiiiiiiiiii i 113
BUS<b>:DSIGnals <BitsSignals> . ... 113
BUS<b>:POSItion <POSIION> ..o 113
BUS<b>:LABel <Label> ... 113
BUS<b>:LABel:STATE <State> ... 113
SOURce:FUNCtion[:SHAPe] <SignalShape> ..o 114
SOURce:FREQUENCY <FreqUeNCY> ..oiiiiiiiiiiiiieie e 114
BUS<b>:STATe <State>
Switches the protocol display on or off.
Suffix:
<b> 1,2

Select the bus.
Parameters:
<State> ON | OFF

*RST: OFF

BUS<b>:TYPE <Type>

Defines the bus or interface type for analysis. For most types, a special option to the instrument is required.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Type> PARallel | CPARallel | 12C | SPI'| SSPI'| UART | CAN | LIN

*RST: PARallel

BUS<b>:FORMat <Format>
Sets the decoding format for the display on the screen.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Format> ASCii | HEXadecimal | BINary | DECimal

*RST: HEXadecimal
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BUS<b>:DSIZe <DisplaySize>
Sets the height of the decoded bus signal on the screen.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<DisplaySize> SMALL | MEDium | LARGe

*RST: MEDium

BUS<b>:DSIGnals <BitsSignals>
Displays the individual bit lines above the decoded bus line.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<BitsSignals> ON | OFF

*RST: ON

BUS<b>:P0Sition <Position>

Sets the vertical position of the decoded bus signal in divisions on the screen.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Position> Increment:  0.02

Default unit: div

*RST: -3.5

BUS<b>:LABel <Label>
Sets the label for the bus.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<lLabel> String value

JUART_PC” [maximum 8 characters)

BUS<b>:LABel:STATe <State>
Switches the label of the bus on or off.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<State> ON | OFF

*RST: ON
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2.11.2

SOURce:FUNCtion[:SHAPe] <SignalShape>
Define the function of the internal bus signal source.

Parameters:
<SignalShape> SQUare | RANDom | 12C | SPI | COUNt | UART

*RST: SQUare

SOURce:FREQuency <Frequency>
Define the frequency of the internal bus signal source.

Parameters:
<Frequency> numeric value, depending of the function choosen for the internal bus signal source.
Square, Random: 1000, 1000000
UART: 9600, 115200, 1000000
SPI: 100000, 250000, 1000000
12C: 100000, 400000, 1000000
Count: 1000, 1000000
*RST: 1000
Parallel Bus
BUS<b>:PARallel:DATA<m>:SO0URce <SoUurce> ..o 114
BUS<b>:PARallel:WIDTh <BusWidth> ... 114

BUS<b>:PARallel:DATA<m>:SOURce <Source>
Sets the input channels for the data bit lines. The suffix <m> selects the bit line.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> DO ....D15

*RST: DO

BUS<b>:PARallel:WIDTh <BusWidth>
Sets the number of lines to be analyzed.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<BusWidth> Maximum number depends on HMO model.
Range: 1to 16
Increment: 1
Default unit: Bit
*RST: 4
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2.11.3 SPI

SPI - Configuration

BUS<b>:SPI:CS:SOURCE <SOUMCE™ ..ot 115
BUS<b>:SPI:CS:POLarity <Polarity> .......cccooiiiiiiio e 115
BUS<b>:SPI:CLOCK:SOURCE <SOUIMCE> ...oiiiiiiiiiiiiicoeeee e 116
BUS<b>:SPI:CLOCK:POLarity <Polarity> ..o 116
BUS<b>:SPIDATA:SOURCE <SOUMCE> it 116
BUS<b>:SPI:DATA:POLarity <Polarity> ... 117
BUS<b>:SPI:BORDer <BitOrders> ........ccooiiioiis oo 117
BUS<b>:SPI:SS1Ze <SymbolSize> ..o 117
Trigger

TRIGGer:A:SPEMODE <MOdE> .o 117
TRIGger:A:SPI:PATTern <DataPattern> .......ccccoiiiiiiiiiiiiiicc 118
TRIGger:A:SPI:PLENgth <PatternLength> ..o 118
TRIGger:A:SPI:POFFset <PatternBitOffset> ..o 118
Decode

BUS<b>:SPI:FCOUNt?<FrameCount> .........oooiiiiiiiiii e 118
BUS<b>:SPI:FRAMe<n>:STATUS? <StatUS> .....ooiiiiiiiiiiiii e 119
BUS<b>:SPI:FRAMe<n>:STARt? <StartTime> .......ccoooiiiiiiiiiiieeceee e 119
BUS<b>:SPI:FRAMe<n>:STOP? <StOPTIME> ..ot 119
BUS<b>:SPI:FRAMe<n>:DATA? <Datas> ......ccccooiiiiiiiieeee e 120
BUS<b>:SPI:FRAMe<n>:WCOunt? <WordCount>..........ccocvviiiiiiiiiiieiciieeee 120
BUS<b>:SPI:FRAMe<n>:WORD<0>STARt? <StartTime> .......cccccooiiiiiiiiiii 120
BUS<b>:SPI:FRAMe<n>:WORD<0>STOP? <StopTime>........c..coovvveiieiiiiiiiceee 121
BUS<b>:SPI:FRAMe<n>:WORD<0>MISO? <Data> ........ccccooiiiiiiiiiiiiiiiiieee 121
BUS<b>:SPI:FRAMe<n>:WORD<0>MOSI? <Data> .........cc.cooooiiiiiiiiiiiie 121

BUS<b>:SPI:CS:SOURce <Source>
Selects the input channel of the chip select line.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CH1T|CH2|CH3|CH4 | DO ....D15| EXTern

The external trigger input of the 2-channel instruments (HMQ0722, HM01022, HM01522,

HM02022, HM03522) can be used as chip select source.

*RST: CH1

BUS<b>:SPI:CS:POLarity <Polarity>
Selects whether the chip select signal is high active (high = 1] or low active (low = 1).

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Polarity> POSitive | NEGative

POSitive = high active
NEGative = low active

*RST: POSitive
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BUS<b>:SPI:CLOCk:SOURce <Source>
Selects the input channel of the clock line.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CHT|CH2|CH3|CH4|DO....D15

*RST: CH1

BUS<b>:SPI:CLOCk:POLarity <Polarity>
Selects if data is stored with the rising or falling slope of the clock. The slope marks the begin of a new bit.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Polarity> POSitive | NEGative

POSitive: rising slope
NEGative:  falling slope

*RST: NEGative

BUS<b>:SPI:DATA:SOURce <Source>
Selects the input channel of the data line.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CH1|CH2|CH3|CH4|DO....D15
*RST: CH1
HAMEG Instruments GmbH e Industriestr. 6 ¢ D-63533 Mainhausen e Deutschland Subject to change without notice

Tel.: +49 (0) 6182 800 0 » Fax: +49 (0) 6182 800 100 * E-Mail: info@hameg.com
Geschaftsfuhrer: Dipl.-Ing. Holger Asmussen, Dipl.-Ing. Andre Vander Stichelen ¢ AG Offenbach am Main HRB 41200 116



HAMEL=

Instruments
A Rohde & Schwarz Company

BUS<b>:SPI:DATA:POLarity <Polarity>
Selects whether transmitted data is high active (high = 1) or low active (low = 1).

Suffix:

<b> 1,2
Select the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive = high active
NEGative = low active
*RST: POSitive

BUS<b>:SPI:BORDer <BitOrder>
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least significant bit].

Suffix:
<b> 1,2
Select the bus.
Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBFirst

BUS<b>:SPI:SSIZe <SymbolSize>
Sets the word length, the number of bits in a message.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<SymbolSize> Range: 4 to 32

Increment: 1
Default unit: Bit

*RST: 8 Bit

TRIGger:A:SPI:MODE <Mode>
Specifies the trigger mode for SPI/SSPI protocols.

Parameters:

<Mode> BSTart | BEND | NTHBit | PATTern
BSTart
Burst start, sets the trigger event to the start of the frame. The frame starts when the chip
select signal CS changes to the active state. In case of SSPI protocol the frames starts with
the first slope of the clock signal.
BEND
Burst end, sets the trigger event to the end of the message. This event occurs if the
CS signal changes to inactive. In case of an SSPI protocol the frames ends if the idle time
has expired after the last clock slope.
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NTHBit
Sets the trigger event to the specified bit number. To define the bit number,
use TRIGger:A:SPI:POFFset.

PATTern

Sets the trigger event to a serial pattern. To define the pattern,

use TRIGger:A:SPI:PATTern.

For a complete configuration of the pattern mode, you also have to set
TRIGger:A:SPI:PLENgth and TRIGger:A:SPI:POFFset.

*RST: BSTart

TRIGger:A:SPI:PATTern <DataPattern>
Defines the bit pattern as trigger condition.

Parameters:
<DataPattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are allowed.
Example: TRIGger:A:SPI:PATTern “0011XXXX0110”

Sets a 12bit pattern.

TRIGger:A:SPI:PLENgth <PatternLength>
Defines how many bits build up the serial pattern.

Parameters:
<PatternLength> Range: 1to 32
Increment: 1

*RST: 4

TRIGger:A:SPI:POFFset <PatternBitOffset>
Sets the number of bits before the first bit of the pattern.

Parameters:

<PatternBitOffset> Number of ignored bits
Range: 0to 4095
Increment: 1

*RST: 0

BUS<b>:SPI:FCOunt?<FrameCount>
Returns the number of frames.

Suffix:
<b> 2

1
Select the bus.

Return values:

<FrameCount> Total number of decoded frames.
Usage: Query only
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BUS<b>:SPI:FRAMe<n>:STATus? <Status>
Returns the status of frames.

Suffix:
<b> 1.2

Select the bus.
<n> *

Selects the frame.

Return values:

<Status> OK | INCFirst | INCLast | INSufficient
OK frame is 0.k.
INCFirst first frame is incomplete
INCLast last frame is incomplete

INSufficient frame is insufficient

Usage: Query only

BUS<b>:SPI:FRAMe<n>:STARt? <StartTime>
Returns the start time of a frame.

Suffix:
<b> 1.2

Select the bus.
<n> *

Selects the frame.

Return value:

<StartTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:SPI:FRAMe<n>:STOP? <StopTime>
Returns the stop time of the frame.

Suffix:
<b> 1.2

Select the bus.
<n> *

Selects the frame.

Return value:

<StopTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:SPI:FRAMe<n>:DATA? <Data>
Returns the comma-separeted frame data.

Suffix:
<b> 1.2

Select the bus.
<n> *

Selects the frame.

Return values:
<Data> List of decimal values of data bytes

Example: BUS:SPI:FRAM3:DATA?

BUS<b>:SPI:FRAMe<n>:WCOunt? <\WordCount>
Returns the number of words of a frame.

Suffix:
<b> 1.2

Select the bus.
<n> *

Selects the frame.

Return value:
<WordCount> Number of words

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>STARt? <StartTime>
Gives back the start time of a word of a frame.

Suffix:
<b> 1.2

Select the bus.
<n> *

Selects the frame.
<0> *

Selects the word number.

Return value:

<StartTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:SPI:FRAMe<n>:WORD<0>STOP? <StopTime>
Returns the stop time of a word of a frame.

Suffix:
<b> 1.2

Select the bus.
<n> *

Selects the frame.
<0> *

Selects the word number.

Return value:

<StopTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>MIS0? <Data>
Returns the decimal value of a data word of a frame.

Suffix:
<b> 1.2
Select the bus.
<n> *
Selects the frame (1...n).
<0> *

Selects the word number (1...0).

Return values:
<Data> Decimal value of a data word

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>MO0SI? <Data>
Returns the decimal value of a data word of a frame.

Suffix:
<b> 1.2
Select the bus.
<n> *
Selects the frame (1...n).
<0> *

Selects the word number (1...0).

Return values:

<Data> Decimal value of a data word
Usage: Query only
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2.11.4 SSPI

BUS<b>:SSPI:CLOCKk:SOURce <Source>
BUS<b>:SSPI:CLOCk:POLarity <Polarity>
BUS<b>:SSPI:DATA:SOURce <Source>
BUS<b>:SSPI:DATA:POLarity <Polarity>
BUS<b>:SSPI:BITime <BurstldleTime>
BUS<b>:SSPI:BORDer <BitOrder>
BUS<b>:SSPI:SSIZe <SymbolSize>

BUS<b>:SSPI:CLOCk:SOURce <Source>
Selects the input channel of the clock line.

Suffix:
<b>

Parameters:
<Source>

1,2
Select the bus.

CH1[CH2|CH3|CH4|DO... D15

*RST: CH1

BUS<b>:SSPI:CLOCk:POLarity <Polarity>

Selects if data is stored with the rising or falling slope of the clock.

Suffix:
<b>

Parameters:
<Polarity>

1,2
Select the bus.
POSitive | NEGative

POSitive: rising slope
NEGative:  falling slope

*RST: POSitive

BUS<b>:SSPI:DATA:SOURce <Source>
Selects the input channel of the data line.

Suffix:
<b>

Parameters:
<Source>

1,2
Select the bus.

CH1[CH2|CH3|CH4|DO... D15

*RST: CH1

The slope marks the begin of a new bit.
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BUS<b>:SSPI:DATA:POLarity <Polarity>
Selects whether transmitted data is high active (high = 1) or low active (low = 1).

Suffix:

<b> 1,2
Select the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive = high active
NEGative = low active
*RST: POSitive

BUS<b>:SSPI:BITime <BurstldleTime>

Within the idle time the data and clock lines are low. A new frame begins when the idle time has expired and the clock
line has been inactive during that time. If the time interval between the data words is shorter than the idle time, the
words are part of the same frame.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<BurstldleTime> Range: 16e-9 to 1E-3

Increment:  16e-9
Default unit: s

*RST: 100e-6

BUS<b>:SSPI:BORDer <BitOrder>
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least significant bit].

Suffix:
<b> 1,2
Select the bus.
Parameters:
<BitOrder> MSBFirst | LSBFirst

*RST: MSBFirst

BUS<b>:SSPI:SSIZe <SymbolSize>
Sets the word length, the number of bits in @ message.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<SymbolSize> Range: 4 to 32
Increment: 1
Default unit: Bit
*RST: 8 Bit
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2.11.5 12C

12C - Configuration

BUS<b>:12C:CLOCK:SOURCE <SOUMCE> ..o 124
BUS<b>:12C:DATA:SOURCE <SOUICE> ..ot 124
Trigger

TRIGger:A:I2C:MODE <M0Ode> ..ot 125
TRIGGEr:A:I2C:ACCESS KACCESSD .ottt 125
TRIGger:A:12C:AMODe <AdrMOdes ..o 125
TRIGger:A:12C:ADDRess <AdAressString> ..o 125
TRIGger:A:12C:PATTern <DataPattern> ... 126
TRIGger:A:12C:PLENgth <PatternLength> ... 126
TRIGger:A:12C:POFFset <PatternByteOffset> ... 126
Decode

BUS<b>:12C:FCOUNt? <FrameCoUNt>........cooiiiiiiiiiiiiicee e 126
BUS<b>:12C:FRAMe<n>:STATUS? <State> ........cooeiiiiiiiiiieee e 127
BUS<b>:12C:FRAMe<n>:STARt? <StartTime> ..........ccccooviiiiiiicee e 127
BUS<b>:12C:FRAMe<n>:STOP? <EndTime> .....coooiiiiiiiiiiiieeeeeeee 127
BUS<b>:12C:FRAMe<n>:ACCESS? KACCESS> ...iiiiiiiiiiiiiiiiiie e 128
BUS<b>:12C:FRAMe<n>:AMODe? <AddressMode>............cccoeeeiviiiiiiiiiiiii 128
BUS<b>:12C:FRAMe<n>:AACCess? <Acknowledge> ...........cccccooviiiiiiiiiiiiiii 128
BUS<b>:12C:FRAMe<n>:ADDRess? <AddressValue> ............ccccooiiiiiiiiii 129
BUS<b>:12C:FRAMe<n>:ADEVice? <SlaveAddress> ...........cccooviiiiiiiiiiiieeeec 129
BUS<b>:12C:FRAMe<n>:ASTart? <StartTime> ............ooiiiiiieieeeeeeee 129
BUS<b>:12C:FRAMe<n>:ADBStart? <AckStartTime>..........ccoooiiiiiiiiiii 130
BUS<b>:12C:FRAMe<n>:ACOMplete? <AddressComplete>..........c.ccoociiiiiiiinn. 130
BUS<b>:12C:FRAMe<n>:BCOunt? <ByteCountIinFrame>................cccoociiiiiin. 130
BUS<b>:12C:FRAMe<n>:DATA? <DataWordsInFrame> ...........cccccciiiiiii 131
BUS<b>:12C:FRAMe<n>:BYTE<o>VALue <ByteValue> ..........cccccoooiiiiiiiin 131
BUS<b>:12C:FRAMe<n>:BYTE<0>STARt <StartTime> .........oooeiiiiiiiiiie 131
BUS<b>:12C:FRAMe<n>:BYTE<0o>ACKStart <AckStartTime>..........cccccovviiiiinn 132
BUS<b>:12C:FRAMe<n>:BYTE<0o>ACCess <Acknowledge>.........ccccccccvviiiiiiiin. 132
BUS<b>:12C:FRAMe<n>:BYTE<0o>COMPlete <ByteComplete> ...............ccccooo. 132

BUS<b>:12C:CLOCk:SOURce <Source>
Sets the input channel to which the clock line is connected.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CH1|CH2|CH3|CH4|DO....D15

*RST: CH1

BUS<b>:12C:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CH1|CH2|CH3[CH4|DO....D15

*RST: CH1
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TRIGger:A:12C:MODE <Mode>
Specifies the trigger mode for 12C.

Parameters:
<Mode> STARt | RESTart | STOP | MACKnowledge | PATTern

STARt
Start of the message. The start condition is a falling slope on SDA while SCL is high.

RESTart
Restarted message. The restart is a repeated start condition.

STOP
End of the message. The stop condition is a rising slope on SDA while SCL is high.

MACKnowledge
Missing acknowledge. If the transfer failed, at the moment of the acknowledge bit the SCL
and the SDA lines are both on high level.

PATTern

Triggers on a set of trigger conditions:read or write access of the master, to an address,
or/and to a bit pattern in the message.

For a complete configuration of the pattern mode, you have to set:
TRIGger:A:I2C:ACCess [read/write access), and

TRIGger:A:I2C:AMODe and TRIGger:A:I2C:ADDRess (address), and/or
TRIGger:A:I2C:POFFset and TRIGger:A:I2C:PLENgth and
TRIGger:A:I2C:PATTern [pattern]

*RST: STARt
TRIGger:A:12C:ACCess <Access>
Toggles the trigger condition between Read and Write access of the master.

Parameters:
<Access> READ | WRITe

*RST: READ
TRIGger:A:12C:AMODe <AdrMode>
Sets the lenght of the slave address.

Parameters:
<AdrMode> NORMal | EXTended

NORMal: 7 bit address
EXTended: 10 bit address

*RST: NORMal

TRIGger:A:12C:ADDRess <AddressString>
Sets the address of the slave device. The address can have 7 bits or 10 bits.

Parameters:
<AddressString> Binary pattern with max. 10 bit. Characters 0, 1, and X are allowed.
Example: TRIG:A:I2C:ADDR “10x1”
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TRIGger:A:12C:PATTern <DataPattern>
Defines the bit pattern as trigger condition. Make sure that the correct pattern length has been defined before with
TRIGger:A:I2C:PLENgth [see command below]).

Parameters:

<DataPattern> String with max. 24 characters. Characters 0, 1, and X are allowed. X can be assigned to a
specified bit. If you define a pattern shorter than the pattern length, the missing LSB are
filled with X. If you define a pattern longer than the pattern length, the pattern string is not
valid.

Example: TRIG:A:I2C:PLEN 2
TRIG:A:I2C:PATT ,10X10000XXXX1111"
TRIG:A:I2C:PATT?
Return value (2 bytes):,10X10000xXxX1111"

Example: TRIG:A:I2C:PLEN 1

TRIG:A:I2C:PATT ,110"
TRIG:A:I2C:PATT?
Return value (1 byte):,110xxxxX"

TRIGger:A:12C:PLENgth <PatternLength>
Defines how many bytes are considered in the trigger condition. To set the pattern for
these bytes, use TRIGger:A:TI2C:PATTern (see command above).

Parameters:

<PatternLength> Number of bytes
Range: 1to3
Increment: 1

*RST: 1

TRIGger:A:12C:POFFset <PatternByteOffset>
Sets the number of bytes before the first byte of interest, relating to the end of the address bytes.

Parameters:

<PatternByteOffset> Number of ignored bytes
Range: 0to 4095
Increment: 1

*RST: 0

BUS<b>:12C:FCOunt? <FrameCount>
Returns the number of frames.

Suffix:
<b> .2

1
Select the bus.

Return values:

<FrameCount> Total number of decoded frames.
Usage: Query only
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BUS<b>:12C:FRAMe<n>:STATus? <State>
Returns the status of the selected frame.

Suffix:
<b>

<n>

Return values:
<State>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

INComplete | OK | UNEXpstop | INSufficient | ADDifferent

INComplete frame is incomplete

oK frame is o.k.

UNEXpstop frame stop is unexpected
INSufficient frame is insufficient
ADDifferent frame address is different

Query only

BUS<b>:12C:FRAMe<n>:STARt? <StartTime>
Returns the start time of a frame.

Suffix:
<b>

<n>

Return values:
<StartTime>

Usage:

1,2
Select the bus.

1..n

Selects the frame.

Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Query only

BUS<b>:12C:FRAMe<n>:STOP? <EndTime>
Returns the stop time of a frame.

Suffix:
<b>

<n>

Return values:

<EndTime>

Usage:

1,2
Select the bus.

1..n

Selects the frame.

Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Query only
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BUS<b>:12C:FRAMe<n>:ACCess? <Access>

Returns the transfer direction - read or write access from master to slave.

Suffix:
<b>

<n>

Return values:
<Access>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

INComplete | READ | WRITE | EITHer | UNDF

INComplete frame is incomplete

READ read frame

WRITE write frame

ElTHer either write or read frame
UNDF frame is undefined

Query only

BUS<b>:12C:FRAMe<n>:AMODe? <AddressMode>
Returns the address length.

Suffix:
<b>

<n>
Return values:

<AddressMode>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

BIT7 | BIT10

BIT7 7 Bit address
BIT10 10 Bit address
Query only

BUS<b>:12C:FRAMe<n>:AACCess? <Acknowledge>
Returns the address acknowledge bit value for the indicated frame.

Suffix:
<b>

<n>

Return values:
<Acknowledge>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

INComplete | ACK | NACK | EITHer

INComplete acknowledge is incomplete

ACK acknowledge
NACK not acknowledge
ElTHer ack or nack
Query only
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BUS<b>:12C:FRAMe<n>:ADDRess? <AddressValue>
Returns the decimal address value of the indicated frame including the R/W bit.

Suffix:
<b> 1,2

Select the bus.
<n> 1..n

Selects the frame.

Return values:

<AddressValue> Decimal value
Range: 0to 2047
Increment: 1

Usage: Query only

BUS<b>:12C:FRAMe<n>:ADEVice? <SlaveAddress>
Returns the read/write address as a decimal value [excluding RW bit].

Suffix:
<b> 1,2

Select the bus.
<n> 1..n

Selects the frame.

Return values:

<SlaveAddress> Decimal value
Range: 0to 1023
Increment: 1

Usage: Query only

BUS<b>:12C:FRAMe<n>:ASTart? <StartTime>
Returns the start time of the address for the indicated frame.

Suffix:
<b> 1,2

Select the bus.
<n> 1..n

Selects the frame.

Return values:

<StartTime> Range: depends on sample rate and time base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:12C:FRAMe<n>:ADBStart? <AckStartTime>
Returns the start time of a address acknowledge of a frame.

Suffix:
<b>

<n>

Return values:
<AckStartTime>

Usage:

1,2
Select the bus.

1..n

Selects the frame.

Range: depends on sample rate and time base
Increment: depends on the time base
Default unit: s

Query only

BUS<b>:12C:FRAMe<n>:ACOMplete? <AddressComplete>
Returns the state of the address.

Suffix:
<b>

<n>
Return values:

<AddressComplete>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

ON | OFF

Query only

BUS<b>:12C:FRAMe<n>:BCOunt? <ByteCountInFrame>
Returns the number of data bytes in the specified frame.

Suffix:
<b>

<n>
Return values:
<ByteCountInFrame>

Example:

Usage:

1,2
Select the bus.

1..n
Selects the frame.
Number of words (bytes)

BUS:I2C:FRAM2:BCO?
> 4

Query only
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BUS<b>:12C:FRAMe<n>:DATA? <Data\WordsInFrame>
Returns a list of data words of the specified frame.

Suffix:
<b> 1,2

Select the bus.
<n> 1..n

Selects the frame.

Return values:
<DataWordsInFrame> Comma-separated list of decimal values of the data bytes

Example: BUS:I2C:FRAM2:DATA?
returns four data bytes:
-> 69,158,174,161
Usage: Query only

BUS<b>:12C:FRAMe<n>:BYTE<o0>VALue <ByteValue>
Returns the decimal value of the specified byte.

Suffix:
<b> 1,2

Select the bus.
<n> 1..n

Selects the frame.
<0> 1.0

Selects the byte number.

Return values:

<ByteValue> Decimal value
Range: 0 to 255
Increment: 1

Example: BUS:I2C:FRAM2:BYTE2:VAL?
-> 158

Usage: Query only

BUS<b>:12C:FRAMe<n>:BYTE<0>STARt <StartTime>
Returns the start time of the specified data byte.

Suffix:
<b> 1,2

Select the bus.
<n> 1..n

Selects the frame.
<0> *

Selects the byte number.

Return values:

<StartTime> Range: depends on sample rate and time base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:12C:FRAMe<n>:BYTE<o>ACKStart <AckStartTime>

Returns the start time of the acknowledge bit of a data byte of a frame.

Suffix:
<b>

<n>

<0>

Return values:
<AckStartTime>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

*

Selects the byte number.

Range: depends on sample rate and time base

Increment: depends on the time base
Default unit: s

Query only

BUS<b>:12C:FRAMe<n>:BYTE<0>ACCess <Acknowledge>
Returns the acknowledge bit of a data byte of a frame.

Suffix:
<b>

<n>

<0>

Return values:
<Acknowledge>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

*

Selects the byte number.

INComplete | ACK | NACK | EITHer

INComplete acknowledge is incomplete

ACK acknowledge
NACK not acknowledge
ElTHer ack or nack
Query only

BUS<b>:12C:FRAMe<n>:BYTE<0>COMPlete <ByteComplete>

Returns the information whether a data byte of a frame is received complete.

Suffix:
<b>

<n>

<0>

Return values:

<ByteComplete>

Usage:

1,2
Select the bus.

1..n
Selects the frame.

*

Selects the byte number.

ON | OFF

Query only
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2.11.6 UART

UART - Configuration

BUS<b>:UART:DATA:SOURCE <SOUMCE> ..o 133
BUS<b>:UART:DATA:POLarity <Polarity> .........ocoiiiiiiiii e 133
BUS<b>:UART:SSIZe <SymbolSIize> ... 134
BUS<b>:UART:PARIty <Parity> ... 134
BUS<b>:UART:SBIT <StopBitNumber> ... 134
BUS<b>:UART:BAUDrate <Baudrate> ..o 134
BUS<b>:UART:BITime <BurstldleTime> ... 135
Trigger

TRIGger:A:UART:MODE <MOde> ..o 135
TRIGger:A:UART:PATTern <DataPattern> ... 135
TRIGger:A:UART:PLENgth <PatternLength> ... 136
TRIGger:A:UART:POFFset <PatternByteOffset> ..o 136
Decode

BUS<b>:UART:FCOuNt? <FrameCount> .........cccooiiiiiiiiii e 136
BUS<b>:UART:FRAMe<n>:WORD<o0>:VALue? <Value> .........cccccoooiiiiiiiiiii 136
BUS<b>:UART:FRAMe<n>:WCOunt? <WordCount> .........c.ccooeeiiiiiiiiiiiiiiiice 137
BUS<b>:UART:FRAMe<n>:WORD:STARt? <StartTime> .........ccccooviviiiiiiiiiiece 137
BUS<b>:UART:FRAMe<n>:WORD<0>:STOP? <StopTime> .........cccoovviiiiiiiiie 137
BUS<b>:UART:FRAMe<n>:WORD<0>:STATe? <FrameStatus> ...............ccccoeenenn 138

BUS<b>:UART:DATA:SOURce <Source>
Selects the input channel of the UART signal.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CHT|CH2 | CH3|CH4 DO ....D15

*RST: CH1

BUS<b>:UART:DATA:POLarity <Polarity>
Defines if the transmitted data on the bus is high (high = 1) or low (low = 1] active.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Polarity> POSitive | NEGative
POSitive = high active
NEGative = low active
*RST: POSitive
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BUS<b>:UART:SSIZe <SymbolSize>
Sets the number of data bits in a message.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<SymbolSize> Range: 5to9

Increment: 1
Default unit: Bit

*RST: 8

BUS<b>:UART:PARity <Parity>
Defines the optional parity bit that is used for error detection.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Parity> ODD | EVEN | NONE

*RST: NONE

BUS<b>:UART:SBIT <StopBitNumber>
Sets the stop bits.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<StopBitNumber> B11B1.51B2

1; 1.5 or 2 stop bits are possible.

*RST: B1

BUS<b>:UART:BAUDrate <Baudrate>
Sets the number of transmitted bits per second.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Baudrate> Range: 100 to 78.1E6 (Upper limit depends on HMO model)
Default unit: Bit
*RST: 115200
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BUS<b>:UART:BITime <BurstldleTime>
Sets the minimal time between two data frames (packets), that is, between the last stop bit and the start bit of the next

frame.
Suffix:
<b> 1,2
Select the bus.
Parameters:
<BurstldleTime> Range: 12.8E-9 to 53.68E-3

Increment:  12.8E-9
Default unit: s

*RST: 64E-9

TRIGger:A:UART:MODE <Mode>
Specifies the trigger mode for UART/RS-232 interfaces.

Parameters:
<Mode> BSTart | SBIT | NTHSymbol | SYMBol | PATTern | PERRor | FERRor | BREak

BSTart
Burst start. Sets the trigger to the begin of a data frame. The frame start is the first start
bit after the idle time.

SBIT
Start bit. The start bit is the first low bit after a stop bit.

NTHSymbol
Sets the trigger to the n-th symbol of a burst.

SYMBol
Triggers if a pattern occurs in a symbol at any position in a burst.

PATTern

Triggers on a serial pattern at a defined position in the burst. To define the pattern, use
TRIGger:A:UART:PLENgth and TRIGger:A:UART: PATTern.

To define the position, use TRIGger:A:UART: POFFset.

PERRor
Parity Error:Triggers if a bit error occured in transmission.

FERRor
Triggers on frame error.

BREak
Triggers if a start bit is not followed by a stop bit within a defined time. During the break the
stop bits are at low state.

*RST: SBIT

TRIGger:A:UART:PATTern <DataPattern>
Defines the bit pattern as trigger condition.

Parameters:
<DataPattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are allowed.
*RST: 1 =.00000001"
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TRIGger:A:UART:PLENgth <PatternLength>
Defines how many symbols build up the serial pattern.

Parameters:
<PatternLength> Number of symbols
Range: 1tob
The maximum number of symbols are depending on the symbol size of the
UART protocol.
Symbol size Max. symbols
5 6
6 5
7 4
38 4
9 3

Table 2.8: Symbols
Increment: 1

*RST: 1

TRIGger:A:UART:POFFset <PatternByteOffset>
Sets the number of symbols before the first symbol of the pattern.

Parameters:

<PatternByteOffset> Number of ignored symbols
Range: 0to 4095
Increment: 1
*RST: 0

BUS<b>:UART:FCOunt? <FrameCount>
Returns the number of decoded frames on the on the data line.

Suffix
<b> 1,2

Select the bus.
Return values:

<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD<0>:VALue? <Value>
Return the value of the specified symbol (word) on the data line.

Response:
<b> 1,2

Select the bus.
<n> *

Selects the frame.
<0> *

Selects the word number.
Return values:

<Value> Decimal value
Range: 0to 511
Increment: 1
Usage: Query only
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BUS<b>:UART:FRAMe<n>:WCOunt? <\WordCount>
Returns the number of symbols in the specified frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:
<WordCount> Number of words (symbols, characters)

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD:STARt? <StartTime>
Returns the start time of the specified symbol (word).

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<StartTime> Range: depends on sample rate, record length and time base

Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD<0>:STOP? <StopTime>
Returns the stop time of a word of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<StopTime> Range: depends on sample rate, record length and time base

Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:UART:FRAMe<n>:WORD<0>:STATe? <FrameStatus>
Returns the status of frames.

Suffix:
<b>

<n>

Return values:
<FrameStatus>

Usage:

1,2
Select the bus.

*

Selects the frame.

OK | FRSTart | FRENd | FRMError | STERror | SPERror | PRERror | INSufficient

OK frame is o.k.
FRSTart frame start
FRENd frame end

FRMError  frame error
STERror starthit error
SPERror stopbit error
PRERror parity error
INSufficient frame is insufficient

*RST: OK

Query only
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2.11.7 CAN

CAN - Configuration

BUS<b>:CAN:DATA:SOURCE <SOUIMCE> ...ooiiiiiiiioi e 139
BUS<b>:CAN:TYPE <SignalType> ... 140
BUS<b>:CAN:SAMPlepoint <SamplePoint> ... 140
BUS<b>:CAN:BITRate <BitRate> ... 140
Trigger

TRIGGer:A:CAN:TYPE <TrgQEITYPE> ..ottt 140
TRIGger:A:CAN:FTYPe <FrameType> ......ocoooiiiiiiiiii e 141
TRIGger:A:CAN:ITYPe <IdentifilerType> ..o 141
TRIGger:A:CAN:ICONdition <ldentifierCondition> ..o 141
TRIGger:A:CAN:IDENTtifier <ldentifiers> ..o 141
TRIGger:A:CAN:DCONdition <DataCondition> ........cocooiiiiiiiiiiiii e 141
TRIGGEr:A:CAN:DATA <Data> .. .iiiiiiiiiiiiii s 142
TRIGger:A:CAN:DLENgth <Datalength> ... 142
TRIGger:A:CAN:ACKerror <AcknowledgeError>........cccociiiiiiiiii 142
TRIGger:A:CAN:CRCerror <CRCEIMOI>......coiiiiiiiiiio e 142
TRIGger:A:CAN:FROMerror <FOrmMEMor>.......c.ccooiiiiiiiiiiiii 142
TRIGger:A:CAN:BITSterror <BitStuffingError> ... 142
Decode

BUS<b>:CAN:FCOUNt? <FrameCount>........ccccoiiiiiiiiiiioie e 143
BUS<b>:CAN:FRAMe<n>:STATUs? <FrameStatus> .........cccccoeieiiiiiiiiiiiiieeee 143
BUS<b>:CAN:FRAME<n>:STARt? <StartTime> .......cooiiiiiiiiiiiice 143
BUS<b>:CAN:FRAME<N>:STOP? <StopTime> ....ccooiiiiiiiiiiiiiii e 144
BUS<b>:CAN:FRAME<n>:TYPE? <FrameType> ......ccocoiiiiiiiiiiiiiieeee e 144
BUS<b>:CAN:FRAME<n>:DATA? <FrameData>..........ccccooiiiiiiii 144
BUS<b>:CAN:FRAME<n>:ACKState? <AcknowledgeState>.............cccoooviiiiinnn 145
BUS<b>:CAN:FRAME<n>:CSState <ChecksumState>............ccoovviiiiiiiiiiiiiee 145
BUS<b>:CAN:FRAME<n>:DLCState? <DataLengthCodeState> ............cccc..coeenn. 145
BUS<b>:CAN:FRAME<n>:IDSTate? <ldentifierState> .........ccccoviiiiiiiiiiii 146
BUS<b>:CAN:FRAME<n>:ACKValue? <AcknowledgeValue>................cccceeevnn. 146
BUS<b>:CAN:FRAME<n>:CSValue? <ChecksumValue> .................ccoocoiviiiiiiin, 146
BUS<b>:CAN:FRAME<n>:DLCValue <DataLengthCodeValue> ..................ceooene.. 147
BUS<b>:CAN:FRAME<n>:IDTYpe? <ldentifierType> .........cccoociiiiiiiiiiiiiiiii, 147
BUS<b>:CAN:FRAME<n>:IDValue? <ldentifierValue> .............cccoccooviiiiiiiiii 147
BUS<b>:CAN:FRAME<n>:BSEPosition? <BitStuffingErrorPosition>....................... 148
BUS<b>:CAN:FRAME<n>:BCOunt? <ByteCount>.........ccccoooiiiiiiiiiiiiiee 148
BUS<b>:CAN:FRAME<n>:BYTE<0>:STATe? <ByteStatus> ............cooeiviiiiiin, 148
BUS<b>:CAN:FRAME<n>:BYTE<o>:VALue? <ByteValue> ...t 149

BUS<b>:CAN:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CHT|CH2 | CH3|CH4|DO....D15

*RST: CH1
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BUS<b>:CAN:TYPE <SignalType>
Sets the signal type of the CAN.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<SignalType> CANH | CANL
CANH CAN High
CANL CAN Low
*RST: CANH

BUS<b>:CAN:SAMPlepoint <SamplePoint>
Sets the sample point for the CAN Decoder within the bit period.

Suffix:

<b> 1,2
Select the bus.

Parameters:

<SamplePoint> <numeric_value>
Min.: 25
Max.: 90
Inc.: 1
Unit:%
*RST: 50

BUS<b>:CAN:BITRate <BitRate>
Sets the number of transmitted bits per second.

Suffix:

<b> 1,2
Select the bus.

Parameters:

<BitRate> <numeric_value>
HMO35xx: 100Bit/s to 4.03MBiIt/s
HMO2524: 100Bit/s to 2.52MBit/s
HMO72x...202x: 1008Bit/s to 2.016MBit/s
Unit: Bit/s
*RST: 50E03

TRIGger:A:CAN:TYPE <TriggerType>
Specifies the trigger type for CAN.

Parameters:

<TriggerType> STOFrame | EOFrame | ID | IDDT | FTYPe | ERRCondition
STOFrame Sets the trigger to the start of a frame.
EOFrame Sets the trigger to the end of a frame.
ID Sets the trigger to the ID of a frame.
IDDT Sets the trigger to the ID and data of a frame.
FTYPe Sets the trigger to the frame type.
ERRCondition Sets the trigger to the error condition of a frame.
*RST: STOF

HAMEG Instruments GmbH e Industriestr. 6 ¢ D-63533 Mainhausen e Deutschland Subject to change without notice

Tel.: +49 (0) 6182 800 0 » Fax: +49 (0) 6182 800 100 * E-Mail: info@hameg.com
Geschaftsfuhrer: Dipl.-Ing. Holger Asmussen, Dipl.-Ing. Andre Vander Stichelen ¢ AG Offenbach am Main HRB 41200 140



HAMEL=

Instruments
A Rohde & Schwarz Company

TRIGger:A:CAN:FTYPe <FrameType>
Specifies the frame type for CAN.

Parameters:

<FrameType> DATA | REMote | ERRor | OVERload | ANY
DATA Sets the frame type to data.
REMote Sets the frame type to remote.
ERRor Sets the frame type to error.
OVERload  Sets the frame type to overload.
ANY Sets the frame type to any.
*RST: ERR

TRIGger:A:CAN:ITYPe <IdentifierType>
Specifies the identifier type for CAN.

Parameters:

<ldentifierType> B11[B29 [ ANY
B11 Sets the identifier type 11Bit.
B29 Sets the identifier type 29Bit.
ANY Sets the identifier type to any.
*RST: B11

(if trigger type ID is set, only B11 or B29 is allowed)
TRIGger:A:CAN:ICONdition <IdentifierCondition>
Specifies the condition for the identifier.

Parameters:
<lIdentifierCondition> EQUual | NEQual | GTHan | LTHan

EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater then.
LTHan Sets the condition for identifier to less then.
*RST: EQU

TRIGger:A:CAN:IDENtifier <Identifier>
Specifies the identifier, depending of TRIGger:A:CAN: ITYPe <ldentifierType> setting only string with 11 or 29
characters is possible.

Parameters:

<|dentifier> 01X-string with up to 29 character

TRIGger:A:CAN:DCONdition <DataCondition>
Specifies the condition for the data.

Parameters:

<DataCondition> EQUual | NEQual | GTHan | LTHan
EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater then.
LTHan Sets the condition for identifier to less then.
*RST: EQU
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TRIGger:A:CAN:DATA <Data>

Specifies the data for CAN trigger. Depending of TRIGger:A:CAN: DLENgth (see commad below) setting the number
of characters is fixed, all bytes need to be complete.

Parameters:
<Data> 01X-string with up to 64 character
Example: TRIG:A:CAN:DATA ,10010110%

TRIGger:A:CAN:DLENgth <Datalength>
Specifies the data length for the CAN trigger.

Parameters:

<DatalLength> <numeric_value>
Min.: 0
Max.: 8
Inc.: 1
Unit: Byte
*RST: 1

TRIGger:A:CAN:ACKerror <AcknowledgeError>
Specifies the trigger on acknowledge error when trigger type is set to error, using TRIGger :A:CAN: TYPE

Parameters:
<AcknowledgeError> ON | OFF

*RST: OFF
TRIGger:A:CAN:CRCerror <CRCerror>
Specifies the trigger on checksum error when trigger type is set to error, using TRIGger:A: CAN: TYPE .

Parameters:
<CRCerror> ON | OFF

*RST: OFF
TRIGger:A:CAN:FROMerror <FormError>
Specifies the trigger on form error when trigger type is set to error, using TRIGger:A:CAN: TYPE .

Parameters:
<FormError> ON | OFF

*RST: OFF

TRIGger:A:CAN:BITSterror <BitStuffingError>
Specifies the trigger on stuff bit error when trigger type is set to error, using TRIGger : A: CAN: TYPE .

Parameters:
<BitStuffingError> ON | OFF
*RST: ON
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BUS<b>:CAN:FCOunt? <FrameCount>
Returns the number of frames.

Suffix:

<b> .2

1
Select the bus.

Return values:
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:CAN:FRAMe<n>:STATus? <FrameStatus>
Returns the status of frames.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<State> OK | BTST | CRC | FORM | NACK | INSufficient
oK frame is valid
BTST bit stuff error occured
CRC cyclic redundancy check failed
FORM wrong CRC or ACK delimiter or end of frame occured
NACK acknowledge is missing

INSufficient frame is incomplete

Usage: Query only

BUS<b>:CAN:FRAME<n>:STARt? <StartTime>
Returns the start time of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<StartTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:CAN:FRAME <n>:STOP? <StopTime>
Returns the stop time of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<StopTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:CAN:FRAME<n>:TYPE? <FrameType>
Returns the frame type.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<FrameType> DATA | REMote | ERR | OVLD
DATA frame type is data
REMote frame type is remote
ERR frame type is error
OVLD frame type is overload
Usage: Query only

BUS<b>:CAN:FRAME<n>:DATA? <FrameData>
Returns a comma separated list of decimal values.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<FrameData> Comma-separated list of decimal values of data bytes of a frame
Usage: Query only
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BUS<b>:CAN:FRAME<n>:ACKState? <AcknowledgeState>
Returns the status of the acknowledge field of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:
<AcknowledgeState> OK | UNDF

oK acknowledge state is 0.k.
UNDF acknowledge state is undefined.
Usage: Query only

BUS<b>:CAN:FRAME<n>:CSState <ChecksumState>
Returns the status of the checksum field of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<ChecksumState> OK | UNDF

OK acknowledge state is 0.k.

UNDF acknowledge state is undefined.
Usage: Query only

BUS<b>:CAN:FRAME<n>:DLCState? <DatalLengthCodeState>
Returns the status of the data length code of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:
<DatalLengthCodeState> OK | UNDF

OK data length code state is o.k.
UNDF data length code state is undefined.
Usage: Query only
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BUS<b>:CAN:FRAME<n>:IDSTate? <l|dentifierState>
Returns the status of the identifier field of a frame.

Suffix:
<b>

<n>

Return values:

<ldentifierState>

Usage:

BUS<b>:CAN:FRAME<n>:ACKValue? <AcknowledgeValue>

1,2
Select the bus.

*

Selects the frame.

OK | UNDF

OK identifier state is o.k.

UNDF identifier state is undefined.
Query only

Returns the value of the acknowledge bit of a frame.

Suffix:
<b>

<n>

Return values:

<AcknowledgeValue>

Usage:

1,2
Select the bus.

*

Selects the frame.

Decimal value

Query only

BUS<b>:CAN:FRAME <n>:CSValue? <ChecksumValue>
Returns the value of the checksum of a frame.

Suffix:
<b>

<n>
Return values:

<ChecksumValue>

Usage:

1,2
Select the bus.

*

Selects the frame.

Decimal value

Query only
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BUS<b>:CAN:FRAME<n>:DLCValue <DatalLengthCodeValue>
Returns the value of the data length code field of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:
<DatalLengthCodeValue> Non-negative integer

Usage: Query only

BUS<b>:CAN:FRAME<n>:IDTYpe? <IdentifierType>
Returns the identifier type of the selected frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<ldentifierType> ANY [ B11 | B29
ANY identifier type is any
B11 identifier type is 11 bit
B29 identifier type is 29 bit
Usage: Query only

BUS<b>:CAN:FRAME <n>:IDValue? <|dentifierValue>
Returns the value of the identifier of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<IdentifierValue> Decimal value
Usage: Query only
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BUS<b>:CAN:FRAME<n>:BSEPosition? <BitStuffingErrorPosition>
Returns the time of the first bit stuffing error within the specified frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<BitStuffingErrorPosition>  Unit: s
*RST: 0
Usage: Query only

BUS<b>:CAN:FRAME<n>:BCOunt? <ByteCount>
Returns the number of data bytes of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:
<ByteCount> Number of bytes

Usage: Query only

BUS<b>:CAN:FRAME<n>:BYTE<0>:STATe? <ByteStatus>
Returns the state of the a data byte of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.
<0> *

Selects the byte number.

Return values:

<ByteStatus> OK | UNDF
OK data byte state is o.k.
UNDF data byte state is undefined.
Usage: Query only
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BUS<b>:CAN:FRAME<n>:BYTE<o0>:VALue? <ByteValue>
Returns the value of the data byte of a frame.

Suffix:
<b>

<n>

<0>

Return values:

<ByteValue>

Usage:

1,2
Select the bus.

*

Selects the frame.

*

Selects the byte number.

Decimal value

Query only
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2.11.8 LIN

LIN - Configuration

BUS<b>:LIN:DATA:SOURCE <SOUICE> ...vvvviiiiiiiiieieeeeee e
BUS<b>:LIN:POLarity <Polarity> ..o
BUS<b>:LIN:STANdard <Standard> ............ccooiiii
BUS<b>:LIN:BITRate <BitRate> .....ccocvvviiiiiiiie

Trigger

TRIGger:A:LIN:TYPE <TriggerTypes> ..ot
TRIGger:A:LIN:ICONdition <ldentifierCondition> ...,
TRIGger:A:LIN:IDENtifier <ldentifier> ...
TRIGger:A:LIN:DCONdition <DataCondition> .........ccccooiiiiiiiiiiiii
TRIGGer:A:LIN:DATA <Datas ...ccoviiiiiiiiiiieee e
TRIGger:A:LIN:DLENgth <DatalLength> ...
TRIGger:A:LIN:CHKSerror <ChecksumError> ...,
TRIGger:A:LIN:IPERerror <ldentifierParityError>...............ccoooii
TRIGger:A:LIN:SYERror <SynchronisationError>.............cccccooiiiii

Decode

BUS<b>:LIN:FCOunt? <FrameCount> ...........cccooviiiiiiiii e
BUS<b>:LIN:FRAME<n>:STATus? <FrameStatus> ...............cccceeiiiiiiinn,
BUS<b>:LIN:FRAME<n>:STARt? <StartTime> ...........cccccc
BUS<b>:LIN:FRAME<n>:STOP? <StopTime>.........coccviiiiieiiiiiiieeee
BUS<b>:LIN:FRAME<n>:VERSIion? <FrameVersion> ................cccccnnn.
BUS<b>:LIN:FRAME<n>:DATA? <FrameData> ............ccocceeeeiiiiiiicncee,
BUS<b>:LIN:FRAME<n>:IDSTate? <ldentifierState> ....................ccoeen.
BUS<b>:LIN:FRAME<n>:IDValue? <IdentifierValue> ................................
BUS<b>:LIN:FRAME<n>:IDPValue? <ldentifierParityValue>....................
BUS<b>:LIN:FRAME<n>:SYSTate? <SyncFieldState>.............ccccccoeeiinn
BUS<b>:LIN:FRAME<n>:CSSTate? <ChecksumState>................cceeenn,
BUS<b>:LIN:FRAME<n>:CSValue? <ChecksumValue>............................
BUS<b>:LIN:FRAME<n>:BCOunt? <ByteCount> ...........ccc..cooevvinieniinnn
BUS<b>:LIN:FRAME<n>:BYTE<0>:STATe? <ByteStatus>........................
BUS<b>:LIN:FRAME<n>:BYTE<o>:VALue <ByteValue> ..........................

BUS<b>:LIN:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Source> CH1[CH2|CH3|CH4| DO ....D15

*RST: CH1

BUS<b>:LIN:POLarity <Polarity>
Sets the polarity of the LIN.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Polarity> IDLHigh | IDLLow

*RST: POS
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BUS<b>:LIN:STANdard <Standard>

Sets the standard of LIN protocol.

Suffix:
<b> 1,2
Select the bus.
Parameters:
<Standard> VIX | V2X | J2602 | AUTO
VIX LIN Standard V1.x
V2X LIN Standard V2.x
J2602 LIN Standard J206 (sets also BitRate to 10.417 KBit/s)
AUTO any standard
*RST: V1X

BUS<b>:LIN:BITRate <BitRate>
Sets the bit rate for the LIN Decoder.

Suffix:

<b> 1,2
Select the bus.

Parameters:

<BitRate> <numeric_value>
HMO35xx: 1008Bit/s to 4.03MBit/s
HMO2524: 100Bit/s to 2.52MBit/s
HMO72x...202x: 100Bit/s to 2.016MBit/s
Default unit: Bit/s
*RST: 9.6E03

TRIGger:A:LIN:TYPE <TriggerType>

Specifies the trigger type for LIN.

Parameters:
<TriggerType> SYNC | WKFRame | ID | IDDT | ERRCondition
SYNC Sets the trigger to the synchronisation.
WKFRame Sets the trigger to the wake up frame.
ID Sets the trigger to the ID of a frame.
IDDT Sets the trigger to the ID and data of a frame.

ERRCondition

*RST:

Sets the trigger to the error condition of a frame.

SYNC

TRIGger:A:LIN:ICONdition <IdentifierCondition>
Specifies the condition for the identifier.

Parameters:

<ldentifierCondition> EQUual | NEQual | GTHan | LTHan

EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater then.
LTHan Sets the condition for identifier to less then.
*RST: EQU
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TRIGger:A:LIN:IDENtifier <Identifier>
Specifies the identifier, only 6 character are allowed.

Parameters:
<lIdentifier> 01X-string with up to 6 character
Example: TRIG:A:LIN:IDEN “100001%

TRIGger:A:LIN:DCONdition <DataCondition>
Specifies the condition for the data.

Parameters:

<DataCondition> EQUual | NEQual | GTHan | LTHan
EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater then.
LTHan Sets the condition for identifier to less then.
*RST: EQU

TRIGger:A:LIN:DATA <Data>
Specifies the data for LIN trigger. Depending of TRIGger:A:LIN:DLENgth (see command below) setting the number
of characters is fixed, all bytes need to be complete.

Parameters:
<Data> 01X-string with up to 64 character
Example: TRIG:A:LIN:DATA ,10100101%

TRIGger:A:LIN:DLENgth <DatalLength>
Specifies the data length for the LIN trigger.

Parameters:

<Datalength> Range: 1t08
Increment: 1
Default unit: Byte

*RST: 1
TRIGger:A:LIN:CHKSerror <ChecksumError>
Specifies the trigger on checksum error when trigger type is set to error condition, using TRIGger:A: LIN: TYPE

<TriggerType>.

Parameters:
<ChecksumError> ON | OFF

*RST: ON
TRIGger:A:LIN:IPERerror <ldentifierParityError>
Specifies the trigger on parity error on identifier when trigger type is set to error condition, using

TRIGger:A:LIN:TYPE .

Parameters:
<ldentifierParityError>  ON | OFF

*RST: OFF
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TRIGger:A:LIN:SYERror <SynchronisationError>
Specifies the trigger on synchronisation error when trigger type is set to error, using TRIGger :A: LIN: TYPE .

Parameters:
<SynchronisationError>  ON | OFF

*RST: OFF

BUS<b>:LIN:FCOunt? <FrameCount>
Returns the number of received frames.

Suffix:

<b> 2

1
Select the bus.

Return values:
<FrameCount> Total number of decoded frames.

Usage: Query only

BUS<b>:LIN:FRAME<n>:STATus? <FrameStatus>
Returns the status of frames.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<State> OK | UART | CHCK | PRER | WAK | SYER | INS | ERR | LEN
OK frame is valid
UART
CHCK checksum error occured

PRERror parity error
WAKeup wake up occured

SYER synchronisation error
INSufficient identifier is insufficient
ERRor error
LENer length error

Usage: Query only

BUS<b>:LIN:FRAME<n>:STARt? <StartTime>
Returns the start time of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<StartTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only
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BUS<b>:LIN:FRAME<n>:STOP? <StopTime>
Returns the stop time of a frame.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<StopTime> Range: depends on sample rate, record length, and time base
Increment: depends on the time base
Default unit: s

Usage: Query only

BUS<b>:LIN:FRAME<n>:VERSion? <FrameVersion>
Returns the version of LIN.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<FrameVersion> VIX | V2X | UNK

V1X LIN version is 1.x

V2X LIN version is 2.x

UNK LIN version is unknown
Usage: Query only

BUS<b>:LIN:FRAME<n>:DATA? <FrameData>
Returns a comma separated list of decimal values of the data bytes.

Suffix:
<b> 1,2

Select the bus.
<n> *

Selects the frame.

Return values:

<FrameData> Comma-separated list of decimal values of data bytes of a frame
Usage: Query only
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BUS<b>:LIN:FRAME<n>:IDSTate? <|dentifierState>
Returns the status of the identifier field of a frame.

Suffix:
<b>

<n>

Return values:
<ldentifierState>

Usage:

1,2
Select the bus.

*

Selects the frame.

OK | PRERror | UVAL | INSufficient

oK identifier state is o0.k.

PRERror parity error at the identifier

UVAL address is unknown
INSufficient identifier is insufficient

Query only

BUS<b>:LIN:FRAME<n>:IDValue? <|dentifierValue>
Returns the value of the identifier of a frame.

Suffix:
<b>

<n>
Return values:

<ldentifierValue>

Usage:

1,2
Select the bus.

*

Selects the frame.

Decimal value

Query only

BUS<b>:LIN:FRAME<n>:IDPValue? <ldentifierParityValue>
Returns the value of the parity of the identifier of a frame.

Suffix:
<b>

<n>
Return values:

<|dentifierParityValue>

Usage:

1,2
Select the bus.

*

Selects the frame.

Decimal value

Query only
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BUS<b>:LIN:FRAME<n>:SYSTate? <SyncFieldState>
Returns the status of synchronization field of a frame.

Suffix:
<b>

<n>

Return values:
<SyncFieldState>

Usage:

1,2
Select the bus.

*

Selects the frame.

OK | ERR | UNDF

oK sync field state is 0.k.

ERR sync error.

UNDF sync field state is undefined.
Query only

BUS<b>:LIN:FRAME<n>:CSSTate? <ChecksumState>
Returns the state of the checksum of a frame.

Suffix:
<b>

<n>

Return values:
<ChecksumState>

Usage:

1,2
Select the bus.

*

Selects the frame.

OK | ERR | UNDF

oK checksum field state is o.k.
ERR checksum error.

UNDF checksum state is undefined.
Query only

BUS<b>:LIN:FRAME<n>:CSValue? <ChecksumValue>
Returns the value of the checksum of a frame.

Suffix:
<b>

<n>
Return values:

<ChecksumValue>

Usage:

1,2
Select the bus.

*

Selects the frame.

Decimal value

Query only
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BUS<b>:LIN:FRAME<n>:BCOunt? <ByteCount>
Returns the number of bytes of a frame.

Suffix:
<b>

<n>

Return values:

<ByteCount>

Usage:

1,2
Select the bus.

*

Selects the frame.

Number of words (bytes)

Query only

BUS<b>:LIN:FRAME<n>:BYTE<0>:STATe? <ByteStatus>
Returns the status of a data byte of a frame.

Suffix:
<b>

<n>

<0>

Return values:

<ByteStatus>

Usage:

1,2
Select the bus.

*

Selects the frame.

*

Selects the byte number.

OK [ INS | UART

oK byte status is o.k.

INS byte status is insufficient.
UART error within the byte.
Query only

BUS<b>:LIN:FRAME<n>:BYTE<o0>:VALue <ByteValue>
Returns the value of the byte of a frame.

Suffix:
<b>

<n>

<0>

Return values:

<ByteValue>

Usage:

1,2
Select the bus.

*

Selects the frame.

*

Selects the byte number.

Decimal value

Query only
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2.12 Dataand File Management
This chapter describes commands that store or restore data and measurement results.
2.12.1 Output Control
HCOPy:DESTInation <MediUm> ..o 158
MMEMory:NAME <FIleName> ... 158
HCOPY[IMMediate] ... 158
HCOPy:LANGUage <FOrmMats> ..o 158
HCOPyY:PAGE:SIZE <SIZE> ..ottt 159
HCOPy:PAGE:ORlentation <Orientation> ...t 159
HCOPy:COLOR:SCHeme <ColorScheme> ..o 159
SYSTem:COMMunicate:PRINter:SELect <PrinterName> ... 159
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt? ..o 159
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]? ... 159
HCOPy:DESTination <Medium>
Defines whether the screenshot is saved or printed.
Parameters:
<Medium> .MMEM" | ,SYST:COMM:PRIN"
.MMEM"
Saves the screenshot to a file. Specify the file name and location with MMEMory : NAME .
.SYST:COMM:PRIN"
Prints on the printer specified with SYSTem:COMMunicate:PRINter:SELect.
The printer must be specified before the HCOPy: DESTination is sent.
*RST: JMMEM"
MMEMory:NAME <FileName>
Defines the file name to store an image of the display with HCOPy [ : IMMediate].
Parameters:
<FileName> String parameter
HCOPy[:IMMediate]
Prints an image of the display to the printer or saves an image to a file, depending on the HCOPy: DESTination setting.
The printer is defined by SYSTem: COMMunicate: PRINter:SELect.
The file name for storage is defined by MMEMory : NAME .
Usage: Event
HCOPy:LANGuage <Format>
Defines the format of the printed or saved screenshot.
Parameters:
<Format> GDI' | BMP | PNG | GIF
GDI For output on printer
BMP | PNG | GIF  File formats for saved screenshots
*RST: PNG
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HCOPy:PAGE:SIZE <Size>
Defines the page size to be used.

Parameters:

<Size> A4 | A5 | B5 | B6 | EXECutive
HCOPy:PAGE:ORIentation <Orientation>

Defines the page orientation.

Parameters:

<Orientation> LANDscape | PORTrait

HCOPy:COLOR:SCHeme <ColorScheme>
Defines the color mode for saved and printed screenshots.

Parameters:

<ColorScheme> COLor | GRAYscale | INVerted
INVerted inverts the colors of the output, i.e. a dark waveform is printed on a white
background.
*RST: COLor

SYSTem:COMMunicate:PRINter:SELect <PrinterName>
Selects a configured printer.

Parameters:

<PrinterName> String parameter
Enter the string as it is returned with
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt? or
SYSTem:COMMunicate:PRINter:ENUMerate [ :NEXT]?.

SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?
Queries the name of the first printer in the list of printers. The names of other installed
printers can be queried with the SYSTem:COMMunicate: PRINter:ENUMerate [ :NEXT]? command.

Return values:
<PrinterName> String parameter
If no printer is configured an empty string is returned.

Usage: Query only

SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?
Queries the name of the next printer installed. The SYSTem:COMMunicate:PRINter:ENUMerate: FIRSt? command
should be sent previously to return to the beginning of the printer list and query the name of the first printer.

Return values:

<PrinterName> String parameter
After all available printer names have been returned, an empty string enclosed by quotation
marks (..) is returned for the next query. Further queries are answered by a query error.

Usage: Query only
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2.12.2 MMEMory Commands

The Mass MEMomory subsystem provides commands to access the storage media and to save and reload instrument
settings.

The oscilloscope has three storage devices indicated as drives:

- /INT:internal storage with default directories for each data type
- /USB_FRONT:USB connector on the front panel

- /USB_REAR:USB connector on the rear panel

Common computer and network drives like C:, D:, \\server\share are not available.
Name conventions

The names of files and directories have to meet the following rules:

- Only the 8.3 format with ASCII characters is supported.

- No special characters are allowed.
- Use/ [slash] instead of \ (backslash].

MMEMOTY:DRIVES? Lo 160
MMEMory:MSIS [<MassStoragelS>] ..o 160
MMEMory:DCATalog? <PathName> ... 161
MMEMory:DCATalog:LENGth? <PathName> ... 161
MMEMory:MDIRectory <DirectoryName> ... 162
MMEMory:CDIRectory [<DirectoryName>] ..o 162
MMEMory:RDIRectory <DirectoryName> ... 162
MMEMory:CATalog? <PathName>[,<Format>] ... 162
MMEMory:CATalog:LENGth? <PathName> ... 163
MMEMory:COPY <FileSource> <FileDestination> ... 163
MMEMory:MOVE <FileSource>,<FileDestination> ..........ccccooiiiiiiiiii 163
MMEMory:DELete <FIleS0oUrCes™ ... 164
MMEMory:DATA <FileName>,<Data> . ..o 164
MMEMory:STORe:STATe <StateNumber>,<FileName> ... 164
MMEMory:LOAD:STATe <StateNumber>,<FileName> ... 164
MMEMory:DRIVes?

Returns the storage devices available on the oscilloscope.

Return values:

<Drive> List of strings, for example, “/INT", "/USB_FRONT", "/USB_REAR"
/INT: internal storage
/USB_FRONT: USB connector on the front panel
/USB_REAR: USB connector on the rear panel

Usage: Query only

MMEMory:MSIS [<MassStoragelS>]
Changes the storage device (drive).

Parameters:
<MassStoragelS> One of the available drives
/INT, /JUSB_FRONT, or /USB_REAR
Example: MMEM:MSIS “/USB_FRONT"
Sets USB stick connected to the front panel as storage device to be used.
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MMEMory:DCATalog? <PathName>
Returns the subdirectories of the specified directory. The result corresponds to the number of strings returned by the
MMEMory:DCATalog:LENgth? command.

Query parameters:
<PathName> String parameter

Specifies the directory.

Return values:

<FileEntry> String parameter
List of subdirectory strings separated by commas. If the specified directory does not have any
subdirectory, the current and the parent directories are returned (*.,,0", "..,,0)

Example: Query for directories with absolute path:

MMEM:DCAT? “/USB_FRONT/ W

received ™., ,0%,“..,,0%, “DATA,, 0", “DATA_NEW, , 0%, “SCREENSHOTS, , 0"
MMEM: DCAT : LENG? ,,/USB_FRONT/*™“

received 5

Example: Query for directories in the current directory:
MMEM:CDIR “/USB_ FRONT/DATA/™
MMEM:DCAT? “*%“
received “.,,0%,“..,,0%, “"JANUARY,, 0%, “FEBRUARY, , O™
MMEM:DCAT : LENG? “*“
received 4

Example: Query with filter:
MMEM: DCAT? ,,/USBiFRONT/DA*“
received “DATA, , 0%, “"DATA NEW,, 0"
MMEM:DCAT : LENG? “/USB_FRONT/DA*“
received 2

Usage: Query only

MMEMory:DCATalog:LENGth? <PathName>
Returns the number of directories in specified directory. The result corresponds to the number of strings returned
by the MMEMory : DCATalog? command above.

Return values:
<FileEntryCount> Number of directories.

Query Parameters:
<PathName> String parameter
Specifies the directory.

Example: MMEM: DCAT : LENG? “/USB_FRONT”
-->2
Usage: Query only
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MMEMory:MDIRectory <DirectoryName>
Creates a new directory with the specified name.

Setting parameters:
<DirectoryName> String parameter
Absolute path including the storage device, or relative to the current directory.

Example: Create directory DATA on the front USB flash device, with absolute path:
MMEM:MDIR “/USB_FRONT/DATA™

Example: Create directory JANUARY in the DATA directory, with relative path:
MMEM:CDIR “/USB FRONT/DATA/™
MMEM:MDIR “JANUARY™

Usage: Setting only

MMEMory:CDIRectory [<DirectoryName>]
Changes the default directory for file access.

Setting Parameters:

<DirectoryName> String parameter to specify the directory.
If the string also contains the storage device, the command MMEM: MSIS is
executed implicitely.

Example: MMEM:CDIR “/USB_FRONT/DATA"”

MMEMory:RDIRectory <DirectoryName>
Deletes the specified directory.
Note: All subdirectories and all files in the specified directory and in the subdirectories will be deleted!

You cannot delete the current directory or a superior directory. In this case, the instrument returns an execution error.

Setting parameters:
<DirectoryName> String parameter, absolute path or relative to the current directory

Example: MMEM:RDIR “/INT/TEST™
Deletes the directory TEST in the internal storage device, and all files and subdirectories
in the directory.

Usage: Setting only

MMEMory:CATalog? <PathName>[,<Format>]
Returns the a list of files contained in the specified directory. The result corresponds to the number of files returned by
the MMEMory:CATalog: LENgth? command.

Query parameters:
<PathName> String parameter
Specifies the directory. A filter can be used to list, for example, only files of a given file type.

<Format> ALL | WTIMe
ALL: Extended result including file, date, time and attributes
WTIMe: Result including file, date, time
Return values:
<UsedMemory> Total amount of storage currently used in the directory, in bytes.
<FreeMemory> Total amount of storage available in the directory, in bytes.
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<FileEntry> String parameter
All files of the directory are listed with their file name, format and size in bytes.

Example: Query for files in the DATA directory, with absolute path:

MMEM: CAT? “/USB_FRONT/DATA/*.*"
received: 511104, 8633856, “"MONDAY . TXT, , 8%, “TUESDAY .CSV, , 8"

Example: Query for TXT files in the DATA directory, with relative path:

MMEM:CDIR “/USB_FRONT/DATA“ N
MMEM:CAT? “*, TXT"

received: 511104, 8633856, "MONDAY . TXT, , 8%
MMEM:CAT :LENGTH? “W* . TXT“

received 1

Usage: Query only
MMEMory:CATalog:LENGth? <PathName>
Returns the number of files in the specified directory. The result corresponds to the number of files returned by the

MMEMory:CATalog? command above.

Return values:
<Count> Number of files

Query Parameters:
<PathName> String parameter
Directory to be queried
Usage: Query only
MMEMory:COPY <FileSource>,<FileDestination>
Copies data to another directory on the same or different storage device. The file name can be changed, too.
Setting Parameters:
<FileSource> String parameter

Name and path of the file to be copied

<FileDestination> String parameter
Name and path of the new file. If the file already exists, it is overwritten without notice.

Example: MMEM:COPY “/INT/SETTINGS/SET001.SET”,
“/USB_FRONT/SETTINGS/TESTSET1.SET”

Usage: Setting only
MMEMory:MOVE <FileSource>,<FileDestination>
Moves an existing file to a new location.

Setting Parameters:

<FileSource> String parameter

Path and name of the file to be moved

<FileDestination> String parameter
Path and name of the new file

Example: MMEM:MOVE “/INT/SETTINGS/SET001.SET”,
“/USB_FRONT/SETTINGS”

Usage: Setting only
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MMEMory:DELete <FileSource>
Removes a file from the specified directory.

Setting Parameters:

<FileSource> String parameter
File name and path of the file to be removed. If the path is omitted, the specified file will
be deleted in the current directory. Filters are not allowed.

Usage: Setting only

MMEMory:DATA <FileName> <Data>
Writes data to the specified file in the current directory MMEMory: CDIRectory, or reads the data.

Parameters:

<Data> 488.2 block data
The block begins with character .#". The next digit is the length of the length information,
followed by this given number of digits providing the number of bytes in the binary data
attached.

Parameters for setting and query:

<FileName> String parameter containing the file name

Example: MMEM:DATA “abc.txt“, #216This is the file
#2: the length infomation has two digits
16: the binary data has 16 bytes

MMEM:DATA? “abc.txt™
received: This is the file

MMEMory:STORe:STATe <StateNumber>,<FileName>
Saves the current device settings to the specified file in the current directory.

Setting parameters:

<StateNumber> Range: Tto1
Increment: 0
*RST: 1

<FileName> String parameter

File name, with or without file extension

Example: MMEM:CDIR “/USB_ FRONT/DATAM
MMEM: STOR: STAT 1, “MORNING.SET"

Usage: Setting only
MMEMory:LOAD:STATe <StateNumber> <FileName>
Loads the device settings from the specified file in the current directory.

Setting parameters:

<StateNumber> Range: Tto1
Increment: 0
*RST: 1

<FileName> String parameter

File name, with or without file extension

Example: MMEM:CDIR “/USB_ FRONT/DATA™
MMEM: LOAD: STAT 1, “MORNING"

Usage: Setting only
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2.13 General Instrument Setup
DISPlay:LANGUage <LangUages ... 165
DISPlay:LANGuage:ADD <Language>,<FilePath>............ccccciiiiiiiiii 165
DISPlay:LANGuage:REMove <Languages ........oooviiiiiiiiiiicc e 165
DISPlay:LANGuage:CATalog? <Languages> ........ccooiiiiiiiiiiiiii e 166
SYSTemM:NAME <NGME> ..ot 166
SYSTem:DATE <Year>,<Month>,<Day> ..o 166
SYSTem:TIME <Hour>,<Minute>,<Second> . ... 166
SYSTEMITREE? L. 167
SYSTemM:SET <SS IUP> i
SYSTem:ERROMINEXTI? SEFTOrS> ..o
SYSTem:ERRor:ALL? <Error>
SYSTIPRESEL e
DISPlay:LANGuage <l anguage>
Sets the language in which the softkey labels, help and other screen information can be displayed. Supported languages
are listed in the ..Specifications” data sheet.
Parameters:
<Language> ENGLish | GERMan | FRENch | SPANish | SCHinese | TCHinese
SCHinese:  Simplified Chinese
TCHinese:  Traditional Chinese
DISPlay:LANGuage:ADD <L anguage>,<FilePath>
Adds the selected language to the device including softkey labels and help. To change the displayed language, use
DISPlay: LANGuage .
Parameters:
<Language> ENGLish | GERMan | FRENch | SPANish | SCHinese | TCHinese
<FilePath> String parameter contains the source path and the filename of the language installation file.
Example: DISPlay:LANGuage:ADD FRENch,“/USB FRONT/HMO LNOO.HLU“
Loads the language installation file HMO_LNOO.HLU from the USB device on the
front panel and adds the french language.
Usage: Setting only
DISPlay:LANGuage:REMove <l anguage>
Removes the selected language from the device including softkey labels and help.
Parameters:
<Language> ENGLish | GERMan | FRENch | SPANish | SCHinese | TCHinese
Example: DISPlay:LANGuage:REMove FRENch
Can be used to remove french language from the device.
Usage: Setting only
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DISPlay:LANGuage:CATalog? <Languages>
Returns a list of available languages of the device.

Return values:
<Languages> List of available languages.

Example: DISPlay:LANGuage:CAT?
Returns ENGL,GERM,FREN, if english, german and french languages are installed.

Usage: Query only.

SYSTem:NAME <Name>
Defines an instrument name.

Parameters:
<Name> String with max. 20 characters
Example: SYST:NAME “MyScope“

SYSTem:DATE <Year>,<Month>,<Day>
Specifies the internal date for the instrument.

Parameters:

<Year> Increment: 1

<Month> Range: 1to 12
Increment: 1

<Day> Range: 1to 31
Increment: 11

Example: SYSTem:DATE 2012,10,1 (Set the device date to october st in the year 2012)
SYSTem:DATE? (returns 2012, 10, 1)

Usage: SCPI confirmed

SYSTem:TIME <Hour>,<Minute> <Second>
Specifies the internal time for the instrument.

Parameters:
<Hour> Range: 0to 23
Increment: 1
Default unit: h
<Minute> Range: 0to 99
Increment: 1
Default unit: min
<Second> Range: 0to 59
Increment: 1
Default unit: s
Example: SYSTem:TIME 12,15,0
Set the time to quarter past twelve.
SYSTem:TIME?
returns 12,15, 0
Usage: SCPI confirmed
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SYSTem:TREE?
Returns a list of implemented remote commands.

SYSTem:SET <Setup>

Defines or queries the device settings that can be saved and load manually with SAVE/RECALL > ,Device Settings”.
Parameters:

<Setup> 488.2 block data

Usage: SCPI confirmed

SYSTem:ERRor:INEXT]? <Error>
Queries the error/event queue for the oldest item and removes it from the queue. The response consists of an error
number and a short description of the error.

Positive error numbers are instrument-dependent. Negative error numbers are reserved by the SCPI standard.
Return values:

<Error> Error/event_number,“Error/event_description>[;Devicedependent info]
If the queue is empty, the response is 0,"No error”

Usage: Query only
SCPI confirmed

SYSTem:ERRor:ALL? <Error>
Queries the error/event queue for all unread items and removes them from the queue.
The response is a comma separated list of error number and a short description of the error in FIFO order.

Positive error numbers are instrument-dependent. Negative error numbers are reserved by the SCPI standard.

Return values:
<Error> List of:Error/event_number,“Error/event_description>[;Devicedependent info]

If the queue is empty, the response is 0,"No error”
Usage: Query only

SCPI confirmed
SYST:PRESet

Resets the instrument to the default state, has the same effect as *RST.

Usage: Event

HAMEG Instruments GmbH e Industriestr. 6 ¢ D-63533 Mainhausen e Deutschland Subject to change without notice
Tel.: +49 (0) 6182 800 0 » Fax: +49 (0) 6182 800 100 * E-Mail: info@hameg.com
Geschaftsfuhrer: Dipl.-Ing. Holger Asmussen, Dipl.-Ing. Andre Vander Stichelen ¢ AG Offenbach am Main HRB 41200 167



HAMEL=

Instruments
A Rohde & Schwarz Company

2.14
2.14.1

Status Reporting
STATus:0PERation Register

The commands of the STATus : OPERation subsystem control the status reporting structures of the

STATus:0OPERation register:

See also:

- chapter 1.6.1, .Structure of a SCPI Status Register”, on page 18
- .STATus:0OPERation Register”, on page 22

The following commands are available:

STATus:0PERation:CONDItion? <Condition> ....oooiiiiiiii e 168
STATus:0PERation:ENABle <Enable> ... 168
STATus:0PERation:NTRansition <NegativeTransition> .........cccocoiiiiiiiiiiie 168
STATus:0PERation:PTRansition <PositiveTransition> .............ccccociiiiiii 168
STATus:0PERation[:EVEN? <EVENT>...oiiii e 168

STATus:OPERation:CONDition? <Condition>
Returns the of the CONDition part of the operational status register.

Return values:

<Condition> Condition bits in decimal representation. ALIGnment (bit 0],

SELFtest (bit 1), AUToset (bit 2}, WTRigger (bit 3).
Range: 1 to 65535
Increment: 1

Usage: Query only

STATus:OPERation:ENABle <Enable>

Parameters:

<Enable> Range: 1 to 65535
Increment: 1

STATus:0OPERation:NTRansition <NegativeTransition>

Parameters:

<NegativeTransition> Range: 1 to 65535
Increment: 1

STATus:0PERation:PTRansition <PositiveTransition>

Parameters:

<PositiveTransition> Range: 1 to 65535
Increment: 1

STATus:OPERation[:EVENt]? <Event>

Return values:

<Event> Range: 1 to 65535

Increment: 1

Usage: Query only
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2.14.2 STATus:QUEStionable Registers
The commands of the STATus : QUEStionable subsystem control the status reporting structures of the
STATus:QUEStionable registers:

0 | CHAMNPal1 0 | TEMF WARM
1 | CHAMne2 1 | TEMP ERRor
2 | CHAMPel3 2
3 | CHANPel4 3
4 4
5 &
<] G
T 7
8 i
9 9
10 10
11 1"
12 12
STATus:QUEStionable 13 13
14 14
1] 15 15
1
2 . . . .
3 | coverload aSTAT.ﬂUES.CEW & STAT:QUES:TEMP
4 | TEMPerature
2
3
T
B | NOALigndata
@ | LIni
1? $STAT:QU ES:LIM
% STAT.QUES:MASK
E MASK 0 | MAsKI 0 | MEAS1
14 1 1 | MEASZ
15 2 2 | MEASS
3 3 | MEAS4
4 4
3 a2
g [
T T
a 8
9 9
10 10
1 1
12 12
13 13
14 14
13 15
Fig. 2.1:Structure of the STATus:QUEStionable register
See also:
- chapter 1.6.1, .Structure of a SCPI Status Register”, on page 18
- .STATus:QUEStionable Register”, on page 22
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The following commands are available:

ST AT US P RE S Ot e 170
STATus:QUEStionable:CONDItION? L. 170
STATus:QUEStionable:COVerload:CONDItION? ... 170
STATus:QUEStionable:LIMit:CONDITION? ..o 170
STATus:QUEStionable:MASK:CONDItION? ..o 170
STATus:QUEStionable:ENABLle <Enable> ... 170
STATus:QUEStionable:COVerload:ENABle <Enable> ... 170
STATus:QUEStionable:LIMit:ENABle <Enable> ..., 170
STATus:QUEStionable:MASK:ENABLle <Enable> ... 170
STATus:QUEStIoNablel:EVENT? ..o 171
STATus:QUEStionable:COVerload:EVEN? .o 171
STATus:QUEStionable:LIMItLEVENLI? oo 171
STATus:QUEStionable:MASKEEVEN? e, 171
STATus:QUEStionable:NTRansition <NegativeTransition> .......ccocooiioiiiiiiiiie 171
STATus:QUEStionable:COVerload:NTRansition <NegativeTransition> .................... 17
STATus:QUEStionable:LIMit:NTRansition <NegativeTransition> ... 17
STATus:QUEStionable:MASK:NTRansition <NegativeTransition> ... 17
STATus:QUEStionable:PTRansition <PositiveTransition> .......ccccccoviiiiiiiiie 171
STATus:QUEStionable:COVerload:PTRansition <PositiveTransition> ....................... 171
STATus:QUEStionable:LIMit:PTRansition <PositiveTransition> ...............cccc..coo. 171
STATus:QUEStionable:MASK:PTRansition <PositiveTransition> ............................... 171
STATus:PRESet

Resets all STATUS:QUESTIONALBLE registers.

Usage: Event

STATus:QUEStionable:CONDition?
STATus:QUEStionable:COVerload:CONDition?
STATus:QUEStionable:LIMit:CONDition?
STATus:QUEStionable:MASK:CONDition?

Returns the contents of the CONDition part of the status register to check for questionable instrument or measurement
states. Reading the CONDition registers does not delete the contents.

Return values:

<Condition> Condition bits in decimal representation
Range: 1to 65535
Increment: 1

Usage: Query only

STATus:QUEStionable:ENABLle <Enable>
STATus:QUEStionable:COVerload:ENABLle <Enable>
STATus:QUEStionable:LIMit:ENABLle <Enable>
STATus:QUEStionable:MASK:ENABle <Enable>

Sets the enable mask that allows true conditions in the EVENt part to be reported in the summary bit. If a bit is set to 1
in the enable part and its associated event bit transitions to true, a positive transition occurs in the summary bit and is
reported to the next higher level.

Parameters:

<Enable> Bit mask in decimal representation
Range: 1to 65535
Increment: 1

Example: STATus:QUEStionable:MASK:ENABle 24
Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:ENABLle
register part:24 =8+ 16 =23 + 24
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STATus:QUEStionable[:EVEN{t]?
STATus:QUEStionable:COVerload[:EVEN(]?
STATus:QUEStionable:LIMit[:EVENt]?
STATus:QUEStionable:MASKI[.EVENt]?

Returns the contents of the EVENt part of the status register to check whether an event has occurred since the last
reading. Reading an EVENt register deletes its contents.

Return values:

<Event> Event bits in decimal representation
Range: 1 to 65535
Increment: 1

Usage: Query only

STATus:QUEStionable:NTRansition <NegativeTransition>
STATus:QUEStionable:COVerload:NTRansition <NegativeTransition>
STATus:QUEStionable:LIMit:NTRansition <NegativeTransition>
STATus:QUEStionable:MASK:NTRansition <NegativeTransition>

Sets the negative transition filter. If a bit is set, a 1 to 0 transition in the corresponding bit of the condition register
causes a 1to be written in the corresponding bit of the event register.

Parameters:
<NegativeTransition> Bit mask in decimal representation
Range: T to 65535
Increment: 1
Example: STATus:QUEStionable:MASK:NTRansition 24

Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:NTRansition
register part:24 =8+ 16 =23 + 24

STATus:QUEStionable:PTRansition <PositiveTransition>
STATus:QUEStionable:COVerload:PTRansition <PositiveTransition>
STATus:QUEStionable:LIMit:PTRansition <PositiveTransition>
STATus:QUEStionable:MASK:PTRansition <PositiveTransition>

Sets the positive transition filter. If a bit is set, a 0 to 1 transition in the corresponding bit of the condition register causes
a 1to be written in the corresponding bit of the event register.

Parameters:

<PositiveTransition> Bit mask in decimal representation
Range: 1 to 65535
Increment: 1

Example: STATus:QUEStionable:MASK:PTRansition 24
Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:PTRansition
register part:24 =8+ 16 =23+ 24
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